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Letraset USA 
Program 
License 
Agreement 

Letraset Software 
License 

This legal document is an agreement between you, the end user, and Letraset USA. BY 
OPENI G THE SEALED DISK PACKAGE, YOU ARE AGREEING TO BECOME BOUND BY 
THE TERMS OF THIS AGREEMENT, WHICH INCLUDES THE SOFTWARE LICENSE AND 
SOFT\VARE DISCLAIMER OF WARRANTY (collectively the "Agreement"). 

THIS AGREEMENT CONSTITUTES THE COMPLETE AGREEMENT BETWEEN YOU AND 
LETRASET USA. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO 
NOT OPEN THE DISK PACKAGE. PROMPTLY RETURN THE UNOPENED DISK PACKAGE 
AND DOCUMENTATION TO THE PLACE OF PURCHASE FOR A FULL REFUND. 

1. Grant of License. In consideration of payment of the LICENSE fee , which is part of the 
price you paid for th is product , Letraset USA, as Licensor, grants to you, the LICENSEE, a 
nonexclusive right to use and display this copy of Letraset graphic design software 
(hereinafter the "Software") on a Single COMPUTER (i.e. , with a single CENTRAL PROCESS­
ING UNIT) at a single location. If the Single computer on w hich you use the SOFTWARE is a 
multiuser system, the License covers all users on that single system. Letraset reserves all 
rights not expressly granted to LICENSEE. 

2. Ownership of Software. As the LICENSEE, you own the magnetic or other physical 
media on which the SOFTWARE is originally or subsequently recorded or fixed , but Letraset 
retains title and ownersh ip of the SOFTWARE recorded on the original disk copy(ies) and all 
subsequent copies of the SOFTWARE, regardless of the form or media in or on which the 
original and othe r copies may exist. This' License is not a sale of the original SOFTWARE o r 
any copy. 

3. Copy Restrictions. This SOFTWARE and the accompanying written materials are copy­
righted. Unauthorized copying of the SOFTWARE, including SOFTWARE that has been modi­
fied , merged, or included with other software, or of the written mate rials is expressly fo rbid­
den . You may be he ld legally responsible for any copyright infringement that is caused or en­
couraged by 'your fa ilure to abide by the terms of this License. Subject to these restrictions , 
you may make one (1) copy of the SOFTWARE solely for backup purposes. You must repro­
duce and include the copyright notice on the backup copy. 

4. Use Restrictions. As the LICENSEE , you may physically transfer the SOFTWARE from 
one computer to another provided that the SOFTWARE is used on only one computer at a 
time. You may not e lectronically transfer the SOFTWARE from one computer to another over 
a network. You may not distribute copies of the SOFTWARE or accompanying written materi­
als to others. You may not modify, adapt, translate, reverse engineer, decompile, disassem­
ble , or create derivative works based on the SOFT\VARE. You may not modify, adapt, trans­
late, or create derivative works based on the written materials without the prior written con­
sent of Letraset. 

5. Transfer Restrictions. This SOFTWARE is licensed only to you, the LICENSEE, and 
may not be transferred to anyone w ithout the prior written consent of Letraset, Any author­
ized transferee of the SOrlWARE shall be bound by the terms and conditions of this Agree­
ment. In no event may you transfer, assign, rent, lease, sell , or o therwise dispose of the 
SOFTWARE on a temporalY or permanent basis except as expressly provided herein. 

6. Termination. This license is effective until te rminated . This License will terminate auto­
matically w ithout notice from Letraset if you fail to comply w ith any provision of this License. 
Upon termination you shall destroy the written materials and all copies of the SOFTWARE, in­
cluding modified copies, if any. 
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Disclaimer 
of Warranty and 
Limited Warranty 

7. Update Policy. Letraset may create, from time to time, updated versions of the SOFT­

WARE. At its option, Letraset will make such updates available to the LICENSEE and transfer­
ees who have paid the update fee and returned the Registration Card to Letraset. 

8. Disclaimer of Warranty and Limited Warranty. 

THE SOFTWARE AND ACCOMPANYING WRITTEN MATERIALS (INCLUDING INSTRUC­
TIONS FOR USE) ARE PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND , EX­
PRESS OR IMPLIED, AND LETRASET USA SPECIFICALLY DISCLAIMS THE WARRAN­
TIES OF FITNESS FOR A PARTICULAR PURPOSE AND MERCHANTABILITY. FURTHER, 
LETRASET DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS 
REGARDING THE USE, OR THE RESULTS OF THE USE, OF THE SOFTWARE OR WRIT­
TEN MATERIALS IN TERMS OF CORRECTNESS , ACCURACY , RELIABILITY, CURRENT­
NESS OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE 
OF THE SOFTWARE IS ASSUMED BY YOU. IF THE SOFTWARE OR WRITTEN MATERIALS 
ARE DEFECTIVE YOU, AND NOT LETRASET OR ITS DEALERS, DISTRIBUTORS, 
AGENTS, OR EMPLOYEES, ASSUME THE ENTIRE COST OF ALL NECESSARY SERVIC­
ING , REPAIR, OR CORRECTION. 

However, Letrase t warrants to the original LICENSEE that the disk(s) on which the SOFT­
WARE is recorded is free from defects in materials and workmanship under normal use and 
service for a period of ninety (90) days from the date of delivery as evidenced by a copy of 
the rece ipt. Further, Letraset hereby limits the duration of any implied warranty(ies) on the 
disk to the period stated above. Some states do not allow limitations on duration of an im­
plied warranty, so the above limitation may not apply to you. 

THE ABOVE ARE THE ONLY WARRANTIES OF ANY KIND, EITHER EXPRESS OR IM­
PLIED, THAT ARE MADE BY LETRASET ON THIS LETRASET GRAPHIC DESIGN SOFT­

WARE PRODUCT. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY LETRA­
SET, ITS DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES SHALL CREATE A WAR­
RANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY 
NOT RELY ON ANY SUCH INFORMATIO OR ADVICE. THIS WARRANTY GIVES YOU 
SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHER RIGHTS, WHICH VARY FROM STATE 
TO STATE. 

9. Limitation of Remedies. NEITHER LETRASET NOR ANYONE ELSE WHO HAS BEEN 
INVOLVED I THE CREATION, PRODUCTION, OR DELIVERY OF THIS PRODUCT 
SHALL BE LIABLE FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL, OR INCIDENTAL 
DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTER­
RUPTION, LOSS OF BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF THE 
USE OF OR INABILITY TO USE SUCH PRODUCT EVEN IF LETRASET HAS BEEN AD­
VISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME STATES DO NOT AL­
LOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCI­
DENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU. 

Le traset's entire liab ility and your exclusive remedy as to the disk(s) shall be, at Letraset's 
option, either (a) return of the purchase price or Cb) replacement of the disk .that does not 
meet Letraset's Limited Warranty and which is returned to Letraset with a copy of the receipt. 
If fa ilure of the disk has resulted from aCCident, abuse, or misapplication , Letraset shall have 
no responsibility to replace the disk or refund the purchase price. Any replacement disk will 
be warranted for the remainde r of the original warranty period o r thirty (30) days, whichever 
is longer. 

10. Governing Law. This Agreement is governed by the laws of the State of New Jersey. 
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Before You Start 
Before you start to use Ready,Set,Go! there are a few things you should 
know about the Macintosh computer, about this manual, and about the disks 
that came with the application. 

About Your Macintosh 
You should know how to set up your Macintosh and switch it on. You should 
know how to perform basic Macintosh operations, such as clicking 
and dragging, choosing commands from menus, and opening and closing 
applications and documents. If you are using a disk that supports the 
hierarchical file system, you should know how to search through folders to 
find documents. For this information refer to your Macintosh owner's guide 
and your hard disk owner's guide. 

About This Manual 
You should also know how this manual is organized. Chapter 1 is a quick 
introduction to Ready,Set,Go! and all the things you can do with it. 
Chapter 2 is a tutorial that helps you discover the power of Ready,Set,Go! by 
creating a Ready,Set,Go! document. If you're an experienced Macintosh 
user, you may want to skip this chapter. Chapter 3 is a step-by-step guide to 
Ready,Set,Go! It describes all the important tasks that you perform to 
design a document, create objects on a page, work with text and graphics, 
and print your final copy. You can read the chapter from start to finish 
or turn to individual tasks as you need help. Chapter 4 is a reference. When 
you're familiar with Ready,Set,Go! this chapter can help you refresh 
your memory about a particular command or provide some extra details 
about how the application works. The chapter also points out some 
shortcuts and offers suggestions for using memory efficiently. A glossary at 
the end of the book defines the most important terms you'll find in this 
manual. 

Throughout the manual , you'll find "Notes" giving some background about 
traditional printing and publishing terms and procedures, as well as helpful 
hints for producing your finished pages. 
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x/ BEFORE YOU START 

About Your Disks 
You should have three disks: the System Disk, the Application Disk, and the 
DictionalY Disk. The 800K System Disk provides the System Folder you 
need to start up your Macintosh (unless you have a Macintosh 512K) and to 
print your Ready,Set,Go! documents. The 400K Application Disk contains 
the Ready,Set,Go! application, Hyphenation Exceptions and User 
Dictionary files , and an Example folder you use with the tutorial 
in Chapter 2. The 400K Dictionary Disk contains the dictionary that 
Ready,Set,Go! uses to check spelling. 

Before you begin to work, make working copies of these disks as described in 
"To Make Working Copies of Your Disks" in Chapter 3. Then put 
the originals away in a safe place so you'll always have them available in case 
you damage your working copies. If you don't know how to make backup 
copies, see your Macintosh owner's guide. 

Welcome to Ready,Set,Go! 
Now you're on your way to learning, using, and enjoying this revolutionalY 
desktop publishing product. 
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PUB LIS H I N G MAD E S IMP L ,E 

Ready, Set, Go! is publishing made simple. 

It 's simple because Ready,Set,Go! gives you all the tools you 
need to create printed pages-grids and drawing tools, over 50 
graphic patterns, a variety of border styles, even a powerful 
word processor-in one place. 

It 's simple because Ready,Set,Go! puts you in control. You see 
exactly how the finished page will look on the screen-before 
you invest in typesetting or even settle on a final page design . 
Changing the position of text and graphics is as easy as clicking 
and dragging. So you can afford to experiment. 

Ready, Set, Go! is Simple because, with just a few keystrokes, it 
performs advanced graphic operations such as scaling pictures or 
making text run around a picture. 

And of course, it 's just plain easy to use. Once you learn a few 
basic skills, you can create pages that normally reqUire the 
skills of many different people-word processors, typesetters, 
and pasteup and layout artists. 

Sound simple? Here 's how it works . 
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S T E P 1 

Open a New Document 
When you start Ready,Set,Go! a new document appears in a 

window on your desktop. A tool bar at the top of the window 

provides all the tools you need to create text and graphics in 

this document. 

A menu bar appears across the top of the screen. You choose 

commands from the menus in this bar-commands for everything 

from hyphenating text to designing a page grid. 

See "Managing the Desktop" in Chapter 3 to start Ready,Set,Go! 
and open a new document. p, 31( ..fl-. 
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S T E P 2 

Design Your Document 
You start with design . Decide how many pages you want and 

choose a page size. Your Ready,Set,Go! document can be a single 

page. Or it can be many more-as many as your available memory 

allows. It can be any size up to 99 by 99 inches. 

Next, design a page grid to help you organize objects on the 

page. The grid appears on the screen but not on your printed 
page. 

Finally, if your document has many pages with elements that 

repeat on each page, you can create these elements on master 

pages. Then Ready,Set,Go! automatically adds them to each page 
of the document. 

"Designing a Document" in Chapter 3 gives you all the details . 
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S T E P 3 

Create Objects 
When you create the pages of a newsle tter, report, manual, or 

brochure, you arrange objects on a page. Text. Charts. 

Illustrations. Photographs. Rules. Borders. 

When you work with Ready,Set,Go! you work with objects, too. 

There are three kinds of objects in .Ready,Set,Go!-text blocks , 

picture blocks, and graphic objects. You create them by selecting 

a tool , and then clicking and dragging on the page. 

"Working With Objec~s" in Chapter 3 tells you all you need to 
know. 
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Use the text tool to 
create text blocks. 

Use the picture tool to 
create picture blocks. 

You put text in text .......... 
blocks. .......... 

Draw graphic 
objects-such as 
circles, dotted lines, 
or solid rules­
anywhere on a 
page. 

Use the shape tools to 
create lines, rectangles, 
rounded rectangles, and 
ovals. 

You put pictures in 
picture blocks. 

You can make 
objects smaller or 
larger, move 
them, and copy 
them. You can 
stack them and 
line them up 
horizontally or 
vertically. 

CREATE OBJECTS!7 

Use the text tool to 
create text blocks. 

Use the picture tool to 
create picture blocks. 

You put text in text .......... 
blocks. .......... 

Draw graphic 
objects-such as 
circles, dotted lines, 
or solid rules­
anywhere on a 
page. 

Use the shape tools to 
create lines, rectangles, 
rounded rectangles, and 
ovals. 

You put pictures in 
picture blocks. 

You can make 
objects smaller or 
larger, move 
them, and copy 
them. You can 
stack them and 
line them up 
horizontally or 
vertically. 

CREATE OBJECTS!7 



S T E P 4 

Work With Text 
When you want to put text on a page, you create a text block. 

Then you get to work with words-typing, getting text from 

another document, choosing the fonts, styles, sizes, and formats 

you want. You create stylesheets for standard combinations of 

text styles and formats. You use glossaries to insert boilerplate 

text- a few lines or several pages . You can search and replace 

text. You can hyphenate automatically or choose not to. You can 
even check your spelling. 

To become an expert, see "Working With Text" in Chapter 3. 
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the Style menu. 
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spacing, line spacing, 
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S T E P 5 

Add Graphics 
Ready,Set,Go! pages can have graphics as well as text. You can 

draw directly on Ready,Set,Go! pages to create boxes for text or 

pictures, rules to separate columns and rows, or simple charts or 

diagrams. 

For more complex graphics, you can create pictures in a graphics 

application and then put them in a picture block on a 

Ready,Set,Go! page. You can even use photographs that you have 

scanned with a scanner and retouched with ImageStudio-the 

image-enhancing software from Letraset. 

Check "Working With Graphics" in Chapter 3 for the fine points . 
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5 T E P 6 

Print Your DOCU111ent 
Printing is the last step in creating a Ready,Set,Go! document. 

It's as quick and simple as the other steps. You select the 

options you want-the number of copies , the pages you want to 
print, and the paper source, for example. 

If you're using a page size that's larger than your printer can 

handle, you can divide your pages into sections called "tiles." 

The tiles fit the paper size you are using and have some overlap 

so you can paste them together to form the complete page. 

For step-by-step instructions on how to print with an 

ImageWriter or LaserWriter printer, see "Printing" in Chapter 3. 
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You select printing 
options. Different 
printers have different 
options. 

Page Setup: 

o us Letter 0 A4 Letter 

o US Legal 085 letter 

@Tabloid 0 Other 

Width: 1[«,tII I picas.pts 

Depth: 1102.00 I picas .pts 

Orientation: 

!ZI : mg 

Tile Ouerlap: 

16.00 1 picas.pts 

D Aegistration Marks 

LaserLllriter <Laserillriter Plus> v4.0 n OK t 
cOPies:I_1 Pages:@ All 0 From: D To: D (Cancel 1 
COLIer Page: @ No 0 First Page 0 Last Page ~ 

Paper Source: @ Paper Cassette 0 Manual Feed 

For large pages, choose 
Page Setup and click 
Tiling. Ready,Set, Go! 
diVides the page into 
"tiles" for printing. 

Click OK to print a 
document that you can 
use as page proof, a 
camera-ready original, or 
a final document ready 
for distribution. 
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THE NEXT STEP 

Get to Know Ready) Set) Go/ 
Of course , before you rush into print, you will want to explore 
the features of Ready,Set,Go! a little further . 

You can start by creating a two-page sample newsletter with the 

tutorial in Chapter 2. Or if you already have a project of your 

own in mind, use the step-by-step instructions in Chapter 3 to 

guide you as you learn to create professional-looking 

publications with Ready,Set,Go! 
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READY,SET ... 

Ready,Set,Go! is easy to learn. So you may want to get started 
right away with a document of your own. 

But if you would like to practice for a few minutes before you 
begin, or if you want to get some ideas about how to organize 
the process from start to finish - and pick up a few tricks along 
the way- you can work with the sample newsletter in this 
chapter. 

To use this example, you need a folder named Example, which is 
on the Ready, Set, Go! Application Disk. The Example folder 
contains a Microsoft Word document named Article and a 
Ready,Set, Go! document named Glossaries. It also contains two 
graphics documents named Masthead and Illustration. You don't 
need the Word or graphics applications to use these documents 
in a ReadY,Set,Go! document. 

Before you begin to work, be sure to make working copies of 
your disks. If you have two BOOK drives, you can copy the RSG 
Dictionary into your working copy of the Application Disk. 
(However, you don't need the RSG Dictionary to create the 
newsletter in this chapter.) If you are using a hard disk, copy 
the application and the dictionary onto one folder on your hard 
disk. See "To Make Working Copies of Your Disks" in 
Chapter 3 for details. 
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A SAMPLE NEWSLETTER 
" 

Start Ready, Set, Go! 

App Hcation Disk 

Ready ,Set ,Go! 4 .0 

16/ READY,SET ... 

-----------------------------

To start Ready,Set,Go' you insert your working copies of the System Disk 
and the Application Disk in your d isk drives and open the application td 

display a new, untitled document. If you are using a hard disk, go directly to 
step 4. 

1 Switch on your Macintosh. If it is already on, return to the Finder and shut 
it down by choosing Shut Down from the Special menu . 

2 Insert your working copy of the Ready,Set,Go! System Disk, label side up, 
metal end first , into the internal 3.5-inch disk drive. Then insert a copy :of 
the Application Disk into the external drive. 

If you used the Shut Down command, click Restart. 

The Macintosh Finder now appears on the screen. The icon for the 
Application Disk appears just below the icon for the System Disk. 

3 Double-click the Application Disk icon to open it. 

A window displays the contents of the Application Disk. 

4 Double-click the Ready,Set,Go! icon. 

Ready,Set,Go' starts by displaying page 1 of an untitled document and the 
tools you need to work. 
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1. Switch on your 
Macintosh. 

2. Insert the System 
Disk and the 
Application Disk. 

You can copy the 
Application Disk and the 
Dictionary Disk onto ~. 
a single BOOK disk to 
check spelling. 

Ii File Edit View Special 

Application Disk 
S70K m dlSk 

o 

4. Double·click the 
Ready,Set,Go! icon. 

CJ 
ExaMple 

o 

Ready, Set, Gol displays 
page 1 of an untitled 
document on your 
screen . 

3. Double·click the 
Application Disk icon. 

Fill Lines Pen 
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A SAMPLE NEWSLETTER 

Name the Document 

18/ READY,SET. .. 

The first step is to give the newsletter a name. 

1 Choose Save As from the File menu. 

The Save As dialog box appears with Untitled selected. 

2 Type a name for the document. 

The title of this newsletter is Design Inc. You can use that for the name of 
your document or choose another name. 

3 Click Save to confirm the name. 

The name that you typed now appears in the title bar of the document 
window. A dotted line around the page shows the print area of the page­
that is, the part of the page that your printer can print. 
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A SAM P LEN· E W S LET T E R 

Set Up the Grid 

20/ READY,SET. .. 

Attractive, readable publications start with page design. A grid system helps 
you design pages that are balanced and consistent. Ready,Set,Go! makes 
grid design easy, even automatic. But first you need to choose a 
measurement scale. 

1 Choose Preferences from the Special menu. 

The Preferences dialog box displays several options. For now, just select the 
units of measure and leave the other options unchanged. 

2 Click Picas/ Points , and then click OK. 

The rulers in your document window now display picas. 

3 Choose Design Grids from the Special menu. 

A dialog box displays eight standard grids and an option for setting up your 
own grid. For this newsletter, you 're going to set up your own. 

4 Click Grid Setup if it is not already selected, and click OK. 

5 Type these specifications: 

Top: 6 
Inside: 6.06 
Row Spacing: .06 
Number Of Rows: 32 

Bottom: 6 
Outside: 4 
Column Spacing: 
Number Of Columns: 4 

Click Double Sided if it is not already checked. Ready,Set,Go! automatically 
assigns the proper inside and outside margins to left and right pages. 

The number you type replaces the selected numher in each box. You can 
use the Tab key to move from one box to the next. 

6 Click OK to display the new grid and make it active. 

The rows and columns form rectangles-32 rectangles per column. 

Choose Save from the File menu to save your work before you continue. 
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A SAMPLE NEWSLETTER 

Add a Page 

22/ READY,SET. .. 

New Ready,Set,Go! documents always open with one page. An icon for 
page 1 appears in the page scroll bar at the upper right of the Ready,Set,Go! 
document window, 

This sample newsletter has two pages, so you need to add a page. You don't 
have to set up the page grid each time you add a page. Ready,Set,Go! does it 
for you. 

1 Choose Insert Page(s) from the Special menu. 

The Insert Page(s) dialog box appears. You can add any number of pages. 
They can be blank pages or duplicates cif the current page. You can add the 
pages before or after the current page. For this example, you use the preset 
options: 1 blank page after the current page. 

2 Click OK. 

An icon for page 2 now appears in the page scroll bar, and page 2 appears 
on the screen. 

3 Click the icon for page 1 in the page scroll bar to return to page 1. 

The two icons at the far left of the page scroll bar represent master pages. 
The Land R stand for left and right master pages. You use master pages to 
create elements that you want to repeat on every left and right page. Master 
pages are very useful for longer documents. See "To Set Up Master Pages" in 
Chapter 3. 

You may want to get a look at the full page now. 

4 Choose Size To Fit from the Special menu. 

The page is reduced to fit in the window. You can also choose Half Size and 
75% Size for intermediate reductions or Double Size for a closeup view. You 
can even choose Facing Pages if you have a document with faCing pages. 
This two-page newsletter is printed on a single, double-sided page, so it 
doesn't have faCing pages. 

5 Choose Actual Size from the Special menu to continue working. 
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A SAMPLE NEWSLETTER 

Create a Masthead 

24/READY,SET. .. 

A newsletter gets its identity primarily from its masthead. The Design Inc 
masthead is already created in a file called Masthead. To put it in the 
newsletter, draw a picture block and get the masthead from the Masthead 
file. 

1 Select the picture tool from the tool bar. 

When you move the pointer into the window, the pointer becomes a 
crossbar. 

2 Position the pointer at the upper left corner of the first column. Drag 
across the page to fill the top ten grid rectangles in all four columns. 

As you drag, the page scrolls in the window. When you release the mouse 
button, the picture block snaps to fit the grid exactly. If YO.LI don't get the 
block the way you want it the first time, press Backspace to erase the block 
and try again. 

3 Select the cropping tool and click in the picture block. 

A pattern fills the picture block to show it's selected. 

4 Choose Get Picture from the File menu. 

A dialog box lists the availahle graphics files. Your list should include a file 
named Masthead. (You may have to open the Example folder or click Drive 
to find this file.) 

5 Double-click Masthead to open it. 

The masthead appears in the picture block. You may need to move it 
around in the picture block by dragging it with the cropping tool if it is not 
centered in the block. Scroll to see the whole picture block, or choose Size 
To Fit from the Special menu to see the whole page. Choose Save from the 
File menu to save your work so far. 
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1. Click the picture tool. 

4. Choose Get 
Picture. 

2. Draw a picture 
block to fill the top 1 0 
rows of the page. 

3. Select the cropping 
tool and click in the 
picture block. 
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A SAMPLE NEWSLETTER 

Create Text Columns 

26/ READY,SET. .. 

This sample newsletter has four columns of text on each page. To create 
columns of text, you draw text blocks. 

1 Select the text tool from the tool bar. 

When you move the pointer into the window, it becomes a crossbar. 

2 Drag to draw a text block for column 1. 

Skip the first grid rectangle below the masthead and start the first column. 
Drag to the next-to-the-last grid rectangle in column 1. When you release 
the mouse button, the text block snaps to fit the grid. Text blocks are shown 
on the screen with a dotted outline. When a text block is selected, there are 
handles at the edges of the block. 

3 Draw three more matching columns on page 1. Then. draw the first three 
columns on page 2. 

Start the columns on page 2 in the second grid rectangle and end them in 
the next-to-last one. 

Save your work before you continue. 
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A SAMPLE NEWSLETTER 

Lay Out an Article 

D 

28/ READY, SET ... 

Now you 're ready to layout your first article . You start by getting the text for 
the article from a file named Article. Then you use the linking tool to lay it 
out in columns. 

1 Select the insertion pointer and then click in the text block in column 1 on 
page 1. 

When you move the po inter into the window, it becomes an I-beam. When 
you click in column 1, a blinking insertion point marks where text you insert 
will start. 

2 Choose Get Text from the File menu . 

A dialog box lists the available text files , including the file named Article. 
You may have to open the Example folder or click Drive to find this file. 

3 Double-click Article to open it. 

The first part of the article fills column 1. (The top of the first line may 
appear to be chopped off, but it will print correctly.) A symbol at the 
bottom right corner of the text block shows that there is more text in the 
article than can fit in the text block. 

4 Select the linking tool from the tool bar. 

5 Click once in column 1 and then once in columns 2, 3, and 4. 

As you click in each text block, text fills the block. 

6 Click the icon for page 2 and link the text across the page by clicking in 
columns 1 and 2 and double-clicking in column 3 to end the chain . 

The text won't fill all the text blocks you made on page 2 yet, but it will after 
you insert a picture on the page. 

Save your work. 
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you insert a picture on the page. 

Save your work. 
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A SAMPLE NEWSLETTER 

Change the Headings 

30/ READY,SET . .. 

Ready,Set,Go! has a powerful built-in word processor, so you can change 
text easily. One of its most powerful features is its ability to create 
stylesheets-predefined formats that you can apply to text paragraphs or 
headings, for example. You can use this feature now to change some of the 
headings in the article you just laid out. 

1 Select the insertion pointer and select the heading: "The form of a 
letter. " 

2 Choose Styles from the Text menu. 

A window displays the list of available styles. Because this is a new 
document, no styles are listed. 

3 Click New to create a new style. 

A new window shows the current specifications for the selected text. 

4 Type a name for the new style. Click Helvetica and 10 Point. Then click 
OK. 

Don't change the other specifications right now. You can learn more about 
stylesheets and type specifications in "Working With Text" in Chapter 3. 

When you click OK, the new style appears in the list of available styles and is 
selected. 

5 Click Apply and then click Done. 

The head you selected appears in the new style. Select the rest of the 
headings in the article , choose Styles from the Text menu, select the style 
you just named, and click Apply to apply it to each one. 

Save your work. 
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A SAMPLE NEWSLETTER 

Add a Publisher)s Note 

32/ READY,SET. .. 

Most publications have some standard text that always appears in the 
document. The Design Inc newsletter has a Publisher's Note that usually 
appears in the last column of the last page. You can use the Glossaries 
command to add this note. 

1 Draw a new text block in column 4 on page 2. 

Select the text tool and position the pointer in the second grid rectangle 
from the top of column 4. Drag to the bottom of the sixth grid rectangle. 

2 Select the insertion pointer from the tool bar and click in the new text 
block. 

3 Choose Glossaries from the Text menu. 

A dialog box displays the available glossaries-preexisting bOilerplate text 
that you can insert anywhere in your document. Every document has a few 
glossaries built into it for displaying the date and time. But you need to 
import the Publisher's Note glossary from another document. 

4 Click Import. 

A new dialog box lists Ready,Set,Go! files. 

5 Double-click BOilerplates. 

You may have to open the Example folder to find the Boilerplates file. All 
the glossaries from the BOilerplates file are added to the list of glossaries. 

6 Select Publisher's Note, click Paste, and then click Done. 

The Publisher's Note appears in the new text block in column 4. 

Save your work. 
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A SAMPLE NEWSLETTER 

Add an Illustration 

34/ READY, SET . .. 

You already know how to get a picture from another file and put it into the 
document. Now you can add an illustration to page 2 of the newsletter-a 
picture of a printing press. 

1 Select the picture tool and draw a picture block that starts in the eighth 
grid rectangle in column 2 and ends in the next-to-the-last grid rectangle of 
column 4. 

The text automatically adjusts to flow around the picture block. You can also 
make the text run around the image itself, rather than the block. But first you 
need to insert the picture. 

2 Get the picture named Illustration. 

Use the cropping tool to select the picture block and choose Get Picture 
from the File menu. Double-click Illustration in the dialog box to insert it in 
the picture block. Use the cropping tool to align the right side of the 
printing press with the right edge of the picture block. Align the bottom of 
the printing press with the bottom of the picture block. 

3 Choose Specifications from the Edit menu. 

A dialog box displays many options for the selected picture. It gives you two 
Runaround options: Frame and Graphic. 

4 Click Graphic and click OK. Then select the insertion pointer from the 
tool bar. 

The text runs around the image. If you're not quite happy with the way it 
looks, try moving the picture with the cropping tool and select the insertion 
pointer again to see the effect on the text. 
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A SAMPLE NEWSLETTER 

And Print It! 

36/ READY,SET ... 

Printing is always the fun part of using Ready,Set,Go! Art and type seem 
somehow abstract while they're on the Macintosh screen, becoming 
concrete only when they're printed. So watch the paper output tray for the 
true rewards of desktop publishing: words in type. 

1 Choose Save from the File menu to save the document before you print it. 
You may also need to choose a printer. Choose Chooser from the Apple 
menu, click the printer you want to use , and click the close box. 

2 Choose Print from the File menu. 

3 Click OK. 

Printing may take a few minutes because the graphics files are large. But it's 
worth the wait. 

For more information, see "Printing" in Chapter 3. 

Editors give writers great satisfaction with the words "Print it!" They mean 
an article is approved and ready for publication. 
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Next time you're at 
the newsstand, pick up 
a copy of The New 
Yorker and notice the 
text runarounds that 
often surround the 
magazine's small line 
drawings. The 
runarounds 
simultaneously set off 
line art and decorate 
the pages. 
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GO! 

Working with Ready,Set,Go! means designing documents, 
creating objects on a page, working with text, adding graphics, 
and printing your finished pages. 

Each of these tasks is made up of many small tasks. To design a 
document, you must set up grids and master pages. You not only 
create objects, but you move them, copy them, and align them. 
When you work with text, you may be typing new text, 
entering text from an existing document, editing text, or 
formatting it. Adding pictures may mean drawing lines, 
rectangles, and ovals, or it may mean copying a graphic 
illustration from another document, resizing it, and cropping it 
to fit into a picture block. 

In addition, you need to know some of the basics about managing 
your Ready,Set, Go! desktop-how to create working copies of 
your disks, how to start and quit the application, and how to 
work with documents and windows. 

If you're ready to get going with Ready, Set, Go! this chapter 
shows you how to perform all of these important tasks. You can 
read it from start to finish if you want or Simply turn to each 
task as you need help. Be sure you understand the basics of 
using the Macintosh before you begin. 

If you want a complete overview of the Ready, Set, Go! software 
and desktop, as well as all the commands in the Ready,Set,Go! 
menus, turn to Chapter 4, "Reference. " 
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Managing the Desktop 

40/ GO! 

B
efore you begin designing a 

document and entering text and 

graphics , you need to know the 

basics about managing the Ready,Set,Go! 

desktop-how to start and quit the 

application, how to work with documents, 

and how to manage windows. 

The Application 

You have three Ready,Set,Go! disks: the 

System Disk, the Application Disk, and 

the Dictionary Disk. The 800K System 

Disk provides the System Folder you 

need to start up your Macintosh (unless 

you have a Macintosh 512K) and to print 

your Ready,Set,Go! documents. The 400K 

Application Disk contains the application, 

Hyphenation Exceptions and User 

Dictionary files, and an Example folder 

you use with the tutorial in Chapter 2. 

The 400K Dictionary Disk contains the 

dictionary that Ready,Set,Go! uses to 

check spelling. 

, CAUTION! Before you do anything, make 

working copies of your original disks. 

Never use your original disks when you 

work. If you damage them, you will need 

to purchase a new copy of Ready,Set,Go! 

For details on making working copies of 

your disks , see "To Make Working 

Copies of Your Disks" in this chapter. 
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It's easiest to use Ready,Set,Go! with 

two SOaK disk drives or with a hard disk 

drive. If you have two SOaK disk drives, 

make working copies of the System Disk 

and Application Disk on SOaK disks, and 

copy the RSG Dictionary from the 

Dictionary Disk to the same disk and 

folder as your Ready,Set,Go! application. 

If you have a hard disk, copy the 

application and dictionary into one folder 

on the hard disk. You can also use 

Ready,Set,Go! with only one SOaK disk 

drive or two 400K disk drives. See "To 

Make Working Copies of Your Disks" in 

this chapter and "The Software" in 

Chapter 4 for details. 

The Document 

When you work with Ready,Set,Go! you 

create documents. 

You can open more than one document 

on the desktop and switch between 

documents as you work. Or you can open 

copies of the same document in more than 

one window to see different views at the 

same time. (Be careful to make all your 

changes to the original copy of your 

document and save them.) See the Save 

command and "Available Memory" in 

Chapter 4 for details.) 

You name a document the first time you 

save it. As you work, you can save the 

changes you make, updating the version 

on your disk. You should save often to 

avoid losing information. 

The Windows 

Ready,Set,Go! displays the pages of your 

document in a window. It displays one 

page at a time or two facing pages. You 

can change the view of a page or pages to 

show the whole page in the window. You 

can also enlarge the page to get a close­

up view. 

Each window has a title bar that 

displays the name of the document and the 

current page . Every window also has its 

own tool bar and a page scroll bar. The 

page scroll bar has an icon for each of the 

pages in the document, as well as for the 

left and right master pages. The icon for 

the current page is selected. You can use 

the scroll bars at the right and bottom of 

the window to view another part of the 

current page. 
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MANAGI NG THE DESKTOP 

The Application 
To make It is easiest to work with Dictionary Disk onto the Application Disk 
working copies Ready,Set,Go! if you another 800K disk to and the RSG 
of your disks have two 800K disk make a working Dictionary from the 

drives or a hard disk. Application Disk. Dictionary Disk to the 
All the files you need But you can make Make sure that the same folder on your 
to use Ready,Set,Go! working disks to use Ready,Set,Go! hard disk. You can 
come on three disks, with a single 800K disk application and the remove the Example 
but you should never drive or even two 400K RSG Dictionary are folder when you are 
work with your original drives. kept in the same folder done with the tutorial 
copies. Instead, make on your working in Chapter 2. You can 
a set of working copies If you are unsure of Application Disk. You use the System Folder 
and put the originals how to initialize or can remove the you already have on 
away in a safe place. If copy disks, see your Example folder when your hard disk, but 
you damage your Macintosh owner's you are done with the make sure that you are 
original disks you will guide . tutorial in Chapter 2. using Finder version 
need to purchase a • If you have two 5.5 and System 
new copy of BOOK drives, copy the • If you have a hard version 4.1 or later 
Ready, Set, Go! System Folder from disk drive, copy the and LaserWriter and 

the System Disk onto Ready,Set ,Go! LaserPrep versions 4.0 

one 800K disk to make application and or later. If you are not, 

a working System Disk. Example folder from you can copy these 

Then copy the files from the System 

Ready,Set,Go! Disk or obtain the 

application and latest System Tools 

Example folder from disk from your Apple 

the Application Disk dealer. See your 

and the RSG Macintosh owner's 

Dictionary from the guide for details. 
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• If you have a single 
BOOK disk drive, copy 
the System Folder 
from the System Disk 
and the Ready,Set,Go! 
application and 
Example folder from 
the Application Disk 
onto one SOOK disk. 
You will not have 
enough room for the 
RSG Dictionary, so 

• 

you won't be able to 
check your spelling. 
Remove the Example 
folder from your disk 
when you are done 
with the tutorial in 
Chapter 2. 

File Edit Uiew SpecIal 

• If you have two 
400K drives, simply 
copy the Application 
Disk onto another 
400K disk. Copy the 
System Folder you 
normally use onto 
another 400K disk to 
use as a working 
System Disk. You will 
not have room for the 
RSG Dictionary on 

I~O Rpplicotion Disk 0§~ 
I '!5it.ms 7221< )n disk 64K~bl. 
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Copy from the Application Disk. 

Systtm Disk 
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your working 
Application Disk, so 
you won't be able to 
check your spelling. 
Remove the Example 
folder from your 
working Application 
Disk when you are 
done with the tutorial 
in Chapter 2. 

Remove when you 
are done 
with the tutorial 
in Chapter 2. 

THE APPLICATION/ 43 

• If you have a single 
BOOK disk drive, copy 
the System Folder 
from the System Disk 
and the Ready,Set,Go! 
application and 
Example folder from 
the Application Disk 
onto one SOOK disk. 
You will not have 
enough room for the 
RSG Dictionary, so 

• 

you won't be able to 
check your spelling. 
Remove the Example 
folder from your disk 
when you are done 
with the tutorial in 
Chapter 2. 

File Edit Uiew SpecIal 

• If you have two 
400K drives, simply 
copy the Application 
Disk onto another 
400K disk. Copy the 
System Folder you 
normally use onto 
another 400K disk to 
use as a working 
System Disk. You will 
not have room for the 
RSG Dictionary on 

I~O Rpplicotion Disk 0§~ 
I '!5it.ms 7221< )n disk 64K~bl. 

Copyfrom 1 
~ 

~ 
the DiCtiOn~11 
Disk. ~ 

Rudy,Stt,GoI4.0 E~ 
~ §gl D D 

RSG Diction.ary Unr DIctionary Hyphtn<lltlOn Exctptions 

R 
1':;;12J 

I 
Copy from the Application Disk. 

Systtm Disk 

! ltlIiliS!D 

i 

your working 
Application Disk, so 
you won't be able to 
check your spelling. 
Remove the Example 
folder from your 
working Application 
Disk when you are 
done with the tutorial 
in Chapter 2. 

Remove when you 
are done 
with the tutorial 
in Chapter 2. 

THE APPLICATION/ 43 



MANAGI NG THE DESKTOP 

The Application 
To start 
Ready,Set,Go! 

You start 
Ready,Set,Go! from 
the Finder. You need 
your working copies of 
the System Disk and 
Application Disk. See 
"To Make Working 
Copies of Your Disks" 
in this chapter. 

CAUTION! Always 
use backup copies 
when you work. Keep 
your original disks in a 
safe place. 

1 Switch on your 
Macintosh. 

If your Macintosh is 
already on, return to 
the Finder and choose 
Shut Down from the 
Special menu . 

If you have installed 
Ready,Set,Go! on 
your hard disk, switch 
it on first. 

2 Insert the 
Ready,Set ,Go! System 
Disk and Application 
Disk. 

If you have installed 
Ready,Set,Go! on 
your hard disk, don't 
insert any disks . 

If you chose Shut 
Down, click Restart. 

1. Switch on your 
Macintosh. 

2. Insert the System 
Disk and the 
Application Disk. 

RSG Dictionary 

3 Double-click the 
Application Disk icon 
to open it. 

If you are working with 
a single disk or a hard 
disk, open its icon and 
any folders you need 
to open to display the 
Ready,Set,Go! icon. 

o o 

4 Double-click the 
Ready,Set,Go! icon to 
open it. Or click it to 
select it and choose 
Open from the File 
menu . 

A new, untitled 
Ready,Set,Go! 
document appears in a 
window on the desktop 
with the tools you need 
to work. 

3. Double-click 
the Application 

Disk icon. 

User Dictionary HyphE'nation ExcE'ptions 

4_ Double-click the Ready,Set,Go! icon. 
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To quit 
Ready,Set,Go! 

When you 're finished 
working or need to 
work with a document 
in another 
application, you can 
quit Ready,Set,Go! 

1 Choose Quit from 
the File menu. 

If you haven't saved 
changes you've made 
to documents on your 
desktop, a dialog box 
asks if you want to save 
them. 

2 Click Yes to save 
your changes. 

If you have not already 
named a document, 
another dialog box 
prompts you for a 
name before it saves 
it. See "To Save a 
Document" in this 
chapter. 

If you click No, the 
untitled document and 
any changes you 've 
made are not saved. 

New 
Open ... 
Close 

3€N 1. Choose Quit. 
3€O 

Saue 3€S 
Saue As •.• 
Page Setup ... 
Printer Setup .. . 
Print •.• 
r,pt "rput" 
Put rf~Ht." 
!;,-pt Pieilll 'e". 
Quit 3€Q 

Quits without 
saving 
changes 

2. Click Yes to save 
changes. 

Cancels the Quit 
command 
and returns you 
to your 
document 
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MANAGI NG THE DESKTOP 

The Document 
To open a 
document 

Each time you start 
Ready,Set,Go! it 
opens a new, untitled 
document. You can 
work with that 
document or open any 
other new or existing 
document. You can 
open many 
documents at once­
as many as your 
internal memory 
allows. 

1 Choose Open from 
the File menu. 

A dialog box displays 
a list of folders and 
documents on the 
current disk. 

Click Eject or Drive to 
go to another disk. If 
your disk uses the 
hierarchical file 
system, you can open 
folders to see folders 
and documents within 
them by double­
clicking. 

46/GO! 

2 Select a document 
and click Open. Or 
just double-click the 
name. 

The document opens 
to the page where you 
were last working. 

If you open a 
document that is 
already open, a dialog 
box asks if you want to 
make a copy of the 
original. Click OK to 
create a copy. The title 
bar shows it is a copy. 

New 3€N 1. Choose Open. 
I,· :'1 

[lose 3€W 
S<we ,'"S 
Salle Hs .•. 
Page Setup ... 

You can choose New to 
open a new document. 

Printer Fr!!:!!::=!================;] 
Print ..• 
bptlpu 
Put lt~H 
hpt Pit:1 
Quit 

Ie Design Inc Folder I 
D Design Inc, Uol. I, No. I 
D Design Inc, Uol. I, No.2 
D Desl n Inc, Uol. I, No.3 
D Graphics Files 
D TeHt Files 

Ig) Hpplication ..• 

Eject 

Oriue 

Open 

[ancel 

• To open a new 
document as you 
work, choose New 
from the File menu . 

2. Double·click the 
document name. 

You can double-click 
a folder to see 
its documents. 

You can click Eject 
or Drive to go 
to another disk. 

Pen 

36 39 
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To save a 
document 

Your document is not 
recorded on your disk 
until you save it. The 
first time ' you save it, 
you give it a name . 

1 Choose Save As 
from the File menu. 

A dialog box prompts 
you for the name of 
the document. 

2 Type the name of 
the document. 

The name may be up 
to 31 characters long. 
It can use any 
character except a 
colon (:) . 

If your disk uses the 
hierarchical file 
system, you can open 
folders and save your 
document in one. 

Click Eject or Drive to 
save the document on 
another disk. 

3 Click Save. 

The name of the 
document appears in 
the title bar of the 
window. 

• To save changes as 
you work, choose 
Save from the File 
menu. Save your 
changes often so you'll 
always have a recent 
version on your disk. 

• To create a new 
version of your 
document and save 
the old one, choose 
Save As and give the 
document a new name 
or save it in a new 
place. If you open 
more than one copy of 
a document, 
Ready,Set,Go! 
automatically asks you 
if you want to save it 
with a new name. 

CAUTION! If you 
save a copy with the 
same name as the 
original, it replaces 
the original version. 
See the Save 
command in 
Chapter 4 for details. 

• To save an article as 
a text-only document, 
select text or an 
insertion point, 
choose Put Text from 
the File menu, and 
name the document 

where you want to save 
the article . Then click 
Save . Ready,Set,Go! 
saves all the text in the 
block or a chain of 
linked blocks, includ­
ing overflow text. 

1. Choose Save As. 

Open ... 
Close 
Saue 

il€N 
il€O You choose Save to 

save changes as you work. 

, lIe'''l'' I"f, tloL 1, .. ~(g) Applicatio ... 
,.~ [!(~~uln Ine, 11(11. 1 j ." 

o Graphics Files L~ 
o TeHt Files [ Driue ) 

~aue current document as: ["}ftue=] 

2. Type the 
name of 
the document. 

3. Click Save. 

[ Cancel) 

You can double-click 
a folder to save a 

document in it. 

You can click 
Eject or Drive to save 

on another disk. 
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MANAGI NG THE DESKTOP 

The Windows 
To manage 
windows on the 
desktop 

You can open several 
windows on the 
desktop--as many as 
your internal memory 
allows. One window is 
always the active 
window. 

You can move an 
active window, change 
its size, and switch 
from one window to 
work in another. You 
can shrink or enlarge a 
window or close the 
window when you are 
finished with it. 

48/GO! 

• To make a window 
active, click in it. 

• To move an active 
window, drag its title 
bar. 

You can move a 
window without 
making it active by 
holding down the 
Command key while 
you drag its title bar. 

• Click the close box 
to close the window. 

• To change the size 
of a window, drag its 
size box. 

• To shrink or enlarge 
a window, click its 
zoom box. 

• To close a window, 
click its close box. 

If you 've made 
changes to a 
document without 
saving them, a dialog 
box asks you if you 
want to save the 
changes before you 
close the window. 
Click Yes to save 
them. See "To Save a 
Document" in this 
cha pter. 

• File Edit ('(HI I Sl~JI" Formal TeHt Special Fill lines Pen • Drag 
the title 
barto 
move the 
window . 

DeSign Inc, Uol I, No.1 Page 1 

• Click in a window to 
make it active. 
The active window is 
frontmost. 

• Drag the size box to 
change the size of a 
window. 

• Click 
the zoom 
box to 
shrink and 
enlarge the 
window. 
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To scroll a 
window 

A window displays one 
page or two facing 
pages at a time. Pages 
may be shown in full 
size, reduced, or 
enlarged . 

If you can't see the 
whole page in the 
window, you can scroll 
it-either vertically or 
horizontally-or drag 
it in any direction with 
the hand tool. 

You can also scroll to 
a new page. 

• To scroll a small 
amount, click one of 
the scroll arrows. 

You scroll in the 
direction the arrow 
points. 

• To keep scrolling, 
point to a scroll arrow 
and hold down the 
mouse button. 

• To scroll to a 
particular place on 
the page, drag a scroll 
box. 

The position of a 
scroll box within a 
scroll bar corresponds 
to your position on the 
page. So if you drag a 
scroll box to the 
middle of a scroll bar, 
you go to the middle 
of the page. 

• To go quickly to the 
edge of a page, click 
the gray area on either 
side of a scroll box in a 
scroll bar. 

• To go to another 
page, click its icon in 
the page scroll bar. 

The icons in the page 
scroll bar show the 
actual order of pages 
in your document. If 
you don't number the 
pages consecutively 

starting with page 1, 
the numbers in the 
icons do not 
correspond to the 
numbers on the 
pages . 

You can also go to a 
page by choosing Go 
To Page from the 
Special menu. A 
dialog box prompts 
you for the page 
number. 

• Select the hand tool 
to drag the page 
quickly in any direction. 

• Click the icon of 
the page you 
want to display. 

Pen 
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• Click to scroll a little. 

• Press to keep scrolling. 

• Click to 
go to 
the top or 
bottom 
of a page. 

• Drag to 
go to a 
particular 
place on 
the page. 
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of a page. 
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MANAGI NG THE DESKTOP 

The Windows 
To work with 
different views 
of a page 

A window can display 
a page in its actual 
size, or you can reduce 
or enlarge the view of 
the page to make it 
easier to work with. 

You can also display 
and work with different 
views of facing left and 
right pages. 

• To change the view 
of the window, 
choose one of the size 
commands from the 
Special menu . 

SO/ GO! 

The five size 
commands are below 
Facing Pages at the top 
of the menu. The 
current size is 
checked. 

• To display facing 
pages, select one of the 
pages you want to view 
from the page scroll 
bar and choose Facing 
Pages from the Special 
menu. 

A box displays the 
facing pages in the 
current view. To return 
to a single page, 
choose Facing Pages 
again from the Special 
menu. 

..ISize To Fit 311 I 
IIlIIf Size 8€2 

• Choo.e Facing 
Page. to di.play 
facing page •. 

15% Size 3113 
Actual Size 3114 

CAUTION! If you 
create an object that 
crosses facing pages, 
you must display 
faCing pages in order 
to print the object 
correctly. You must 
also choose Tiling with 
the Page Setup 
command. 

Do ubi e S i z e ?""'f-~----:-:::--;:----;---;::---:----;---;:--:;--;:--=-::-:-;-:-;-=~ ___ ----::----, 
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DESIGNING A DOCUMENT 

Designing a Document 

Preferen 
.,ces ... 

S2/ GO! 

D ocument design has several 

purposes. It directs the reader's 

eye. It highlights important 

information . It organizes information, too, 

binding an illustration with a paragraph 

of text , for example. Design also gives a 

document its own style, its own identity. 

Consistency is the key word here. If 

the design is consistent, its organization 

is apparent, and its style is recognizable. 

When you create a document with 

Ready,Set,Go! design has yet another 

purpose: to make it as easy as possible 

for you to produce final pages. 

Ready,Set,Go! has two features to help 

you with these design objectives: the grid 

and master pages. 

The Grid 

One of the first things you do when you 

start a new document is select a grid. A 

grid organizes a page into columns and 

rows . Ready,Set,Go! has eight standard 

grids, from one column by one row to 

eight columns by eight rows. You can also 

define your own grid, with the number of 

columns and rows you want. 

You can fill these columns and rows 

with text, illustrations , or graphic 

objects . When you create text blocks , 
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picture blocks, or graphic objects, they 

automatically "snap" to fit your grid. 

Sometimes you may want to use the 

grid as a visual gUide only, without 

automatically aligning every object you 

create. With Ready,Set,Go! you can turn 

off the grid and still see it. Or you can 

hide the grid completely. 

The grid also defines the page margins. 

The standard grids use preset margins for 

the top and bottom of the page as well as 

the inside and outside margins . Inside 

margins are the margins that separate two 

facing pages. Sometimes they are 

narrower than outside margins . If you 

create your own grid, you can change any 

of the margins to suit your needs. 

Everything you put on a page must fit 
within the print area-the area that your 

printer can actually print. A dotted line 

marks the outer edge of the priilt area. 

The ruler also works with the grid. 

You can choose one of three units of 

measure: inches , centimeters, or picas and 

points. When you define your own grid, 

you specify the measurements in the units 

you've chosen. 

The Page 

A document may have one page or many. 

The only limit is the amount of storage 

you have available on your disk and the 

internal memory available in your 

Macintosh. You can set the number of 

pages before you begin, or you can add 

and delete pages as you work. 

The preset page size in Ready,Set,Go! is 

usually 8.5 by 11 inches-depending on 

the printer you are using. But you can 

specify any page size you want, up to 99 

by 99 inches. For these larger page sizes, 

you can divide the page into sections 

called "tiles" for printing. 

If your document has many pages, one 

of the most useful tools is the master 

page. You create master pages for both 

the left and the right pages. On the 

master pages, you layout the elements 

that you want to appear on all the pages of 

the document-running heads , running 

feet, page numbers , rules, logos, and 

other repeating elements. Ready,Set,Go! 

then displays all these elements on the 

individual pages of your document. Of 

course , you can also create these 

elements individually on each page, but 
using master pages saves you time and 

helps ensure consistency from page to 

page. See "To Set Up Master Pages" in 

this chapter. 

DESIGNING A DOCUMENT/ 53 

picture blocks, or graphic objects, they 

automatically "snap" to fit your grid. 

Sometimes you may want to use the 

grid as a visual gUide only, without 

automatically aligning every object you 

create. With Ready,Set,Go! you can turn 

off the grid and still see it. Or you can 

hide the grid completely. 

The grid also defines the page margins. 

The standard grids use preset margins for 

the top and bottom of the page as well as 

the inside and outside margins . Inside 

margins are the margins that separate two 

facing pages. Sometimes they are 

narrower than outside margins . If you 

create your own grid, you can change any 

of the margins to suit your needs. 

Everything you put on a page must fit 
within the print area-the area that your 

printer can actually print. A dotted line 

marks the outer edge of the priilt area. 

The ruler also works with the grid. 

You can choose one of three units of 

measure: inches , centimeters, or picas and 

points. When you define your own grid, 

you specify the measurements in the units 

you've chosen. 

The Page 

A document may have one page or many. 

The only limit is the amount of storage 

you have available on your disk and the 

internal memory available in your 

Macintosh. You can set the number of 

pages before you begin, or you can add 

and delete pages as you work. 

The preset page size in Ready,Set,Go! is 

usually 8.5 by 11 inches-depending on 

the printer you are using. But you can 

specify any page size you want, up to 99 

by 99 inches. For these larger page sizes, 

you can divide the page into sections 

called "tiles" for printing. 

If your document has many pages, one 

of the most useful tools is the master 

page. You create master pages for both 

the left and the right pages. On the 

master pages, you layout the elements 

that you want to appear on all the pages of 

the document-running heads , running 

feet, page numbers , rules, logos, and 

other repeating elements. Ready,Set,Go! 

then displays all these elements on the 

individual pages of your document. Of 

course , you can also create these 

elements individually on each page, but 
using master pages saves you time and 

helps ensure consistency from page to 

page. See "To Set Up Master Pages" in 

this chapter. 

DESIGNING A DOCUMENT/ 53 



DES I G N IN GAD OC U MEN T 

The Grid 
To set up a 
standard grid 

The grid makes it easy 
to place objects on a 
page with consistency. 

A new document has 
no active grid. You 
can select one of the 
eight standard grids 
when you first design 
your document. 

Once you select a grid, 
it becomes active. If 
you create an object­
a text block, picture 
block, or graphic 
object- it "snaps" to 
fit one or more 
rectangles in the grid. 
If you want to create an 
object that does not fit 
the grid lines, you can 
turn the grid off. 

54/ GO! 

1 Choose Design 
Grids from the Special 
menu. 

A dialog box displays 
the eight standard 
grids . 

2 Click the standard 
grid option you want 
to use. 

3 Click OK. 

The grid appears on 
all the pages of your 
document. 

• To turn the grid off 
or on, chQose Snap To 
from the Special 
menu . When the grid 
is active, a check 
appears next to Snap 
To . 

,. , 

• To show or hide the 
grid, choose 
Preferences from the 
Special menu, click 
Show Grid, and click 
OK. An X indicates 
that the grid is 
showing. When the 
grid is hidden, it is no 
longer active and the 
Snap To command is 
dimmed. 

Facing Pages 

Size To Fit 

il€E 
.......... 

il€1 

1. Choose 
Design Grids. 

Half Size il€2 
75'1. Size il€3 

./Actual Size il€4 
Double Size il€5 

Insert Page(s) .. . 
Delete Page(s) .. . 
Go To Page ... 

2. Click the 
grid option. 

Preferences... / 
~nllil 10 r;=====1=====il 

./Use Master 

fliJ9"""Hl1 ... 

You can 
use this 

Desi n Grids 

01 H! 

02,2 

O' H 3 

4H4 

05 H 5 

06 H 6 

07 H 7 

option to - r Gridl~etup 
define your ~= ~ 
own gnd. \ 

3. Click OK. 
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DESIGNI NG A DOCUMENT 

The Page 
To define your 
own grid 

If you want to change 
the preset margins on 
a page or the space 
between rows and 
columns, you can 
define your own grid 
using any 
combination of rows 
and columns. 

Like a standard grid, a 
grid that you define 
appears on all the 
pages of your 
document and is 
active. So when you 
create objects, they 
"snap" to fit one or 
more grid rectangles. 

1 Choose Design 
Grids from the Special 
menu. 

A dialog box displays 
the standard grid 
options . 

2 Click Grid Setup if 
it's not already 
selected, and click 
OK. 

The Grid Setup dialog 
box displays the size of 
the margins, the space 

56/GO! 

between rows and 
columns, and the 
number of rows and 
columns in the grid. If 
the document is new, 
the settings define a 
grid with four rows 
and two columns. 

If you are using 
different inside and 
outside margins, 
Ready,Set,Go! 
automatically 
alternates margins on 
left and right pages if 
you select Double 
Sided. 

3 Typenew 
measurements for 
margins, row spacing, 
column spacing, and 
number of rows and 
columns. 

Just type to replace the 
selected number. 
Then press Tab to 
select the next 
number. 

• To design a grid for 
a Single-sided 
publication, deselect 
Double Sided in the 
Grid Setup box. Inside 
and Outside change to 
Left and Right, and the 
grid has the same left 
and right margin on 
every page. 

4 Click OK. 

The grid appears on 
all the pages of your 
document. 

Facing Pages 3€E 1. Choose Design Grids. 

Size To Fit 3€1 

Half Size ;::o3€~2k======~ 
75% Size Ir 2. Click OK to accept 

Grid Setup. "'Rclual Size 
Double Size 

Insert Pagels). 
Delete Pagels) 
Go To Page ... 

Preferences ... 
~n" p II) 

Design Grids 

0'"' 
02112 

04114 

05 II 5 

06 II 6 

07 II 7 

Note format for specifying picas and 
pOints-6.06 means 6 picas and 6 points. 

0811r,;-=~=~F===========~ 

",Use Masler 
_1'1 I 

flI 19nrn en1, .. 

@ Grid Selup 
Grid Setup 

Measuremen sin Picas.Poinls: 

Bollom: 16.00 1 
~~ 

Dutside: 14.00 1 

({]!J~ 
J.l",,======~1 Top: !IF'~'!H~~!I 

Inside: LI6_.0_6 __ -,1 

3. Type new grid 
specifications. 

4. Click OK. 

'-----' 

Row Spacing: ~ Column Spacing: ~ 

Number of Rows: Q:D Number of Columns: ~ 

181 Double Sided 
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To change the 
units of 
measure 

You can choose one of 
three units of measure 
when you work with a 
Ready,Set,Go! 
document: inches, 
centimeters, or picas 
and points. 

The rulers that appear 
in each window use the 
scale you choose. You 
also use this scale 
when you define your 
own grid or when you 
specify the size of 
objects. The preset 
scale is inches, but 
you can change it at 
any time. 

When you start 
Ready,Set,Go! the 
rulers measure across 
and down, starting at 
the upper left corner 
of the page. You can 
move the starting 
point anywhere on the 
page. 

1 Choose Preferences left corner of the rulers 
from the Special and drag to the 
menu. starting point on the 

page you want. The 
A dialog box displays rulers will snap to an 
several options. active grid. Click once 

in the small box to 
2 Click the Units return the starting 
option you want. point to the upper left 

corner of the window. 
3 Click OK. 

No matter where you 
• To change the place the starting 
starting pOint of the 
rulers, position the 
object pointer in the 
small box at the upper 

, . ; 

Facing Pages 3€E 1. Choose 
Preferences. 

Size To Fit 3€1 
Half Size 3€2 
75'7. Size 3€3 2. Click the Units 

,;Actual Size 3€4 option. 
Double Size 3€5 

Insert Poge(s) ... 
Delete Pagels) 

Preferences Go To Poge ... 

point of the rulers, 
positions of objects 
you specify with the 
Specifications 
command are always 
measured from the 
upper left corner of 
the page . 

• To show or hide the 
rulers, choose 
Preferences from the 
Special menu , click 
Show Ruler, and click 
OK. An X indicates 
that the rulers are 
showing. 

This option shows 
or hides -Units: 

~ @ Inches ow Ruler 
\nnp [I) 181 Show Print Areo 

the mlers. 

,;Use Master o Centimeters 
181 Show Bloclc Outlines 

Design Grids ... o Picos/Points o Use Froclionol Widths 
mi9nrnenL .. 

Storting Page o Disoble Font Scollng 

Number: 

II I DO ( concel] 

3. Click OK. 
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DESIGNI NG A DOCUMENT 

The Page 
To change the 
page size and 
orientation 

You can select one of 
five standard page 
sizes, or you can 
specify your own page 
size. You can use the 
page in its normal 
upright position or 
turn it sideways. 

New 
Open ... 
Close 
Salle 
Salle As". 

XN 
3110 
XW 
XS 

1 Choose Page Setup 
from the File menu. 

A dialog box displays 
the page sizes and the 
icons for the page 
orientation options. 

2 Click the size you 
want. 

If you want to define 
your own size, click 
Other and type the 
width and depth. 

1. Choose Page Setup. 

2. Click the size. 

3 Click the page 
orientation you want. 

If you are using a grid, 
the width and depth of 
columns and rows 
adjust to keep the same 
margins and spacing 
on the new page size. 
Make sure the grid is 

8.27 x 11.69 inches 

Quit IIflI Page Setup: Onentation: 

inside the print area 
for your page size and 
printer. 

4 Click OK. 

• To show or hide the 
print area, choose 
Preferences from the 
Special menu, click 
Show Print Area, and 
click OK. An X 
indicates that Show 
Print Area is selected. 

3. Click the orientation. 

Printer Setup... It. 6.93 x 9.84 inches 

~::in:::::::: F=====~/ Up to 99 x 99 inches 

11l'll'il:l\11 (l". II II 
8.5 X 11 inches tJL -:::J us letter 0. R ~ letter rr~<='----'lt§;=tQ~~----*II - upright orientation 

Q us legal (!) r, s letter .&i t:y 
8.5 X 14 inches I Q Tabloid Other "----*- Sideways orientation 
11 x 17 inches - Printer Effects: 

Width: 15 I inches 0 Tiling 

~I ==~I Tile Ouerlap: Depth: 7 inches 
11.0000 I inches 

o fl(l~Ji'lrnlion Mnrks 

4. Click OK. 
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To set up tiles 

If you want to create a 
page that is larger than 
the paper size your 
printer can handle or 
if you want to print 
objects that cross 
facing pages and fall 
outside the normal 
print area, you can 
divide your page into 
sections called "tiles. " 
When you print a page 
with tiles, 
Ready,Set,Go! 
calculates the size of 
the tiles and prints an 
overlap on each one 
to provide a 
continuous image. 
You can set the 
amount of overlap. 

1 Choose Page Setup 
from the File menu. 

A dialog box displays 
several options. 

2 Click the Tiling 
option. 

3 Type the amount of 
tile overlap you want. 

If you want to print 
registration marks , 
click Registration 
Marks. 

4 Click OK. 

Print ..• 
!,pt ·h~Ht. .. 
Put 1.~Ht. .. 

Poge Setup: 

The tiles do not 
appear on your 
screen, but the dotted 
rectangle that 
indicates the print 
area disappears and 
your page is printed in 
tiles when you print. 

1. Choose Page Setup. 

2. Click Tiling. 

3. Type the amount 
of overlap. 

Orientotion: 

o us letter 0 R4 letter 

o US legol 0 85 letter 

OTobloid @Other 

Width: l'c8nnm-1 inches 

Depth: 119.0000 1 inches 

Printer [ffects: 

181 Tiling 

Tile Ouerlop: 

11.0000 

(Cancel 1 
r-~~~---'-----------

4. Click OK. 

A 14x 19 
inch page is 
divided 
into four tiles 
for printing 
on 8.5 x 11 
inch paper. '......- ...... 

:::::;-;:; \ 
......... _ . 
..... O' ....... , 

.......... - I -_ ......... ,,,. . .... .. 
---'--. ....... _ ... _- -.-- .............. - ... ~-. ..... -.... - ... .., . ~....... ,.~_._ ... ,,-_ .. -..... -.,---.-"" .... _'-' -_ ................. -_ . .......................... - ............. - ... ...... - ... _ .-. ........ _ ..... 
_ , ....... ~. __ .. ,.,~._ .... _ , __ . _ .... ~.· .... _ ·, •• iI ............ -'" .. ,.-, .... -...... ~ , ............... -

,. Notes: 

Registration Marks 

Registration marks 
help you line things 
up. 

Paste-up artists use 
registration marks to 
align overlays on 
paste-up boards. 

Printers use 
registration marks, 
too. They are 
particularly 
important for printing 
pages with more than 
one color. Each color 
is printed with a 
different plate, and 
registration marks 
help the printer line up 
the images as they 
pass from plate to 
plate. 

When the corners of 
the registration marks 
on an oversized 
Ready, Set, Go! page 
are aligned, the tiles 
of the page fit together 
perfectly. 
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DESI GNI NG A DOCUMENT 

The Page 
To add blank or 
duplicate pages 

You can add one or 
more pages before or 
after the current page. 
The pages you add can 
be blank, or they can 
be copies of the 
current page. 

1 Choose Insert 
Page(s) from the 
Special menu. 

A dialog box prompts 
you for the number of 
pages and displays 
several options. 

6o/GO! 

2 Type the number of 
pages you want to add. 

The number you can 
add depends on the 
available memory in 
your Macintosh. 

3 Click the options 
you want. 

4 Click OK. 

If you duplicate a page 
with linked text blocks, 
you can select whether 
the duplicate is without 
links (None), with 
links on the duplicate 
page only (Local), or 
with the same links as 

Facing Pages 3€E 

Size To Fit 3€1 

1. Choose Insert 
Pagels). 

Half Size 3€2 
75% Size 3€3 

"Actual Size 3€F===============il 
Double Size 3€ ""' 

......... .... ................ ........ .......... 'f' I nsert After Current Page 

. , ; 'JaHIII!IIIJ " Insert Before Current Poge Delete Page(s)... 't' 
Go To Page... ~@ I nsert Blank Page 

Preferences... 0 Duplicate Current Page 
,>,,,,p'lo 

"Use Master links: ,\ .(lnH q 1.0( "I <i blob"l 

Design Grids ... /, I \ I 
flliqnrnHn1... II Number of P ges: L3+-__ --+J 

/ \ \0\ 
The new pages are if you are are duplicating 
added before or after a page that has links, 
the current page. you choose one of these 

three options. 

the original page, 
including links to 
other pages (Global) . 
Only the text blocks 
are duplicated, not 
their text. See 
"Working With Text" 
in this chapter. 

2. Type the 
number of pages. 

3; Click the 
options. 

4. Click OK. 
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To delete pages 

You can delete one or 
more pages from a 
document. 

1 Choose Delete 
Page(s) from the 
Special menu. 

A dialog box displays 
the number of the 
current page . 

2 Type the numbers of 
the first and last pages 
in the range you want 
to delete. 

CAUTION! The page 
numbers refer to the 
page numbers shown 
in the page scroll bar. 
The numbers that 
actually appear on the 
page may be different. 

If you want to delete 
only one page, type its 
number as both the 
first and the last page. 

, . . 
racing Page. il€E 1. Choose Delete 

Size To Fit il€1 
"alf Size il€2 
75'70 Size il€~ 

..... Rctual Size il€ 
Double Size il€ 

I n.ert Pagels) ... 
I' . . '.1' 

Go To Page ... 

Preference .... 
~nnl' To 

..... U.e Ma.ter 
De.ign Grid .... 
fili9n"l(m1... 

Pagels). 

Delete Pager.): D 

When the 
dialog box first 
appears, 
the page 
numbers are 
for the 
current page. 

Through: D 
rJD Hcancei)) 

3. Click OK. 

3 Click OK. 

The pages you selected 
are deleted. The 
remaining pages are 
renumbered in the 
page scroll bar . 

2. Type the 
numbers 
of the pages. 
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DES I G N IN GAD OC U MEN T 

The Page 
To set up 
master pages 

You can set up two 
master pages. The left 
master page is a 
template for all of the 
even-numbered pages 
in the document. The 
right master page is a 
template for the odd­
numbered pages. 

Everything that is 
visible on a master 
page is visible on the 
corresponding pages 
of the document. 

1 Click one of the two 
master page icons­
labeled "L" and "R"­
in the page scroll bar. 

The master page 
appears with a grid if 
you have displayed 
one. 

2 Enter text, pictures, 
and graphic objects 
that you want to 
appear on every left 
or right page of the 
document. 

62/ GO! 

See "Working With 
Text" and "Working 
With Graphics" in this 
chapter. See also "To 
Add Page Numbers 
Automatically" in this 
chapter. 

• To remove all 
master page elements 
from a document 
page, choose Use 
Master from the 
Special menu to turn 
off the master page for 
the current page. The 
check next to Use 
Master disappears 
when it is turned off. 

• To remove some 
master page elements 
from a document 
page, choose Use 
Master from the 
SpeCial menu to turn 
off the master page for 
that page. Then copy 
the elements you want 
from the master page 
and paste them on the 
document page. 

• File Edit lonl Sllll" rom",1 TeHt Spech,1 Fill lines Pen 1. Click 
one of the 
master 
page 
Icons. 

~O ., Design Inc, Uol. 1, No.3 Right Master ~ 0 

~ OIITU ' ..... I~,x:IOOO:I-,,1 I"t.JIIIIiI ¢l u('d'?i(..1 c> 
,1,,1,,1,,1, 1"1,,1,,1,, ,I" "I, 

I~ 
1-'.' 
1-'.' 

I~ 

2. Enter text, 
pictures, 
and graphic 
objects that are 
to appear on 
every right 
or left page. 

These appear 
on all odd-numbered 
pages. 

.fllC;".INC 
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To add page 
numbers 
automatically 

You can use the master 
pages to number the 
pages of your 
document 
automatically. 

You can start with 
page 1 or any other 
number. 

1 Click the icon for 
the right master page. 

2 Create a text block 
where you want the 
number to appear and 
select an insertion 
point. See "Working 
With Text" in this 
chapter. 

3 Hold down the 
Command, Option, 
and Shift keys, and 
type the number 3. 

Two number signs 
(##) appear in the text 
block. These show that 
automatic page 
numbering is in effect, 
and page numbers will 
appear in the same 
position on all odd­
numbered pages in the 

type, style, and size 
you choose. 

4 Repeat for the left 
master page to 
number all even­
numbered pages 
automatically. 

• To change the 
starting page number, 
choose Preferences 
from the Special 
menu, type the 
starting number you 
want in the dialog box 
and click OK. 

CAUTION! If the 
starting page number 
is not 1, the page 
numbers in the page 
scroll bar do not 
match the page 
numbers on the 
screen. When you 
delete pages, refer to 
the pages in the page 
scroll bar. 

1. Click the Icon for 
the right master page. 

it File Edit Ion. S.!Jle I "'Hlil. TeHt Special Fill Lines Pen 

~ Design Inc, Uol. 1, NO.3 Right Moster 

It: {'ilITl X ..... IQg ;xID 001- '--I uJIl ¢U'l('dl'lL4] 
2 15 1 B . ~~ 24 27 30 33 36 39 42 4:5 48 S1 a-

S1 

I~ 

16li .·.·.·.· .•. · .·. · ~ .•.•.. ·;~;2~ 
~ 
I;;: 

~ ~. : ... ' " 

.. 

Page numbers are 
entered automatically in 
this position on every 
corresponding page. 

4. Aepeatfortheleft 
master page. 

' .....•.... Q] 

2. Create 
a text 
block for 
the page 
number 
on the 
master 
page. 

3. Hold 
down the 
Command, 
Option, 
and Shift 
keys, 
and 
press 3. 
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Working With Objects 

64/GO! 

cut 
coPY 
paste 
(\ear 

III 

Briog t 
a Froot 

w hen you create a page in 

Ready,Set,Go! you work with 

objects. There are three kinds 

of objects: text blocks, picture blocks , 

and graphic objects. 

A text block is an area where you 

enter text. When you are working in a 

text block, Ready,Set,Go! becomes a 

powerful word processing system with 

capabilities for formatting text , 

hyphenating, searching and replacing, and 
checking spelling. 

A picture block is an area where you 

enter pictures you have created in 

Macintosh graphics or scanning 

applications. 

A graphic object may be one of many 

shapes: rectangles, squares, rectangles 

with rounded corners , ovals , circles, and 

vertical, horizontal , or diagonal lines . 

When you work with objects, you can 

work with an individual object or several 

objects at once. 
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The 'Ob,· ect 

You .ea e . oboe b\- ele - a 001 

from the 001 00 :- a d drawin _ O nce you 

create it. you can moye i on the page , 

mO\-e it or copy it to another page, make 

it larger or smaller, or remove it from 

the document entirely . You can lock its 

size and position. You can also make 

duplicate copies and automatically space 

them across the page to create forms or 

complex diagrams , for example. 

If the grid is active when you draw an 

object, it snaps to fit the grid. Its outside 

borders enclose one or more of the grid 

rectangles. This Snap To feature makes it 

easy to align objects exactly when the 

grid is active. 

Sometimes, though, you need to 

position objects precisely without 

aligning them to a grid rectangle _ In these 

cases , you can specify the size and 

position of the object, using one of the 

three units of measure available in 

Ready,Set,Go! 

A Group of Objects 

Often you want to work with a group of 

objects rather than a single object. For 

example, you may want to copy an entire 

page to another document. Or you may 

want to copy a masthead composed of 

several objects from an old issue of a 

newsletter . 

With Ready,Set,Go! you can select 

several objects at once. Then you can 

work with the selected group in many of 

the same ways as you work with a single 

object-moving, copying, duplicating, and 

removing it as necessary. You can also 

lock a group of objects in place. 

You can change the arrangement of a 

group of objects. You can align their tops, 

bottoms, or sides , or center them 

hOrizontally or vertically. You can also 

stack them so they overlap, and then 

rearrange their order in the stack by 

sending the object on top behind the 

stack or bringing the one on the bottom 

of the stack in front. 

I 
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WORK I NG WI TH OBJECTS 

The ObJ"ect 
To create an 
object 

You can create three 
kinds of objects on a 
page: a text block, a 
picture block, and a 
graphic object. 

You create these 
objects with tools from 
the tool bar. 

• To create a text 
block, select the text 
tool, position the 
pointer on the page, 
and drag to draw the 
block. 

See "To Create a Text 
Block" in this chapter. 

• To create a picture 
block, select the 
picture tool, position 
the pointer on the 
page, and drag to draw 
the block. 

See "To Create a 
Picture Block" in this 
chapter. 

66/GO! 

• To create a graphiC 
object, select one of 
the shape tools, 
position the pointer 
on the page, and drag 
to draw the shape. 

See "To Draw a 
Graphic Object" in 
this chapter. 

As you drag to draw an 
object, a dotted 
rectangle or line shows 
its size and position. 

When you release the 
mouse button, the 
object appears. 

Handles show that the 
object is selected. If 
you continue to create 
the same kind of 
object, all stay 
selected until you 
choose a new tool. 

If the grid is active, the 
object snaps to fit one 
or more of the 

rectangles in the grid. 
If you change the grid, 
the object keeps its 
original size and 
position . 

• To show or hide 
text and picture block 
outlines, choose 
Preferences from the 
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Show Block Outlines, 
and click OK. An X 
indicates that Show 
Block Outlines is 
selected. 

• Select the text tool • Select one of the 
and drag to shape tools and drag to draw 
draw a text block. a graphic object. 

L1~1 ~i X i .... l~i xl t5i(5iC5illi~1 
• Select the picture 
tool and drag to draw 
a picture block. 

Empty pic'.,"" bloc," ~I 
have a solid border with · . .. .. - .. . .. 

a large X inside. : : ""' 

Text blocks have dotted V ~ ~ 
lines for borders _ 

Graphic objects have : 
borders in the pen pattern / 

and line size you select. 
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To select an 
object 

When you first create 
an object, it is 
selected. You can also 
select an object as you 
work with the object 
pointer. You do this 
when you want to 
move or copy the 
object, change its size, 
remove it from the 
document, or lock or 
unlock it. 

1 Select the object 
pointer from the tool 
bar by clicking it. 

2 Point to the object 
you want to select and 
click. 

To select a line, 
position the tip of the 
pointer exactly on the 
line and click. 

If you are working on 
one of the pages of the 
document, you cannot 
select an object that 
you created on a 
master page. See "To 
Set Up Master Pages" 
in this chapter. 

L1 1. Select the object pointer. 

l~l 
o 

See "To Select a Group 
of Objects" in this 
chapter if you want to 
select more than one 
object. 

• To deselect an 
object, click anywhere 
on a blank area of the 
page with the object 
pointer or click 
another object. 

2. Click 
the object. 
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The Object 
To specify 
an object's size 
and position 

After you create an 
object, you can 
specify its size and 
position with greater 
precision than you 
might achieve when 
drawing with one of 
the tools in the tool 
bar. 

1 Select the object 
whose size and 
position you want to 
specify. 

2 Choose 
Specifications from 
the Edit menu. 

A dialog box shows the 
current position and 
size of the selected 
object, using the units 
of measure you 
selected with the 
Preferences 
command. A different 
dialog box appears for 
text blocks, picture 
blocks, and graphic 
objects. 

68/GO! 

3 For the Start Across 
position, type the 
distance from the left 
edge of the page to the 
object. For the Start 
Down position, type 
the distance from the 
top of the page to the 
object. 

Any number you type 
replaces the selected 
number. You can use 
the Tab key to select 
the next number. 

4 Type the width and 
depth of the object. 

5 Click OK. 

The object appears in 
its new position and 
size. It is not affected 
by the grid. 

• To specify the 
positions and sizes of 
objects in a group, 
select the group and 
choose Specifications. 
A dialog box appears 
for each of the 
selected objects in the 
group. Click OK or 
Cancel to go to the 
next dialog box. 

1. Select the object. 

2. Choose 
Specifications. 
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3. Type the new 
position. 

4. Type the new 
size. 

5. Click OK. 
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To move an 
object on a page 

You can quickly move 
an object on the page. 

1 Select the object 
pointer from the tool 
bar. 

2 Position the pointer 
in the object and drag 
the object to the new 
position. 

As you drag, a dotted 
outline shows the size 
and position of the 
object. If you move 
the pointer past the 
window border while 
dragging, the page 
scrolls in that 
direction. 

Objects you move do 
not snap to the grid 
the way they do when 
you create them or 
change their size. To 
position objects with 
precision, see "To 
Specify an Object's 
Size and Position" in 
this chapter. 

If you drag a handle by 
mistake, the object 
changes size. If this 
happens , choose 
Undo from the Edit 
menu before you do 
anything else. 

You can also specify 
an object's position 
with the Specifications 
command. 

CAUTION! If you 
drag an object outside 
the page area, you 
may lose it. To 
recover it, select the 
object pointer, 
choose Select All from 
the Edit menu, hold 
down the Shift key, 
and drag the object 
pointer from the top 
left corner to the 
bottom right corner of 
the page to deselect all 
outside objects. Then 
choose Specifications 
from the Edit menu. A 
dialog box appears for 
each object outside 
the page area and you 
can specify a new 
position. 

L1 
1. Select the 
object 
pointer. 

2. Position 
the pointer in 
the object 
and drag. 

A dotted line 
shows the 
position and size 
of the object as 
you drag. 
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The Object 
To move or copy 
an object to 
another page 

You can copy or move 
an object from one 
page of a document to 
another or from one 
Ready,Set,Go! 
document to another. 

1 Select the object 
you want to copy or 
move. 

2 Choose Copy from 
the Edit menu to copy 
the object. Or choose 
Cut from the Edit 
menu to move it. 

A copy of the object is 
placed on the 
clipboard, replacing 
the last thing you 
copied or cut. If you 
choose Cut, the object 
is removed from the 
page. 

You cannot cut a 
locked object. See "To 
Lock an Object" in this 
chapter. 

3 Go to the page 
where you want 'to 
copy or move the 
object. 

70/GO! 

Click the page number 
in the page scroll bar. 
If you want to place the 
object in a different 
document, open the 
document and go to 
the page. 

4 Choose Paste from 
the Edit menu. 

The object is pasted 
on the page in the 
same position it was in 
on the page you 
copied or moved it 
from. If you don't see 
it in the window, scroll 
to find it or change the 
view of the page. If you 
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2. Choose Copy 
or Cut. 

3. Go to the 
new page. 

4. Choose Paste. 

:dltrKuk. _skfoxf'lr 

still don't see it, 
change the Page Setup 
options to match 
those of the document 
you cut or copied the 
object from. Then 
drag it to a new 
position before you 
reset the Page Setup 
options. 

L1 
1. Select 
the object. 
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To duplicate an 
object 

You can make one or 
more duplicate copies 
of an object and 
position them at 
regular intervals on 
the page. Duplicating 
objects makes it easy 
to construct forms. 

1 Select the object 
you want to duplicate. 

2 Choose Duplicate 
from the Edit menu. 

A dialog box prompts 
you for the number of 
copies and the 
distance you want 
between copies on the 
page. 

3 Type the number of 
copies you want. 

4 For Horizontal 
Offset, type the 
distance from the left 
side of the original 
object to the left side 
of the first copy. 

If you want to align the 
objects vertically, type 
o for the horizontal 
offset. 

5 For Vertical Offset, 
type the distance from 
the top of the original 
object to the top of the 
first copy. 

If you want to align the 
objects horizontally, 
type 0 for the vertical 
offset. 

L1 1. Select an object. 

3. Type the number of 
copies. 

4. Type the horizontal 
offset. 

5. Type the vertical 
offset. 

6. Click OK. 

The hOrizontal 
offset is O. 

The vertical 
offset is 

24 points 
(2 picas equals 

24 points). 

6 Click OK. 

The copies appear on 
the page in the 
positions you 
specified. The last 
copy is selected. 
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The Object 
To change 
the size of an 
object 

You can quickly 
change the size of an 
object. 

1 Select the object 
you want to change. 

2 Position the pointer 
on one of the handles. 

3 Drag to make the 
object larger or 
smaller. 

If you drag one of the 
corner handles, you 
change the size both 
horizontally and 
vertically. If you drag 
one of the top, 
bottom, or side 
handles, you change 
the size only 
horizontally or 
vertically. 

As you drag, a dotted 
rectangle shows the 
size and position of 
the object. If you 
move the pointer past 
the window border 
while dragging, the 
page scrolls in that 
direction. 

72/ GO! 

If you aCCidentally 
drag the whole object, 
keep holding the 
mouse button down 
and drag the object 
back so the dotted 
outline is on top of the 
original border. 

If the grid is active, the 
object snaps to fit one 
or more of the 
rectangles in the grid. 
You can turn off the 
grid with the Snap To 
command in the 
Special menu . 

S I 

For greater precision, 
you can specify the 
size of the object with 
the Specifications 
command. See "To 
Specify an Object's 
Size and Position" in 
this chapter. You 
cannot change the size 
of a locked object. See 
"To Lock an Object in 
this chapter. 

L1 
1. Select the 
object. 

2. Point to a 
handle. 

3. Drag to 
make the 
object larger or 
smaller. 

Comer handles 
change the size in 
any direction. 

Side handles 
change the 
horizontal size. 

Top and bottom 
handles 
change the 
vertical size. 
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To remove an 
object 

You can permanently 
remove an object 
from a document. 

1 Select the object 
you want to remove. 

2 Choose Clear from 
the Edit menu . Or 
press the Backspace 
key. 

The object is 
removed. 

If you want to store a 
copy of the object on 
the Clipboard, use the 
Cut command to 
remove it. 

If the object you're 
removing is a text 
block linked to other 
text blocks, see "To 
Remove Linked Blocks 
From a Chain" in this 
chapter. 

You cannot remove a 
locked object. See "To 
Lock an Object" in this 
chapter. 

• To restore an 
object that you've 
removed, choose 
Undo from the Edit 
menu before you do 
anything else . 
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WORKI NG WI TH OBJECTS 

The Object 
To lock an 
object 

You can lock the size 
and position of 
objects . 

1 Select the object 
you want to lock. 

2 Choose Lock from 
the Edit menu. 

When objects are 
locked, you cannot 
move them, change 
their size, or remove 
them from the page. 
You can copy and 
duplicate them. The 
copies are also locked. 
You can also move 
locked objects in front 
or in back of other 
objects . 

74/GO! 

You can change the 
text in a locked text 
block or the picture in 
a locked picture block. 
You can also change 
the border and fill 
patterns in locked 
graphic objects. 

You can also lock 
objects with the 
Specifications 
command from the 
Edit menu. 
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• To unlock an 
object, select it and 
choose Unlock from 
the Edit menu . You 
can also unlock an 
object with the 
Specifications 
command. 

You cannot move 
a locked object, 

change its size, or 
remove it with 

the Cut or Clear 
command. 
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2. Choose Lock. 

You can unlock a 
locked object 

with the Unlock 
command. 
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2. Choose Lock. 

You can unlock a 
locked object 

with the Unlock 
command. 



A Group of Objects 
To select a 
group of objects 

You can select a group 
of objects. Then you 
can move, copy, 
duplicate, or lock 
them. You can also 
remove all of them. 

1 Select the object 
pointer from the tool 
box by clicking it. 

2 Position the pointer 
on the page. 

3 Drag to draw a 
selection rectangle 
around the group. 

Ready,Set,Go! selects 
all the objects in the 
rectangle or that touch 
its border. 

Handles show that all 
the objects in the 
group are selected, 
though some handles 
may not be visible. 

If you are working on 
one of the pages of the 
document, you cannot 
select an object that 
you created on a 

master page. See "To 
Set Up Master Pages" 
in this chapter. 

• To select an 
additional object, 
hold down the Shift 
key and click the 
object. 

You can also hold 
down the Shift key and 
drag the object 
pointer to surround an 
additional group of 
objects with a dotted 
rectangle. When you 
release the mouse 
button, they are 
selected. 

• To deselect an 
object in a group of 
selected objects, hold 
down the Shift key and 
click the object. 

L1 1. Select the object pointer. 

.. File Edit f onl Sl !JI(! f 01 Hldl TeHt Specinl Fill Lines Pen 

o. choose· rr===========::;: :~;:CS~1a~~~;:~~,. 
4 e.:e? 'Y'OUNw "~Ikhnln" 

dltlCOm. . 

4 bUl( mu­
SVk 
oudy, wit\ 

1 ~nd.·Yn1i(11 

...w:d4tU1t 
IpJOdLr.ct 

1I;1clustc., 
;s.'ny.1t. 

X\S urif 

2. Position the 
pointer 
on the page. 

3. Drag to draw 
a selection 
rectangle around 
the group. 

rNikt itilppulb bl! 1 sin- . 
:,ltvis.wlunit . 
. Youdon'tn,ud b wludt 
:\Klldslkr ''Conparv,'' . 
·'':'[nc ,," 01 't. 11," in tlI: 
'loso-uruus, of (oun(, 
't\oS( ~1ds b«otN in . 
:(l!]cpu1Siw p:ntofbt Joso .. 
'(Tht: ''INC''lnOW nust'll:ld 
:isln()Q~lf:-> 

1 

A GROUP OF OBJECTS175 

A Group of Objects 
To select a 
group of objects 
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WORKI NG WI TH OBJECTS 

A Group of Objects 
To stack 
objects 

You can stack objects 
so they overlap 
completely or 
partially. You simply 
move them on top of 
one another. 

When you stack 
objects, you can 
change the order in 
which they are 
stacked. 

1 Select the object 
you want to move. 

2 Choose Bring To 
Front or Send Behind 
from the Edit menu. 

If you choose Bring To 
Front, the selected 
object appears on top 
of any objects it 
overlaps. 

76/GO! 

If you choose Send 
Behind, the selected 
object moves behind 
the other objects in 
the stack. 

If you select a group 
and choose Bring to 
Front or Send Behind, 
the entire group 
appears in front of or 
behind other objects. 

• To find an object 
that has disappeared 
behind another 
object, select the 
object you can see and 
choose Send Behind. 
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To align objects 

You can align a group 
of objects you select 
horizontally or 
vertically. 

You can align them 
along their tops , their 
sides, or their centers. 

1 Select the group of 
objects you want to 
align. 

See "To Select a Group 
of Objects" in this 
chapte r. 

2 Choose Alignment 
from the Special 
menu. 

A dialog box prompts 
you for the kind of 
alignment you want. 

3 Click the options 
you want. 

If you align objects 
along their tops , 
bottoms, or left or 
right sides, the objects 

move to align with the 
object farthest in the 
direction you choose. 
For example, if you 
align right sides, the 
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objects align with the 
right side of the object 
farthest to the right. 

... 

. . 
Rlign Objects 

left Sides 

If you align centers, 
the objects align along 
a vertical or horizontal 
center line. 

4 Click OK. 
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Working With Text 

T
ext can play many roles in a 
document. It can be the long 

paragraphs of a report that goes on 

for pages , neatly arranging facts and ideas 

for a reader. Or it might be a few, well­

planned paragraphs, short and to the 

point, that describe a product or service 

in a brochure for prospective customers. 

It might be a quick message, no more than 

a line or two, to give focus to a poster. 

Because text can be all these things, 

Ready,Set,Go! is designed to handle it 

with flexibility, efficiency, and power. 

Ready,Set,Go! gives you complete word 

processing capabilities, with access to a 

variety of styles and formats. You can 

choose them as you work. Or you can set 

up stylesheets before you begin for fast 

and consistent formatting. Basic aids such 

as hyphenation options and spelling 

checking also save you time. 

The Text Block 

The text block is the basic element of the 

word processing system. You always 
enter text in a text block. The text block 

can fill a page or a column or be just big 

enough to fit a caption or even a page 

number. You never enter text in a 

document without first creating a text 

block for it. 

78/ GO! 

Once you create a text block, you can 

enter text directly by typing. Or you can 

enter the text of a document that you 

create with another application. You can 

select text in a text block to edit it, 

move it, copy it, replace it, or remove it. 

You can even overlap a text block with 

another text block, a picture block, or a 

graphic object and make the text run 

around the object. 

A Chain of Blocks 

Of course, your document may have 

articles that span several columns or 

pages. So you can link text blocks into a 

chain. The text in a chain flows 
continuously from one block to the next. 

If you add or remove text, all the text in 

the chain adjusts immediately, so you 

don't have to reenter text in each block 

individually. 

You can add or remove blocks from a 

chain and copy blocks from one page to 

another. If you duplicate pages with 

linked blocks, you can automatically link 
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enter the text of a document that you 

create with another application. You can 

select text in a text block to edit it, 

move it, copy it, replace it, or remove it. 

You can even overlap a text block with 

another text block, a picture block, or a 

graphic object and make the text run 

around the object. 

A Chain of Blocks 

Of course, your document may have 

articles that span several columns or 

pages. So you can link text blocks into a 

chain. The text in a chain flows 
continuously from one block to the next. 

If you add or remove text, all the text in 

the chain adjusts immediately, so you 

don't have to reenter text in each block 

individually. 

You can add or remove blocks from a 

chain and copy blocks from one page to 

another. If you duplicate pages with 

linked blocks, you can automatically link 



the blocks on the new page to those on 
previous and following pages. See "To 
Add Blank or Duplicate Pages" in this 
chapter. 

Style and Format 

You can select text in a block or chain of 
linked blocks and then choose the font , 
style, and size you want. You can also 
change the text alignment, character 
spacing, word spacing, line spacing, and 
paragraph spacing. You can shift 
characters in a line up or down, a point at 
a time, if you want. You can choose 
different styles of paragraph indentation. 
You can make these choices one at a time , 
or you can set up all the type 
specifications with a Single command 
before you begin to enter text. See "To 
Set Up Type Specifications" in this 
chapter for the step-saving instructions. 

Each character in a document carries its 
own format information. So if you insert 
text in an existing line of text, it has the 
same format as the preceding character, 
including invisible characters such as 
spaces and return characters. Formats for 
lines and paragraphs are determined by 
the first character in the line or 
paragraph. 

Time-Savers 

Ready,Set,Go! has several features to help 
save you time as you work. Perhaps the 
most important is the stylesheet. 
Stylesheets are sets of type specifications 
that you can choose as you work. For 
example, you can create a style sheet for 
chapter titles. Then, whenever you type a 
chapter title, you just choose the 
stylesheet to format it. If you change the 
stylesheet, it automatically changes all 
the chapter titles. 

You can also create glossaries for 
standard text-a few lines or many 
paragraphs- that you use over and over 
again. When you want to use this text in a 
document, you just choose it from a list of 
glossaries and Ready,Set,Go! automatically 
inserts it, already formatted, in your 
document. 

Other time-savers are automatic 
hyphenation, with specifications that you 
can select, and spelling checking. You can 
also search a document for particular 
phrases and replace them automatically 
with other phrases or formats . 
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WORKI NG WI TH TEXT 

The Text Block 
To create a text 
block 

Before you can enter 
any text, you must 
create a text block. 

1 Select the text tool 
from the tool bar by 
clicking it. 

2 Position the pointer 
on the page in the 
window. 

SO/GO! 

The pointer changes 
to a crossbar when you 
move it inside the 
window. 

3 Drag the pointer to 
draw the text block. 

As you drag, a dotted 
rectangle shows the 
size and position of 
the text b lock. When 
you release the mouse 
button, the dotted 
rectangle remains 
and the text block is 
selected. If you create 
more text blocks, they 
all stay selected until 
you select another 
tool. 

1. Select the text tool. 

If the grid is active, the 
text block snaps to fit 
one or more 
rectangles in the grid. 

You can change the 
size of a text block, 
move it, copy or 
duplicate it, lock it, or 
remove it. See 
"Working With 
Objects" in this 
chapter. 
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To enter text by 
typing 

You can enter text 
directly in a text block 
by typing. 

1 Select the insertion 
pointer from the tool 
box. 

2 Click in the text 
block where you want 
to begin typing. 

When you move the 
pointer into the 
window, it changes to 
an I-beam. 

If you click in an empty 
text block, the 
insertion point 
appears at the upper 
left corner of the 
block. If you click in a 
text line , it appears 
where you click. If you 
dick in the empty area 
of a text block with 
some text, the 
insertion po int 
appears at the end of 
the text. 

3 Type to enter text at 
the insertion point. 

Before you type, you 
can choose the font , 
style, and size you 
want. You can also 
select text and change 
its type or format, 
replace it with new 
text, or remove it 
completely. 

As you type, lines wrap 
automatically to the 
next line, so you press 
Return only at the end 
of a paragraph. 

If you type more text 
than the block can 
hold, the overflow 
indicator appears in 
the lower right corner 
of the text block and 
the text is stored as 
overflow. You can 
change the size of the 
text block to display 
overflow text. You can 
also link the text block 
to another text block. 
See "To Link Text 
Blocks" and "To Add 
Text Blocks to a 
Chain" in this 
chapter. 
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.ot4SiyiC· 
:OltBtyittne_ir:s roots: 
-ia tM urlilSt ia.ys of. pUt­
:Di'. W'lIt .. 1M fwst tnt 
·)lodts .:iaicttl r~"lII~­
:,,:11:.., 

2. Click in the text 
block. 

A blinking vertical 
bar marks the 
insertion point. 

3. Type the text. 

You can choose fonts, 
styles, and sizes before 
you begin, or change 
them after you type. 

-Old Siv·le . . 
:o:w. 8tJ~ tnt Us :Is roots 
·ia 1M ,lIf"liut la.ys oC pr:i¥:- . 
:bIr, w ... 1M frst tnt 
·)locts aiaickd, rifttt~k- . 
:Halwy u.MwrZtn. lttttrs. . 
·:e.e"'IISt IMy ... 1'I itsiptt : 
"to JooC like 1M hU.wr:iltu, 
(~S, IMY bw the suat : 
)lictI: wtmstroku that .. · 
-flat-tind Ita }f'04w:u, 
:~nr:). series lUI cW'Vt w 
:taler to .... Uilt. 

]a 1M .i8'~"1II:k c:utwy, 
-soa. tnt w.ilits ril . 
: ..... lttttn alIiaon ~. 
'zoKal sris Meu to 
:.,)Ut. n. «IKnst 
·MtwttatU:tr: ..... Im 
:WOkts was i'Ullf' tlaa ia . 
:tM OKIty» Wt.iliIs . . 

:_ .. ,10< 0( tnt, 
.Mlit'ft it or JIOt, ",:pun' 
"&st: b. tM lIItt 1700s. 
:nm [aaillts W twry­
~t" Trus::lt:ioul faai-' 
:~ u., oal,.... n. --1. 

\ 
The overflow 
indicator 
means 
more text 
follows. 
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To enter text by 
typing 

You can enter text 
directly in a text block 
by typing. 

1 Select the insertion 
pointer from the tool 
box. 

2 Click in the text 
block where you want 
to begin typing. 

When you move the 
pointer into the 
window, it changes to 
an I-beam. 

If you click in an empty 
text block, the 
insertion point 
appears at the upper 
left corner of the 
block. If you click in a 
text line , it appears 
where you click. If you 
dick in the empty area 
of a text block with 
some text, the 
insertion po int 
appears at the end of 
the text. 

3 Type to enter text at 
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Before you type, you 
can choose the font , 
style, and size you 
want. You can also 
select text and change 
its type or format, 
replace it with new 
text, or remove it 
completely. 

As you type, lines wrap 
automatically to the 
next line, so you press 
Return only at the end 
of a paragraph. 

If you type more text 
than the block can 
hold, the overflow 
indicator appears in 
the lower right corner 
of the text block and 
the text is stored as 
overflow. You can 
change the size of the 
text block to display 
overflow text. You can 
also link the text block 
to another text block. 
See "To Link Text 
Blocks" and "To Add 
Text Blocks to a 
Chain" in this 
chapter. 
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WORK I NG WI TH TEXT 

The Text Block 
To get text from 
another 
document 

You can get text from 
documents you create 
with MacWrite 4.5, 
Microsoft Word 1.05 
or 3.0, or WriteNow! , 
or from a text-only 
(ASCII) document. 

1 Select the insertion 
pointer from the tool 
bar. 

2 Select an insertion 
point in the text block 
where you want to 
enter text. 

See "To Enter Text by 
Typing" in this 
chapter. 

3 Choose Get Text 
from the File menu. 

A dialog box lists the 
documents that are 
available on the 
current disk. If you are 
using the hierarchical 
file system, it also lists 
folders. You can open 
the folders to view 
additional folders and 
their documents. 

S2i GO! 

You can click the Eject 
or Drive button to go 
to another disk. 

4 Select the document 
you want and click 
Open. Or just double­
click the name. 

The document you 
open is inserted at the 
insertion point. If it is 
a text-only document, 
it is entered with the 
formats of the 
insertion point. If it is 
a document from a 
compatible word 
processing applica­
tion, it keeps the font , 
style, size, line spac­
ing, paragraph inden­
tation, tabs, and other 
formats, depending 
on the application. 

If the document is 
longer than the text 
block or chain of 
linked blocks, it is 
stored as overflow 
text. You can change 
the size of the text 
block or link the block 
to another one to 
display the overflow 
text. See "A Chain of 
Blocks" in this 
chapter. 
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To select text 

\Vhen you \\-ant to 
change text or remo\-e 
it , you must first select 
it. Selected text is 
highlighted , with white 
characters on a black 
background (unless 
you select White 
Type). 

• To select text in a 
text block, place the 
insertion po inte r at 
the beginning of the 
text and drag to the 
end of it. 

You can drag down the 
page to select more 
than one line. 

If you find it difficult to 
select an insertion 
point at the beginning 
of a line, place the 
insertion pointer in 
the middle of the first 
character and click. 

• To select one word 
qUickly, double-click 
anywhere in the word. 
Hold down the 
Command key while 
you double-click a 
word to select just the 
word, not any space 

character that follows 
it. Double-click and 
drag to select as many 
entire words as you 
want_ 

See "Shortcuts" in 
Chapter 4 for other 
ways to select text. 

• To make an 
extended selection in 
a text block or linked 
blocks, click to select 
the insertion point at 
the beginning of the 
selection . Then place 
the pointer at the end 
of the selection, hold 
down the Shift key, 
and click. 

You can scroll to the 
end of the selection­
on the same page or 
another page-before 
you hold down the 
Shift key and click. 

You can also drag 
directly from one 
linked text block to 
another on the same 
or faCing page to select 
all the text in between. 

anywhere in the block 
and choose Select All 
from the Edit menu . 

-. To select all the text 
in just one linked 
block, select an 
insertion point in the 
block, hold down the 
Option key, and 
choose Select All from 
the Edit menu. 

• To select all the text 
in a text block or 
linked blocks, select 
an insertion point 
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II 
• Select an insertion 
point and drag to 
select text. 

• Select an insertion 
point and choose 
Select All from the 
Edit menu to select all 
the text in a block. 
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To select text 
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Shift key and click. 

You can also drag 
directly from one 
linked text block to 
another on the same 
or faCing page to select 
all the text in between. 

anywhere in the block 
and choose Select All 
from the Edit menu . 

-. To select all the text 
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• To select all the text 
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• Select an insertion 
point and drag to 
select text. 

• Select an insertion 
point and choose 
Select All from the 
Edit menu to select all 
the text in a block. 
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WORKI NG WI TH TEXT 

The Text Block 
To copy part of 
a document 

You can copy part of 
the text from a 
document that you 
create with 
Ready,Set,Go! or 
almost any other 
Macintosh 
application. You use 
the Clipboard or the 
Scrapbook. 

84/GO! 

1 Open the document 
with the text you want 
to copy. 

If necessary, quit 
Ready,Set ,Go! 

2 Select the text you 
want and choose Copy 
from the Edit menu to 
copy it to the 
Clipboard. 

To copy several 
selections before 
quitting, use the 
Scrapbook. See your 
Macintosh owner's 
guide for details about 
the Scrapbook. 

3 Open the 
Ready, Set,Go! 
document where you 
want to enter the text. 
If necessary, quit the 
other application. 

Undo Typing il€2 1. Open the document with the text you want. 

Cut il€H 2. Select the text and choose Copy. 
Paste il€U 
Clear 
Show Clipboard 
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Preferences ... 

letterfonns 
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Page I 

3. Open the 
Ready,Set,Go! 
document. 
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4 Select an insertion 
point in the text block 
where you want to 
enter the text. 

See "To Enter Text by 
Typing" in this 
chapter. 

5 Choose Paste from 
the Edit menu. 

If the text is from 
another 
Ready ,Set ,Go i 
document, it keeps all 
of its original formats . 
If it's from another 
application, the text 
uses the formats at the 

insertion point. See 
"The Format Menu" in 
Chapter 4 for details 
about formats. 

If you use the 
Scrapbook, open the 
Scrapbook and scroll 
to the text you want 
before you choose 
Copy. If you don't see 

your selections in the 
Scrapbook, make sure 
the Scrapbook you are 
using is on the same 
startup disk as the one 
you used with the other 
application. 

• File Edit Font Style Formnt TeHt Speclnl fill Ime. Pen 4. Select an 
insertion 
point in 
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WORKI NG WI TH TEX T 

The Text Block 
To replace, 
move, or 
remove text 

You can replace, 
move, or remove any 
selected text. 

• To replace text, 
select the text you want 
to replace and type 
new text or choose 
Paste from the Edit 
menu to replace the 
selected text with the 
contents of the 
Clipboard. 

• To move text to a 
new location, select 
the text you want to 
move and choose Cut 
from the Edit menu. 

s6/GO! 

The text is placed on 
the Clipboard­
replacing the last thing 
you cut or copied­
and you can paste it 
somewhere else in the 
document or in 
another document. 

• To remove text, 
select it and then 
choose Clear from the 
Edit menu or press the 
Backspace key. 

i nbOT
' Cg",''''WFmm. 

• Select text you 
want to replace and 
type new text or 
paste it from the 
clipboard. 

When you choose 
Clear or use the 
Backspace key, the text 
is not saved on the 
Clipboard. 

• To restore text that 
you have removed, 
choose Undo from the 
Edit menu before you 
do anything else. 
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• Select text you 
want to move and 
choose Cut to place It 
on the Clipboard. 

Select RII 
Ouplied1H. 

I (I(k 

Ilnlot:k 
lI'i'''.1 [0 flonl 
S(Hl(lliehind 

lICR 
:.:[1 
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Specifications ••. 

:-:7 • Select text 
you want to 

lICH remove 
lICC 

and choose lICU 
Clear. 
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To make text 
run around 
another object 

You can make text run 
around any text block, 
picture block, graphic 
object, or group of 
objects. 

1 Create the object 
you want the text to run 
around and move it . 
into position on top of 
the text block. The 
object should remain 
selected. 

If the object is a 
picture block, the text 
automatically runs 
around the block. 

Text does not 
automatically run 
around text blocks, 
graphic objects, or 
groups of objects. 

2 Choose 
Specifications from 
the Edit menu. 

A dialog box displays 
the specifications for 
the selected object. 

If you have selected a 
group of objects, a 

different dialog box 
appears for each 
object. 

3 For the Text Repel 
Distance, type the 
distance you want 
between the object 
and the text. 

If the selected object is 
a picture block, you 
can click GraphiC to 
make the text 

.(og08 . 
:A 1010 U a word OJ a 

;;:'::;:;'O(WO~'<h to : 
·is zodabh, 
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runaround adjust to 
the contours of the 
picture instead of the 
frame of the picture 
block. 

4 Click Runaround if it 
is not selected. 

5 Click OK. 

The text flows around 
the object. If you 
move the object, the 
text adjusts 
automatically. 

1. Create the 
object and 
move It on top 
of the text 
block. 2. Choose 

Specifications. 

3. Type the repel 
distance. 

4. Click Runaround. 

• To prevent text 
runarounds in a text 
block, select the text 
block, choose 
Specifications from 
the Edit menu, and 
click Ignore 
Runarounds. Now text 
in this text block will 
never run around any 
object. 
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Cut X" 
Copy XC 
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Clear 
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You can click Graphic to adjust 
text to the contours of a picture_ 
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5. Click OK. Scale Down: ~~ per~ent 
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WORKI NG WI TH TEXT 

A Chain of Blocks 
To link text 
blocks 

When a single article 
spans several columns 
or pages, it's useful to 
link text blocks into a 
chain. Then the text 
flows from block to 
block and adjusts 
automatically to 
changes you make in 
any of the linked 
blocks. 

You can link blocks 
before or after you 
enter text. 

1 Select the linking 
tool from the tool bar. 

2 Click in the text 
blocks in the order you 
want them linked. 

As you click in the 
blocks, the linking tool 
flashes in the tool bar 
and the linked blocks 
blink. 

You can use the page 
scroll bar to go to a 
new page and continue 
linking. 

1. Select the 
linking tool. 

If the first block has 
overflow text, the text 
immediately flows into 
the linked blocks. If 
the blocks you link 
already have text, the 
overflow text is 
inserted after the 
existing text. 

3 Double-click in the 
last block to end the 
chain. 

2. Click in 
each block In 

the link. , 
; 

3. Double·click 
In the last 

Ready,Set ,Go! 
automatically ends the 
chain if you select 
another tool. 

You can find all the 
linked blocks in a 
chain by selecting 
some text and 
choosing Select All . 
Text in every linked 
block is selected. 

.. ~ 
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block to end 
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To add text 
blocks 
to a chain 

You can add text 
blocks in the middle 
or to the end of a 
chain of linked blocks. 
You can also add text 
b locks before the 
beginning of a chain. 

1 Insert the new text 
blocks where you want 
them to appear. 

You can draw new text 
blocks with the text 
tool, cut or copy text 
blocks and paste them 
into place, or 
duplicate existing text 
blocks on the same or 
faCing page . 

2 Select the linking 
tool from the tool bar. 

3 Click in the text 
block in the existing 
chain that precedes 
the new text blocks you 
want to add. 

4 Click in the new text 
blocks in the order you 
want to link them to 
the existing chain and 

double-click in the last 
block you want to add. 

Use the page scroll bar 
to go to each page with 
a text block you want to 
add. 

The text blocks are 
added to the chain 
after the existing 
linked block you 
clicked. 

• To add text blocks 
to the beginning of a 
chain, click in the first 
text' block in the chain. 
Then hold down the 
Shift key while you 
click, in reverse order, 
in the text blocks you 
want to add to the 
front of the chain. 
Double-click in the 
new first block. 
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• To add a new page 
with linked blocks, 
choose Insert Page(s) 
from the Special menu 
and select Duplicate 
Current Page and 
Global links. Overflow 
text flows automatical­
ly into the blocks on 
the new pages. 

1. Insert 
new text 
blocks. 

.. 2. Select 

... the linking 
tool. 

3. Click In the 
inked block 
before the 
blocks you want 
to add. 

4. Click in the 
new blocks in 
order. 

5. Double·click 
in the last new 
block. 
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To add text 
blocks 
to a chain 

You can add text 
blocks in the middle 
or to the end of a 
chain of linked blocks. 
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b locks before the 
beginning of a chain. 
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double-click in the last 
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Use the page scroll bar 
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add. 

The text blocks are 
added to the chain 
after the existing 
linked block you 
clicked. 

• To add text blocks 
to the beginning of a 
chain, click in the first 
text' block in the chain. 
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Shift key while you 
click, in reverse order, 
in the text blocks you 
want to add to the 
front of the chain. 
Double-click in the 
new first block. 
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WORKI NG WI TH TEXT 

A Chain of Blocks 
To move or copy 
linked blocks 

You can move or copy 
linked blocks from one 
page in the document 
to another. Then you 
must use the linking 
tool to relink them 
after you paste them. 

1 Select the text 
blocks you want to 
move or copy. 

2 Choose Cut or Copy 
from the Edit menu. 

The blocks and their 
text are stored on the 
Clipboard but are no 
longer linked. 

If you choose Cut, the 
blocks are removed 
and the remaining 
blocks in the chain are 
relinked. The original 
text is adjusted to fit 
the new chain. 

3 Go to the page 
where you want to 
copy or move the 
blocks. 
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You can use the page 
scroll bar to go to a 
new page in the 
document, or you can 
open another 
document and go to a 
page in it. 

4 Choose Paste from 
the Edit menu. 

The blocks are pasted, 
with their text, in their 
original position, on 

the new page. If you 
want to link them, see 
"To Add Text Blocks 
to a Chain" in this 
chapter. 
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To remove 
linked blocks 
from a chain 

You can remove 
linked text blocks from 
a chain. You can also 
unlink blocks without 
removing them. 

• To remove a linked 
block, select it and 
choose Cut or Clear 
from the Edit menu. 
Or select it and press 
the Backspace key. 

The text block itself is 
removed, but the text 
it contained is 
readjusted to fit the 
remaining blocks in 
the chain. 

• To unlink a block 
without removing it, 
select the linking tool 
from the tool bar, 
hold down the 
Command key, and 
click in the block you 
want to unlink. 

The text disappears 
from the unlinked 
block and flows into 
the next block in the 
chain. 
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The text is adjusted in 
the remaining blocks in 

the chain when you 
remove or unlink a block. 

• To restore a linked 
block that you have 
removed, choose 
Undo from the Edit 
menu before you do 
anything else. 

L1 
• Choose Cut or 
Clear to remove a 
selected block. 
Or press 
Backspace. 

• Select the 
linking tool, hold 
down the 
Command key, 
and click in a 
block to unlink it. 
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the remaining blocks in 

the chain when you 
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• To restore a linked 
block that you have 
removed, choose 
Undo from the Edit 
menu before you do 
anything else. 
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• Choose Cut or 
Clear to remove a 
selected block. 
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Backspace. 
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linking tool, hold 
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Style and Format 
To change the 
font, style, or 
size of text 

When you type text in 
a text block, it appears 
in the font, style, and 
size currently chosen 
at the insertion point. 
However, you can 
change the font, style, 
and size as you type. 
Or you can change the 
font, style, and size of 
any text selection. 

1 Select an insertion 
point where you want 
to start typing in a new 
font, style, or size. Or 
select the text you want 
to change. 

2 Choose the font you 
want from the Font 
menu . 

3 Choose the style 
you want from the 
Style menu. 

You can· choose one 
style or a combination 
of styles. A check 
appears beside each 
style that you are 

92/GO! 

using. If you choose 
Plain, all the other 
styles are canceled. 

4 Choose the size you 
want from the Style 
menu. 

If you choose Other, a 
dialog box prompts 
you for a size. You can 
specify any size from 
1 to 255 points. Then 
click OK. 

Sizes that appear in 
outline characters in 
the menu-those sizes 
installed in your 
System file-look 
better than other sizes 
when you print them 
on an ImageWriter. If 
you're using a 
LaserWritet, the font is 
scaled when you print 
to look good in any 
size you choose. 

The Macintosh 
automatically creates, 
on screen, sizes of 
fonts not installed in 
your System file by 
scaling one that is. 
Sometimes these 
scaled fonts are almost 
illegible on screen­
especially in very 

small sizes. Choose 
Preferences and select 
Disable Font Scaling 
to make it easier to 
read and work with 
scaled fonts, but be 
sure to deselect 
Disable Font Scaling 
before you print with 
an ImageWriter. See 
the Preferences 

command in 
Chapter 4 for more 
information. 

You can also change 
the font, style, size, 
and other formats with 
the Type Specs 
command. See "To 
Set Up Type 
Specifications" in this 
chapter. 
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a size. 
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1 to 255 
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To align text 

You can align your text 
with the right or left 
side of the text block. 
You can also center 
the text in a block or 
justify it. 

1 Select the text you 
want to align. 

Each line is aligned 
according to the 
alignment you specify 
for its first character. 
However, if you want 
to keep the same 
alignment as you edit, 
it's a good idea to 
select entire lines, 
paragraphs, or 
articles. 

2 Choose the 
alignment you want 
from the Format 
menu. 

A check in the Format 
menu marks the 
alignment at the 
insertion point. 

The text you selected 
realigns. 

You can also align text 
with the Type Specs 
command. See "To 
Set Up Type 
Specifications" in this 
chapter. 

II 1. Select the text. 

..;left 
Right 
Center 

2. Choose the alignment. 

Left aligns 
text at the left 
side of the 
text block 
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Center centers 
the text 
in the tex t 
block. 
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WORK I NG WI TH TEXT 

Style and Forlnat 
To reduce space 
between 
characters 

Sometimes the space 
between certain 
characters is 
noticeably too wide­
especially if the type 
size is large, as in 
titles . In traditional 
typesetting, this space 
is reduced by a meth­
od called "kerning. " 

With Ready,Set,Go! 
you can automatically 
kern certain pairs of 
characters if you use a 
LaserWriter screen 
font that contains a 
special table of pairs , 
such as To or A V 

In addition, you can 
specify the amount of 
space you want to 
remove between each 
pair of characters in 
text you select. 

• To kern automati­
cally, select the ·text 
you want to kern and 
choose Kern from the 
Format menu. 

Ready,Set,Go! kerns 
each pair of characters 

94/GO! 

that is included in a 
table stored with most 
LaserWriter screen 
fonts. If the pair is in 
the table , the 
character on the right 
moves to the left and 
any following lines of 
type adjust to fit. 

Because the 
Macintosh screen 
allows kerning only in 
I-point increments, 
kerning is effective 
only for larger type 
sizes, such as 
headlines. 

• To specify the space 
to be removed 
between two 
characters, select the 
character on the right 
and choose Kern from 
the Format menu. 

A dialog box prompts 
you for the number of 
points you want to 
remove. When you 
click OK, the charac­
ter moves to the left. 

• To remove space 
between each 
character in selected 
text, hold down the 

Option key and 
choose Kern from the 
Format menu. 

A dialog box prompts 
you for the number of 
points you want to 
remove between each 
pair of characters in 
the selection. When 
you click OK, all of the 
characters move to the 
left and any following 
lines of type adjust to 
fit. 

• To remove space 
manually between 

selected characters, 
hold down the 
Command key and 
press the Left Arrow 
key once for each 
point of space you 
want to remove. 

• To restore kerned 
characters to their 
preset spacing, select 
the kerned text, hold 
down the Option key, 
and choose Kern from 
the Format menu. 
When the box 
appears, type 0 and 
click OK. 

.,alL_-WHAl OOPICASSO~ MAX ERN 
~~:~t SAlmDOR DALI HA VE TO DO 

[enter VOUR WHA1DO PiCASSO, MA 
Justify . . ..... SALVADOR DALI HAVE 1 

Word Spocing .. . 
Line Spocing .. . 
Porllgrllph spocing ... 

Porogroph Indent ... 
left Indent .. . 
Right Indent .. . _. __ .. _ .••.•... _---_ ..... _. __ ..... 

Lettersp 
Shift Up .. 
Shift Dou 

.;'118seline 

Kern: 

.VOUR LOGO? 

• To kem automati· 
cally, select characters 
and choose Kern. 

I L 2 __ ---..J1 points 

n OK II [[Oncel] 

• To specify space 
to be removed, select 
characters and choose 
Kern. Type the number 
of points and click OK. 
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To add space 
between 
characters 

You can add space 
between characters to 
achieve special design 
effects. This is called 
"Iette rspacing. " 

1 Select the text you 
want to letterspace. 

2 Choose Letterspace 
from the Format 
menu. 

A dialog box prompts 
you for the positive 
number of points you 
want to add between 
each character. 

If the text has already 
been kerned or 
letters paced different 
amounts, no number 
will appear in the 
dialog box. 

3 Type the number of 
points you want to 
add. 

4 Click OK. 

Each selected 
character moves to the 
right, and the 
following lines adjust 
to fit. 

If you type text after a 
letterspaced 
character, it uses the 
same letterspacing. 
Text that you paste is 
not affected. 

• To restore 
letters paced 
characters to their 

normal spacing, select 
the letterspaced text 
and choose 
Letterspace from the 
Format menu. When 
the box appears, type 
a and click OK. 

• To add space 
manually between 
selected characters, 
hold down the 
Command key and 
press the Right Arrow 
key once for each 
point of space you 
want to add. 

II 1. Select the text. 

2. Choose 
Letterspace. 

3. Type the number of 
points. 

4. Click OK. 

Aeft 
Right 
Center 
Justify 

Word Spacing .. . 
line Spacing .. . 
Pllrllgraph Spacing ... 

Paragraph Indent ... 
Left Indent .. . 
Right Indent .. . 

Kern 

Letterspace: 118 . I points 

It OK)) t conce!) 

• Notes: 

Kerning Then 
and Now 

When all type was set 
in metal blocks, the 
space between letters 
was governed by the 
size of the block on 
which the type was 
cast. Sometimes the 
size of the block 
created awkward 
spacing between 
certain characters. To 
correct this problem, 
typesetters sawed 
notches in the type 
blocks to make them fit 
closer together. The 
part of the letter that 
extended beyond the 
notched edge was 
called a "kern." 

Computers can make 
these adjustments with 
a lot less fuss. 
However, you may still 
want the manual 
control of specifying 
exactly how much 
space to remove 
between characters. 
Ready,Set,Go! gives 
you this control. 
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WORK I NG WI TH TEXT 

Style and Format 
To shift 
characters up or 
down 

You can shift 
characters up or down 
from the baseline­
the imaginary line on 
which the bottom of 
most uppercase letters 
rests. This is useful for 
raised footnote 
references and other 
symbols as well as 
special design effects. 

1 Select the text you 
want to shift. 

2 Choose Shift Up or 
Shift Down from the 
Format menu . 

A dialog box prompts 
you for the number of 
points you want the 
text to shift. If a 
number other than 0 
appears in the box, 
the text has already 
been shifted by the 
number of points 
indicated. 

If no number appears, 
the text has been 
shifted different 
amounts . 

96/GO! 

3 Type the number of 
points you want the 
text to shift. 

4 Click OK. 

The selected 
characters shift up or 
down. If you are using 
automatic line 
spacing, the space 
between lines adjusts if 
necessary. To keep the 
line spacing the same, 

try changing the 
shifted text to a 
smaller font size or 
specify the line 
spacing for that line. 
See "To Change the 
Space Between Lines" 
and "To Add Space 
Between Paragraphs" 
in this chapter. 

II 1. Select the text. 

Vo~ ~~ shifi ch~: ° 

• To use the arrow 
keys to shift selected 
text, hold down the 
Command key and 
press the Up Arrow or 
Down Arrow key once 
for each point of space 
you want the text to 
shift. 

• To shift text back to 
the baseline, select the 
shifted text and 
choose Baseline from 
the Format me nu . 

:acters lor down : 

:from the baseline. : 

..-left 
Right 
Center 
Justify 

2. Choose Shift Up or 
Shift Down. 

Word Spacing .. . 
line Spacing ..• 
Paragraph Spacing ... 

Paragraph Indent. 
left Indent .•. 
Right Indent ..• 

Kern 
letterspace •.. 

Shift Down ... 
..-Baseline 

3. Type the number of 
points. 

Shift Up: IL4_~=o!1 points 

I( OK )) (cance!) 

4. Click OK • 

You can shift char­

°acters up or down ° 

:trom the baseline. 0 

, -----
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See "To Change the 
Space Between Lines" 
and "To Add Space 
Between Paragraphs" 
in this chapter. 

II 1. Select the text. 
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• To use the arrow 
keys to shift selected 
text, hold down the 
Command key and 
press the Up Arrow or 
Down Arrow key once 
for each point of space 
you want the text to 
shift. 

• To shift text back to 
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To change the 
space between 
words 

Ready ,Set , Go! 
automatically sets the 
space between words. 
You can change the 
word spacing to 
increase or reduce 
space between words. 

1 Select an insertion 
point or some text. 

2 Choose Word 
Spacing from the Text 
me nu. 

A dialog box prompts 
you for a percentage of 
normal word spacing. 
Th~ preset word 
spacing is 100 percent. 

3 Type a new 
percentage for the 
word spacing. 

For example , if you 
want twice as much 
space between words, 
type 200. If you want 
half as much space, 
type 50. 

4 Click OK. 

Ready,Set,Go! now 
uses the word spacing 
you chose. 

II 1. Select text or an insertion point. 

, 

You can also change 
word spacing with the 
Type Specs 
command. See "To 
Set Up Type 
Specifications" in this 
cha pter. 
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To change the 
space between 
words 

Ready ,Set , Go! 
automatically sets the 
space between words. 
You can change the 
word spacing to 
increase or reduce 
space between words. 

1 Select an insertion 
point or some text. 
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For example , if you 
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word spacing with the 
Type Specs 
command. See "To 
Set Up Type 
Specifications" in this 
cha pter. 
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WORKI NG WI TH TEXT 

Style and For1nat 
To change the 
space between 
lines 

Ready,Set,Go! 
automatically adjusts 
the space between 
lines to fit the font size 
you are using. 
However, you can 
specify the line 
spacing you want-to 
increase the space 
between text and 
headings, for 
example, or to keep 
the same space 
between lines with 
different type sizes. 
Ready,Set,Go! 
measures the space 
between lines and 
paragraphs from the 
baseline of the line 
above to the baseline 
of the line below. 

1 Select the lines 
whose spacing you 
want to change. Or 
select an insertion 
point. 

98/ GO! 

You can select the first 
character or the entire 
line. For ease of 
editing, however, it's a 
good idea to select the 
entire line. 

2 Choose Line 
Spacing from the 
Format menu. 

A dialog box prompts 
you for the number of 
points between lines. 

3 Type the number of 
points you want 
between lines. 

4 Click OK. 

The space is adjusted 
between each selected 
line and the line above 
it. 

D 1. Select the lines. 

You can also change 
line spacing with the 
Type Specs 
command. See "To 
Set Up Type 
Specifications" in this 
chapter. 

• To return to 
automatic line 
spacing, select the text 
and choose Line 
Spacing from the 
Format menu. When 
the dialog box 
appears, type Auto and 
click OK. 
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space between 
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baseline of the line 
above to the baseline 
of the line below. 
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whose spacing you 
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point. 
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You can select the first 
character or the entire 
line. For ease of 
editing, however, it's a 
good idea to select the 
entire line. 

2 Choose Line 
Spacing from the 
Format menu. 

A dialog box prompts 
you for the number of 
points between lines. 

3 Type the number of 
points you want 
between lines. 

4 Click OK. 

The space is adjusted 
between each selected 
line and the line above 
it. 
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line spacing with the 
Type Specs 
command. See "To 
Set Up Type 
Specifications" in this 
chapter. 
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Spacing from the 
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the dialog box 
appears, type Auto and 
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To add space 
between 
paragraphs 

Ready,Set,Go! 
normally uses the 
same space between 
paragraphs as it uses 
between lines in the 
paragraphs. You can 
add more space 
between paragraphs if 
you want. 

1 Select the text you 
want to change. Or 
select an insertion 
point. 

You can select the first 
character of a 
paragraph, the first 
line, an entire 
paragraph, or several 
paragraphs. For ease 
of editing, however, 
it's a good idea to 
select at least an entire 
paragraph. 

2 Choose Paragraph 
Spacing from the 
Format menu. 

A dialog box prompts 
you for the number of 
points you want to add 
to the current spacing 
above the selected 
paragraph. 

3 Type the number of 
points you want to 
add . 

4 Click OK. 

The space above each 
selected paragraph is 
adjusted. If you 
selected an insertion 
point, Ready,Set,Go! 
uses the new 
paragraph spacing for 
any paragraphs you 
type after the insertion 
point. 

II 1. Select text or an insertion point. 

You can also change 
the paragraph spacing 
with the Type Specs 
command. See "To 
Set Up Type 
Specifications" in this 
chapter. 

• To return to normal 
paragraph spacing, 
select the text or an 
insertion point, 
choose Paragraph 
Spacing from the 
Format menu, type 0, 
and click OK. 

..-left 
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Center 
Justify 

2. Choose Paragraph Spacing. 
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line Spacing .. . .'i.,., I. I 

Paragraph 
Spacing: 
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To add space 
between 
paragraphs 

Ready,Set,Go! 
normally uses the 
same space between 
paragraphs as it uses 
between lines in the 
paragraphs. You can 
add more space 
between paragraphs if 
you want. 

1 Select the text you 
want to change. Or 
select an insertion 
point. 

You can select the first 
character of a 
paragraph, the first 
line, an entire 
paragraph, or several 
paragraphs. For ease 
of editing, however, 
it's a good idea to 
select at least an entire 
paragraph. 

2 Choose Paragraph 
Spacing from the 
Format menu. 

A dialog box prompts 
you for the number of 
points you want to add 
to the current spacing 
above the selected 
paragraph. 

3 Type the number of 
points you want to 
add . 

4 Click OK. 

The space above each 
selected paragraph is 
adjusted. If you 
selected an insertion 
point, Ready,Set,Go! 
uses the new 
paragraph spacing for 
any paragraphs you 
type after the insertion 
point. 

II 1. Select text or an insertion point. 

You can also change 
the paragraph spacing 
with the Type Specs 
command. See "To 
Set Up Type 
Specifications" in this 
chapter. 

• To return to normal 
paragraph spacing, 
select the text or an 
insertion point, 
choose Paragraph 
Spacing from the 
Format menu, type 0, 
and click OK. 
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WORKI NG WI TH TEXT 

Style and Forfflat 
To indent 
paragraphs 

You can indent the 
first line of a 
paragraph or all lines 
except the first line­
called a "hanging 
indent. " You can also 
indent any line from 
the right or a combi­
nation of any of these 
indentation styles. 

1 Select the text you 
want to indent. 

You can select just the 
first character of a 
line, a line, a 
paragraph, or an 
entire text block or 
chain of linked blocks. 
It is usually best to 
select at least an entire 
paragraph, so if you 
add or remove text 
later, your indents will 
not accidentally 
change . 

2 Choose an indent 
command from the 
Format menu. 

Paragraph Indent 
indents the first line of 
each selected 
paragraph. 

lOO/ GO! 

Left Indent indents all 
the lines except the 
first line of each 
selected paragraph. 

Right Indent indents 
all the lines from the 
right side of the text 
block . 

When you choose one 
. of these commands, a 
dialog box prompts 
you for the amount of 
indentation you want. 

3 Type the number of 
inches, centimeters, 
or picas and points 
you want the selected 
lines to indent. 

4 Click OK. 

The selected lines are 
indented. 

II 1. Select the text you want to indent. 

, , 

You can also set up 
indentations with the 
Type Specs com­
mand. See "To Set Up 
Type Specifications" 
in this chapter. 

• To remove an 
indentation, select the 
indented lines and 
choose the appro­
priate indent com­
mand from the Format 
menu. When the 
dialog box appears , 
type 0 and click OK. 
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To set up type 
specifications 

You can set all the type 
specifications at once, 
including font, style, 
size, alignment, tabs, 
indentation, word 
spacing, line spacing, 
paragraph spacing, 
and hyphenation. 

1 Select an insertion 
point in a text block. 
Or select text. 

When you select an 
insertion point, 
Ready,Set,Go! uses 
the type specifications 
you set for any text that 
you type after the 
insertion point. 

2 Choose Type Specs 
from the Text menu. 

A window displays the 
type and format 
options of the selected 
text or insertion point. 

3 Select the options 
you want. 

You can click to select 
the options for font, 
style, size, alignment, 
and hyphenation 
specifications. Type 
the indents you want 
and the word, line, 
and paragraph 
spacing. Click Set Tabs 
to display the Tabs 
window. See "To Set 
Tab Stops" in this 
chapter for details 
about using this 
window. Select the 
Tabs option to use the 
tab stops you set. 

You can also choose 
to select no option for 
one or more of the 
type or formatting 
specifications. Then 
selected text will keep 
its current 
specifications for 
those formats. 

4 Click Apply to view 
your specifications 
without closing the 
window. Or click OK. 

Ready,Set,Go! uses 
these type specs for 
the selected text or for 
any text you type after 
the insertion point. 

You can change any of 
the specifications by 
chOOSing the Type 
Specs command again 
and chOOSing new 
options. You can also 
change individual 
style and format 
options as described 
earlier in this chapter. 
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You can create 
stylesheets for several 
different sets of type 
specifications and 
apply them 
throughout your 
document. See "To 
Create a Stylesheet" in 
this chapter. 
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insertion point or 
select text. 

2. Choose Type 
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the Text menu. 
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click OK. 

I 
U 

IZI Plain 

DBoid 
11 . D Italic 

Other: 
D Underline 

lit I D Outline Spacing: 
D Shadow 

Word 1100 I Hyph: D Condense 
IZI On D [Htend line IAuto Ipoin 

DOff D Ouerstrike Para 10 Ipoin 

STYLE AND FORMAT/ 101 

To set up type 
specifications 

You can set all the type 
specifications at once, 
including font, style, 
size, alignment, tabs, 
indentation, word 
spacing, line spacing, 
paragraph spacing, 
and hyphenation. 

1 Select an insertion 
point in a text block. 
Or select text. 

When you select an 
insertion point, 
Ready,Set,Go! uses 
the type specifications 
you set for any text that 
you type after the 
insertion point. 

2 Choose Type Specs 
from the Text menu. 

A window displays the 
type and format 
options of the selected 
text or insertion point. 

3 Select the options 
you want. 

You can click to select 
the options for font, 
style, size, alignment, 
and hyphenation 
specifications. Type 
the indents you want 
and the word, line, 
and paragraph 
spacing. Click Set Tabs 
to display the Tabs 
window. See "To Set 
Tab Stops" in this 
chapter for details 
about using this 
window. Select the 
Tabs option to use the 
tab stops you set. 

You can also choose 
to select no option for 
one or more of the 
type or formatting 
specifications. Then 
selected text will keep 
its current 
specifications for 
those formats. 

4 Click Apply to view 
your specifications 
without closing the 
window. Or click OK. 

Ready,Set,Go! uses 
these type specs for 
the selected text or for 
any text you type after 
the insertion point. 

You can change any of 
the specifications by 
chOOSing the Type 
Specs command again 
and chOOSing new 
options. You can also 
change individual 
style and format 
options as described 
earlier in this chapter. 

II 

:l&F 

:1& A 

yphenation On 
Hyphenation Off 
Hyphenation Specs .. . 

Tabs ... :l&T 
T pe Specs... :l&Y 
Styles ... 
Remoue 

Chicago . 
Heluetica 
Monaco 
Times 

:l&H 

You can create 
stylesheets for several 
different sets of type 
specifications and 
apply them 
throughout your 
document. See "To 
Create a Stylesheet" in 
this chapter. 

1. Select the 
insertion point or 
select text. 

2. Choose Type 
Specs from 
the Text menu. 

3. Select options. 

4. Click Apply or 
click OK. 
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WORKI NG WI TH TEXT 

Style and Format 
To set tab stops 

You can set up to 10 
tab stops for any text 
you select. You can 
define a text measure: 
the length of the text 
line after a tab. You 
can also choose right, 
left, centered, 
justified, or decimal 
alignment of text 
within that measure. ( 
You can also use a 
character as a leader 
to a tab stop. 

If no tab stops are set, 
an 8-point space is 
inserted automatically 
at the insertion point 
when you press Tab. 

1 Select the text or 
insertion point where 
you want to set tabs. 

Tab stops apply to any 
text you type after the 
insertion point. 

2 Choose Tabs from 
the Text menu. 
A window displays a 
ruler for setting the tab 
stops. The ruler 
measures from the left 
edge of the current text 

l02/ GO! 

block in the units you 
choose with the 
Preferences 
command. You can 
scroll to show more of 
the ruler. 

3 Click in the ruler 
where you want to set a 
tab stop. 

Two arrows appear. 
The large arrow marks 
the tab stop. The small 
arrow marks the end of 
the text measure. If the 
measure is 0, the end 
of the measure is the 
end of the text block. 

The precise tab 
position and width of 
the measure are shown 
above the ruler. 

An icon to the left of 
the arrows indicates 
the alignment. 

4 Click OK. 

The tabs are set. Press 
the Tab key to indent 
the text. You can also 
set tabs with the Type 
Specs command. See 
"To Set Up Type 
Specifications" in this 
chapter. 
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• To set the text 
measure after a tab, 
select an insertion 
point, choose Tabs, 
and set the tab stop. 
Then drag the smaller 
arrow to the right to set 
the text measure and 
click OK. 

• To change the 
alignmentr.at a tab, 
select the text, choose 
Tabs, and click the 
alignment icon. The 
icon changes each 
time you click to 
indicate left , right, 
centered, justified, or 
decimal alignment. If 
you select decimal 
alignment , the 
characters you type at 
the tab stop align to 
the right until you type 
a decimal point and 
then align on the 
decimal point. Then 
click OK. 

• To specify a leader 
character to a tab 
stop, select the text, 
choos,e Tabs, click the 
tab stop, click Specs, 
type the character for 
the leader character, 
click OK, and click OK 
again. The character 

fills the space between 
the text and the tab 
stop. 

• To specify tab stops 
precisely, select the 
text, choose tabs, click 
the tab stop to select 
it, and click Specs. 
When the dialog box 
appears, type the 
position of the tab 
stop, the width of the 
measure, and the 

leader character, click 
OK, and then click OK 
again . 

• To change a tab 
stop, select the text, 
choose Tabs, click the 
tab stop you want to 
change, and drag the 
appropriate arrow to 
the new position. 
Then click OK. 

:0 Tabs 

• To remove a tab 
stop, select the text, 
choose Tabs, click the 
tab stop you want to 
remove, and drag it 
below the ruler. Then 
click OK. 

• To remove all tab 
stops, select the text, 
choose Tabs, click 
Clear All, and click 
OK. 

To specify tab 
[Clear nil) Iindent: 1200 Decimal : JGJ • ~ Measure: 3 00 leader: 

stops precisely, Specs ... 

click Specs. 
Measurements in picas.pts. 

6 1 
<, f" 

., 
Tab Specifications 

Indent: 112.00 I leader: I· I 
Measure: 1:'1·00 I 
Measurements in 

GJ©i~ picas.pts . 

Left 
alignment 

• To specify a leader 
character, type the 
character in the Specs 
dialog box. 

Right 
alignment Centered 

~~ 

'it '~ '~ 211 

• To set the 
alignment, 
click the 
alignment 
icon. 

justified 

[cancel) 

24 27 30 
I¢ 

• To set 
the text 
measure, 
drag the 
small arrow 
to the right. 

Decimal 
alignment 
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• To set the text 
measure after a tab, 
select an insertion 
point, choose Tabs, 
and set the tab stop. 
Then drag the smaller 
arrow to the right to set 
the text measure and 
click OK. 

• To change the 
alignmentr.at a tab, 
select the text, choose 
Tabs, and click the 
alignment icon. The 
icon changes each 
time you click to 
indicate left , right, 
centered, justified, or 
decimal alignment. If 
you select decimal 
alignment , the 
characters you type at 
the tab stop align to 
the right until you type 
a decimal point and 
then align on the 
decimal point. Then 
click OK. 

• To specify a leader 
character to a tab 
stop, select the text, 
choos,e Tabs, click the 
tab stop, click Specs, 
type the character for 
the leader character, 
click OK, and click OK 
again. The character 

fills the space between 
the text and the tab 
stop. 

• To specify tab stops 
precisely, select the 
text, choose tabs, click 
the tab stop to select 
it, and click Specs. 
When the dialog box 
appears, type the 
position of the tab 
stop, the width of the 
measure, and the 

leader character, click 
OK, and then click OK 
again . 

• To change a tab 
stop, select the text, 
choose Tabs, click the 
tab stop you want to 
change, and drag the 
appropriate arrow to 
the new position. 
Then click OK. 
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• To remove a tab 
stop, select the text, 
choose Tabs, click the 
tab stop you want to 
remove, and drag it 
below the ruler. Then 
click OK. 

• To remove all tab 
stops, select the text, 
choose Tabs, click 
Clear All, and click 
OK. 

To specify tab 
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alignment 

• To specify a leader 
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Right 
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• To set the 
alignment, 
click the 
alignment 
icon. 
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[cancel) 
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• To set 
the text 
measure, 
drag the 
small arrow 
to the right. 

Decimal 
alignment 
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WORKI NG WI TH TEXT 

Tiffle-Savers 
To find text 

You can search for 
characters in a text 
block or chain. You 
can also search for text 
in any font, style, size, 
or combination of 
these. 

1 Select an insertion 
point where you want 
to begin the search. 
Or select the text you 
want to find. 
~ 

You can search for up 
to 255 characters. The 
search begins after the 
current insertion point 
or selected text and 
ends at the end of the 
block or chain, which­
ever you choose. 

l04/GO! 

2 Choose Find from 
the Text menu. 

A window prompts you 
for the text you want to 
find and the search 
options you want to 
use. 

If you select text before 
you choose Find, the 
selected text appears 
in the Find box. 

3 Type the text you 
want to find . 

If you want to match 
uppercase and 
lowercase characters, 
type the characters 
exactly and click Case­
sensitive. 

If you selected text, 
you can edit it in the 
box. 

4 Click Block or 
Chain. 

Ready,Set,Go! 
searches the part of 
the document you 
choose. 

5 Click OK. 

The Find window 
closes, and the next 
occurrence of the 
search text is 
highlighted in the 
document. You can 
type to change it if you 
want. 

• To search for a font, 
style, or size, hold 
down the Option key 

when you choose 
Find. A new window 
lists the font , style , 
and size options. 
Choose the options 
you want. When you 
click OK, 
Ready,Set,Go! finds 
the text in the font, 
style, size, or 
combination of these 
you specified. Leave 
the Find box blank to 
find the next 
occurrence of a font, 
style, or size of type, 
regardless of the text. 

• To qUickly find the 
next occurrence of 
text, choose Find 
Next. Ready,Set,Gol 
finds the selected text 
or type using the last 
search options you 
selected. 
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Tiffle-Savers 
To find text 

You can search for 
characters in a text 
block or chain. You 
can also search for text 
in any font, style, size, 
or combination of 
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1 Select an insertion 
point where you want 
to begin the search. 
Or select the text you 
want to find. 
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You can search for up 
to 255 characters. The 
search begins after the 
current insertion point 
or selected text and 
ends at the end of the 
block or chain, which­
ever you choose. 
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2 Choose Find from 
the Text menu. 

A window prompts you 
for the text you want to 
find and the search 
options you want to 
use. 

If you select text before 
you choose Find, the 
selected text appears 
in the Find box. 

3 Type the text you 
want to find . 

If you want to match 
uppercase and 
lowercase characters, 
type the characters 
exactly and click Case­
sensitive. 

If you selected text, 
you can edit it in the 
box. 

4 Click Block or 
Chain. 

Ready,Set,Go! 
searches the part of 
the document you 
choose. 

5 Click OK. 

The Find window 
closes, and the next 
occurrence of the 
search text is 
highlighted in the 
document. You can 
type to change it if you 
want. 

• To search for a font, 
style, or size, hold 
down the Option key 

when you choose 
Find. A new window 
lists the font , style , 
and size options. 
Choose the options 
you want. When you 
click OK, 
Ready,Set,Go! finds 
the text in the font, 
style, size, or 
combination of these 
you specified. Leave 
the Find box blank to 
find the next 
occurrence of a font, 
style, or size of type, 
regardless of the text. 

• To qUickly find the 
next occurrence of 
text, choose Find 
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finds the selected text 
or type using the last 
search options you 
selected. 
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II 1. Select an insertion point 
or the text you want to find. 

2. Choose Find. 
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Hold down the Option 
key when you choose 
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you want to find. 
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WORK I NG WI TH TEXT 

Time-Savers 
To replace text 

You can search for text 
and automatically 
replace it with other 
text. You can replace 
the next occurrence of 
the text. Or you can 
replace it everywhere 
it occurs in a block, a 
chain, or the entire 
document. You can 
also search for and 
change a font, style, 
or size of type 
regardless of text, or 
search for and change 
the font, style, or size 
of specific text. 

1 Select an insertion 
point where you want 
to begin the search. 
Or select the text you 
want to find. 

When replacing text 
throughout a 
document , you can 
begin the search 
anywhere in the 
document. To replace 
all occurrences in a 
block or chain, you 
must select an 
insertion point at the 
beginning of the text 
in the block or chain. 

l06/ GO! 

2 Choose Replace If you want to match search. Click Once -0 

from the Text menu. uppercase and replace the next 
lowercase characters , occurrence of the ex:: 

A window prompts you type the characters or All to replace 
for the text you want to exactly and click Case- occurrences in the 
find, the text you want sensitive . block, chain , o r 
to change it to, and document . 
the search options you 4 Type the new text 
want. and click the search 5 Click OK. 

options you want. 
3 Type the text you The new text repla 
want to find. Click Block, Chain, or the old text acco 

Document to select to your instructio 
the part of the 
document you want to 

/ 

II 1. Select an Insertion point or 
text you want to replace. 
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want to replace. 

4. Type the new text 
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'yow C'oaJuy-or OllA of 
:itsJro4:W:IS-Sltll!:4ow..u.. ' 
"'YPt . . 
. Not jv.st ally IYJt, o( 
·coW'St . b.(ltt,t~tYJIt(ltt : 

:if whaJ: t~ .. JriAlt' wort . 
"w:o .. logo . The typ,CItI . 
~vtS 1M lollO t. vinal (OMII. . 

"loS ~ll tS .. vu)aJ auu,Q't . : 
: ....... ·s this 'ris:'IIAl(orm. 
"11&1 ,tOplt rtcopUt as 
:yovr1Wiv.t lop, wh.tl"f\l'tr 
:illnun . 

-So bow tM'(iitfi,se 
:the riOM . . . . 
"To )t,u, rtllLtm)tr thal 
:typtC..:u tlllmulvu eoJII.- . 
"lIlwUcllLt SODlt h s it a u- . 
:Slft . AJ!y014 81ylt 
'tYPtC"", lilu GouiV. with 
:its CWYt4 miff u4 V'trtiul 
·stroku,ttllstMW'Orlttha.t 
:tu cOIl,uyorproa:w:t 
')t:biM t1l.t logo is ... clAs sic, 

:w.:ll-rootd. u. history. A 
· .. on .04.,.11, u.»J: unt btl, : 
:swhuHtlwtitl., aiihl. 

3€F 

Aeploce NeHt 3€A 

v'Hyphenotion On 
Hyphenotion Off 
Hyphenotion Spec •... 

Tabs ... 3€T 
3€Y 
3€H 

2. Choose Replace. 

3. Type the text you 
want to replace. 

4. Type the new text 
and click the Search 
options. 

Type Specs ... 
Styles ... 
Aemoue Styles 

Glo .. orie •.. ~§o~~~~~~~~~A~ep~l~oc~e~_ ~~~~~~~~ 
Check Spell Find: I type roce 
Sugge.t Sp , 
Add Word Change To: LI t_yp_e_r_o_ce ___________ ~ 

( once 
o Block @ Choin 

o Document 

o Co.e-.en5ltiue 

@ Once 0 All ([ OK ) 

5. Click OK. 



• To replace the font, 
sty le, or size of text, 
hold down the Option 
key when you choose 
Replace. A new 
window lists the font, 
style, and size options 
for both the old text 
and the new text. Type 
the old and new text, 
choose the options 

you want for each, and 
click OK. 
Ready,Set,Go! finds 
the text you specify 
and replaces it with the 
new text in the font, 

Hold down the Option 
key when you 

style, size, or 
combination of these 
you specified. Leave 
the Find and Change 
To boxes blank to find 
and replace every 
occurrence of the 
font, style, or size of 
type you specify, 
regardless of text. 

choose Repjgc~to specify 
the font, sfyle, and 
size of the old and new 
text. 

Replace 

Find: Ilype face I 

121 Plain 0 Bold 0 ItHlic 0 Underline 0 Outline ~ 

o Shadow 0 Condense 0 [Hlend 0 Ouerslrike ~ 

IHeluelico 
Monaco 

D 0 Case-sensitiue 

Change T~:LI l_yp_e_f_oc_e ___________ """1 

121 Plain 0 Bold 0 Ilalic 0 Underline 0 Oulline ~ 
o Shadow 0 Condense 0 [Hlend 0 Ouerslrike ~ 

Monaco D @ Chain II ~ I Heluelica IQI 0 BI~Ck~ Once tI""'(jj("II 

mmlil •••• QlODocu .• nl (Cancel] 

/ \ 
Replaces the next Replaces all 

occurrences of the 
text in the block, 
chain, or document 

occurrence 
of the text 

• To quickly replace 
the next occurrence 
of text, choose 
Replace Next. 
Ready,Set,Go! uses 
the most recent 
specifications for 
replacing text or type. 
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replacing text or type. 
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WORKI NG WI TH TEXT 

Tiffle-Savers 
To create 
a stylesheet 

You can create one or 
more stylesheets for a 
docume nt. A 
stylesheet defines a set 
of type specifications. 
Once you create a 
stylesheet, you can use 
it to format text quickly 
and consistently. If 
you change a 
stylesheet, 
Ready ,Set,Go! 
automatically changes 
all of the text you 
formatted with that 
stylesheet. You can 
quickly reformat your 
entire document in 
this way. 

1 Select an insertion 
point. Or select text to 
use its specifications in 
the stylesheet. 

l08/ GO! 

2 Choose Styles from 
the Text menu. 

A window displays a 
list of existing 
stylesheets, if any. 

3 Click New. 

A new window displays 
the options for type 
specifications . 

4 Type a name for the 
stylesheet. 

Ready,Set,Go! 
automatically names 
the stylesheet New 
Style. You can give it 
any name you want. 

5 Select the options 
you want. 

You can click to select 
the font , style, size, 
alignment , and 
hyphenation options. 
Type the indents you 
want and the word, 
line, and paragraph 
spacing. Click Set Tabs 
to display the Tabs 
window. See "To Set 
Tab Stops" in this 
chapter for details 
about using this 
window. 

You can also choose 
to select no option for 
one or more of the 
type or formatting 
specifications. Then 
text you format with 
the stylesheet will 
retain its current 
specifications for 
those formats. See "To 
Use a Stylesheet" in 
this chapter for more 
information. 

6 Click OK. 

The new stylesheet 
appears selected in the 
list of stylesheets. 

7 Click Done. 

The style sheet is 
stored with the current 
document, and you 
can use it to format 
selected text. See "To 
Use a Stylesheet" in 
this cha pter. 

• To assign a 
keyboard command 
to a stylesheet, set up 
the stylesheet as usual, 
but add a slash (/) 
and any single 
character at the end of 
the name. See "To Use 
a Stylesheet" in this 
chapter for details 
about using keyboard 
commands for 
stylesheets. 
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II 1. Select an insertion 
point or select text. 

A logo, Ul.lts Sl.lD.plt~t 
fOrm.,1SjU5tthtumtOf 
vour compUly --or Oll.t lof 
us prod.urls-sptlld 0\1.1 l.D. 

Iyp. 
Not )usta.nY'V'P',of 

CO\ll":;t In [nt, 1M tvptface 
15 wlW twns • plwad. word. 
lIl.tO • logo T~ qrptfut 
lSlvt~ !hot logo .. VLual form. 
as wtllas I vub..tm.tsslgt' 
u41t"s tlw: VlSualform. 

tbl ptOplt f'tcogJU1t lS 
your lIJIlqU! 101l'O, whtl't",r 
1I.I.pptUS 

So how d.o you choost thot 
~httyptfact? 

To btp, rtm.tlll..hr thai 
typtfatts thunstlvts com­
&\lllltt!tsomt basU'mu 
sag! AnV014 Sl ylt 
typtfnt like Goudy, wuh 
its c1.I.rVld 5tnf~ u..d Vtrticll 
stroku, tells tlot wurld lht 
llot compuy or pro4uct 
lltluJod thf logo 1$ .. CWHC, 

wtll-roottdmlw:lory A 
mort modtl'll.5iUl.S senfrnt, 

such as HtlvttlCl., tDliht 

Find ... 
Find NeHt J€F 
Repla(e ... 
Replace NeHt a€R 

"'HyphenatIOn On 
Hyphenation Off 
HyphenatIOn Specs .. 

Tabs ... 
Type ·Specs ... 

Remolle Styles 
Glossaries ... 

Check Spelling 
Suggest Spellong ... 
Rdd tuord 

2. Choose Styles. 

C New ... ] 

("1odiltj. ) 

flppl~J ) 

( Import...) 

r IIUplH 0(0' J 

~., 

3. Click New. 

Style SpecIfications 

I St41e name: rzJ left 0 Right 

L ________ -' ~ll=e=lI=e=I=I=H=e=a=d====~1 0 Center 0 Justify 

4. Type the name of 
the stylesheet. 

~ ~:~c:;: R ( Set TabS ... ) 

~J ~ :~~~ '"":::: I",,, 1'""" 
5. Select options. II 0 Italic left ~OO ]lnrhes 

ellel I Head 

7. Click Done. 

6. Click OK. 
Other: o Underline Right l.O._OOOO J inches 

~ 0 Outline Spacing: 

C--.-J 0 Shadoll' tuord 
Hyph: 

DOn 

----===0-==='==, [3J Off Styles - ~-~~ 

( New ... ) 

~ ... ) 
CiiWlY-j 
( 'InPori .. .] 

~~ 
( Oelete 

Coone) 

o rondense Line 
o fRtend 
o Ollerstnke Para 

" 

[lM - J percent 

112 Ipoints 

rrr-~ points 
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WORKI NG WI TH TEXT 

Tiffle-Savers 
To use a 3 Select the stylesheet • To change the style Create a Stylesheet" in 
stylesheet you want to use. or format of text this chapter to assign a 

formatted with a keyboard command to 
If you have created You can use the scroll stylesheet, select the a stylesheet. 
stylesheets for your bar to bring more of text you want to 
document, you can the list into view. change and choose • To impona 
use them as you enter Remove Styles from stylesheet from 
text. Or you can 4 Click Apply and the Text menu. You another document, 
format the text that then click Done. - can now use menu choose Styles from the 
you have already commands or another Text menu and click 
entered with a The text you selected stylesheet to change Import. A dialog box 
stylesheet. or the text you type the style and format of lists the other 

after the insertion the selected text. The Ready,Set ,Go! 
1 Select the text that point is for11latted with stylesheet remains documents on your 
you want to format or the type specifications unchanged. disk. Double-click a 
select an insertion defined in the document to import 
point. stylesheet. You cannot • To use a keyboard its stylesheets. When 

change any formats command for a they appear in the list 
2 Choose Styles from you specified with the stylesheet, select the for the current 
the Text menu. stylesheet with menu text, hold down the document, click Done. 

commands. Command key, type 
A window lists the H, and then type the 
style sheets for the character assigned to 
current document. the stylesheet. See "To 

1101<;70! 
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:A ]oil', ia its siD.pll,st 
fora, is just tlle ~. or 
:voW' eom.pUL,-or OM or 
' its pro4\1Cts-sp.U.4 ollt b. : 
:typ. , 
, Not jv.st uy In', o[ : 

:eoWSt , Inract,tMly:ptrt.C"I ' 
'is ,..:bat: 1\nS a prWM. "'Wni : 
:mto a logo . TM typtfacl 
'giVtS tM logo a vis..w rom: 
:as Will as a -nr),J. muSt", ' 
'aM. it 's this visVll form. ' 
:t:bat: ltOplt rKoplH as 
'yow uit". ~, WMnvtr : 
:itap:ptan:. 

:80 how 40 YO'" ehoosl tht 
'rigM typlrllCt? 
:To )1gU., I'tll.tll.)tr tlal 
'tVllrt.Cts t1tm.nlvu eom.- : 
:lI. _at, som., :bade mts­
's*8" , Ally OJa Sty. 
:ty:p,ract likt Gov.4y, wd. 
'its eWvt4 striCs u4 ftrtieal : 
:strtlku, t,Us the "'WrJalhll: ' 
'Ut eom.pny or :pro4v.ct . 
:M:w.t tlle loeo is a ewsic:, . 
'wtn-roold ia history. A . 
:m.on m.04mt sus s.nc [Ut, ' 

:sv.cll. as HUvttiea, m.irk . 

II 1. Select text or an insertion point. 

Find Newt 
Replace ... 
Replace Newt 

XF 

XR 

.,/Hyphenation On 
Hyphenation Off 
Hyphenotion Specs ... 

lobs... Xl 
Type Specs... XY 

Remoue Styles 
Glossories.. . XG 

Check Spelling 
Suggest Spelling ... 

2. Choose Styles. 

3. Select a stylesheet. 

- Styles 

Add Word Caption New ... 
euel 1 Head 

Leuel 2 Head [ Modify ... ) 

[ APPlY) 

[ Import... ) 

[DUPlicate) 

Delete) :.-tit: i.()i;"Il; O~" 
"lOGOS 

'ti=D"'o='n='e':"'''IIf 

L-===========~~~.::::::-:-~: 'A 108'0, ia its sm,lest :(01"111., is jwsl 1M .... or 

4. Click Apply and 
then click Done. 

'yow ~Oll.,a:ay-or OM of 
::its pro4v.ets-slt.U.t ollt D. ' 
"tJPt , ' 
: Not j'4St oJ Iytt, or 
·cows • . b. [loCt, 1M typtratt : 
is wMt t\lnS a prDI:,4 wont . 
-mto a lojo, TM In,fut ' 
:giws 1M loiO a visul [01"111. ' 

'as: wtll as: a vtrllal JIlUS~,: 
:u4 it's tns visul fonD. 
"tllat ptO). ncopizt as 
:yow uit-loeo, w.n"ftr ' 
:ir.app,ars , ' 

'So low 10 JO'" clloost 1M 
:rii"M t",rlft? 
·Tollt~, I't"'lI.)trlllll: 

:tYJt(IoCU tMJIlsdws eoa.­
'm. uic:". SO .. , )asit .. t$­
S"", . M.y0148tylt 
'1Y:tt(ut Jikt Go"'y, rill. 
:.s nrn4 miCs ..... vtrtical . 
"stroku, ttUs tlle wor14 tUi: : 
:tM co.puy or )f04wt 
'),lm4tb.t loil) is adassic, : 
: ... ll-root,4 i.JI.lWtory. A 
'mQA a ohr1l SallS suit (M" ,: 
:S"\l,l;"lI. as HtlVttica, :ad,k 

.""., .. , .. 

TIME-SA VERS/ lll 

:A ]oil', ia its siD.pll,st 
fora, is just tlle ~. or 
:voW' eom.pUL,-or OM or 
' its pro4\1Cts-sp.U.4 ollt b. : 
:typ. , 
, Not jv.st uy In', o[ : 

:eoWSt , Inract,tMly:ptrt.C"I ' 
'is ,..:bat: 1\nS a prWM. "'Wni : 
:mto a logo . TM typtfacl 
'giVtS tM logo a vis..w rom: 
:as Will as a -nr),J. muSt", ' 
'aM. it 's this visVll form. ' 
:t:bat: ltOplt rKoplH as 
'yow uit". ~, WMnvtr : 
:itap:ptan:. 

:80 how 40 YO'" ehoosl tht 
'rigM typlrllCt? 
:To )1gU., I'tll.tll.)tr tlal 
'tVllrt.Cts t1tm.nlvu eom.- : 
:lI. _at, som., :bade mts­
's*8" , Ally OJa Sty. 
:ty:p,ract likt Gov.4y, wd. 
'its eWvt4 striCs u4 ftrtieal : 
:strtlku, t,Us the "'WrJalhll: ' 
'Ut eom.pny or :pro4v.ct . 
:M:w.t tlle loeo is a ewsic:, . 
'wtn-roold ia history. A . 
:m.on m.04mt sus s.nc [Ut, ' 

:sv.cll. as HUvttiea, m.irk . 

II 1. Select text or an insertion point. 

Find Newt 
Replace ... 
Replace Newt 

XF 

XR 

.,/Hyphenation On 
Hyphenation Off 
Hyphenotion Specs ... 

lobs... Xl 
Type Specs... XY 

Remoue Styles 
Glossories.. . XG 

Check Spelling 
Suggest Spelling ... 

2. Choose Styles. 

3. Select a stylesheet. 

- Styles 

Add Word Caption New ... 
euel 1 Head 

Leuel 2 Head [ Modify ... ) 

[ APPlY) 

[ Import... ) 

[DUPlicate) 

Delete) :.-tit: i.()i;"Il; O~" 
"lOGOS 

'ti=D"'o='n='e':"'''IIf 

L-===========~~~.::::::-:-~: 'A 108'0, ia its sm,lest :(01"111., is jwsl 1M .... or 

4. Click Apply and 
then click Done. 

'yow ~Oll.,a:ay-or OM of 
::its pro4v.ets-slt.U.t ollt D. ' 
"tJPt , ' 
: Not j'4St oJ Iytt, or 
·cows • . b. [loCt, 1M typtratt : 
is wMt t\lnS a prDI:,4 wont . 
-mto a lojo, TM In,fut ' 
:giws 1M loiO a visul [01"111. ' 

'as: wtll as: a vtrllal JIlUS~,: 
:u4 it's tns visul fonD. 
"tllat ptO). ncopizt as 
:yow uit-loeo, w.n"ftr ' 
:ir.app,ars , ' 

'So low 10 JO'" clloost 1M 
:rii"M t",rlft? 
·Tollt~, I't"'lI.)trlllll: 

:tYJt(IoCU tMJIlsdws eoa.­
'm. uic:". SO .. , )asit .. t$­
S"", . M.y0148tylt 
'1Y:tt(ut Jikt Go"'y, rill. 
:.s nrn4 miCs ..... vtrtical . 
"stroku, ttUs tlle wor14 tUi: : 
:tM co.puy or )f04wt 
'),lm4tb.t loil) is adassic, : 
: ... ll-root,4 i.JI.lWtory. A 
'mQA a ohr1l SallS suit (M" ,: 
:S"\l,l;"lI. as HtlVttica, :ad,k 

.""., .. , .. 

TIME-SA VERS/ lll 



WORKI NG WI TH TEXT 

Time-Savers 
To modify a A window lists the you formatted with use, and click 
stylesheet stylesheets. that stylesheet will also Duplicate. The 

be changed duplicate has the same 
You can change the 2 Select the stylesheet automatically. name as the original, 
name or specifications you want to change. but .1 is added to the 
of a stylesheet, and all If you select text end of the name and 
the text you formatted 3 Click Modify. formatted with a any keyboard 
with the stylesheet will stylesheet and choose command character is 
be automatically A window displays the Remove Styles, its removed. You can 
changed throughout specifications Tarrhe formats will not now modify the 
your document. You selected stylesheet. change if you modify duplicate and give it a 
can replace the the stylesheet you new name. 
original or keep both 4 Change the name or formatted it with. 
the old version and specifications as • To delete a 
the new. You can also appropriate and click 5 Click Done. stylesheet, choose 
delete a stylesheet OK. Styles from the Text 
from a document. . • To create a new menu , select the 

If you changed the version of a styleshe(!t stylesheet you want to 
1 Choose Styles from name, the new name and save the old, delete, and click 
the Text menu. appears in the list of choose Styles from the Delete. A dialog box 

stylesheets. Text menu, select the asks you to confirm 
/ stylesheet you want to that you want to delete 

If you changed the the stylesheet. Click 
specifications, all text OK to delete the 
in the document that stylesheet. Then click 

Done. 
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2. Select the 
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4. Change the name 
or options or both and 
then click OK. 

5. Click Done. 
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WORKI NG WI TH TEXT 

Time-Savers 
To create a 
glossary 

A glossary is formatted 
text that you use over 
and over again. It may 
be a copyright notice, 
author biographies, or 
your corporate 
address, for example. 

You can create a set of 
glossaries for your 
document or import 
glossaries from 
another document. 
See "To Use a 
Glossary" in this 
chapter for details 
about importing 
glossaries. 

1 Type and format the 
text you want to save as 
a glossary and select 
it. Or select existing 
text. 

114/ GO! 

2 Choose Glossaries 
from the Text menu. 

A window lists the 
glossaries for the 
current document. 

3 Click Define. 

A dialog box prompts 
you for the name of 
the new glossary. 

4 Type the name of 
the glossary and click 
OK . 

The new glossary 
appears selected in the 
list. 

5 Click Done. 

You can now use the 
glossary anywhere in 
your document. 

• To assign a 
keyboard command 
to a glossary, define 
the glossary as 
described, but add a 
slash ( / ) and any 
Single character at the 
end of the name. See 
"To Use a Glossary" in 
this chapter for details 
about using keyboard 
commands to insert 
glossaries. 

• To rename a 
glossary, choose 
Glossaries from the 
Text menu, select the 
glossary you want to 

rename, and click 
Rename. Type the new 
name in the dialog 
box and click OK. 
Then click Paste to use 
it or click Done. 

• To delete a glossary, 
choose Glossaries 
from the Text menu, 
select the glossary you 
want to delete, and 
click Delete. A dialog 
box asks you to 
confirm that you want 
to delete the glossary. 
Click OK to delete it. 
Then click Done. 
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3. Click Define. 

Glossory Nome: I Publisher's Note 

4. Type the 
glossary name 
and click OK. 

5. Click Done. 

Short time/t 
long time/T 
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WORKI NG WI TH TEXT 

Tiffle-Savers 
To use a 
glossary 

You can insert a 
glossary in any text 
block in your 
document. 

1 Select an insertion 
point where you want 
to insert the glossary. 

·2 Choose Glossaries 
from the Text menu. 

A window displays the 
names of glossaries in 
the current document. 

3 Select the glossary 
yo,u want and click 
Paste. 

4 Click Done. 

The text is inserted at 
the curre nt insertion 
point in the font , 
style, size, and format 
that you used ta create 
it. Yau can change the 
style and format with 
menu commands ar 
stylesheets . 

• To use a keyboard 
command to insert a 
glossary, select an 
insertion point, hold 

116/GO! 

down the Command 
key, type G , and then 
type the character 
assigned to the 
glossary. See "To 
Create a Glossary" in 
this chapter to assign a 
keyboard command to 
a glossary. 

• To import glossaries 
from another 
document, choose 

o 
Replace ... 
Replace Nellt 

.,IHyphenation On 
Hyphenation Off 
Hyphenation Specs. 

Tabs ... 
Type Specs .. . 
Styles ... 
Remoue Styles 

Check Spelling 
Suggest Spelling ... 
Rdd Word 

Glossaries from the 
Text menu and click 
Import . A dialog box 
lists the Ready,Set,Go! 
documents on your 
disk. Double-click a 
document to import 
its glossaries. The new 
glossaries a ppear in 
the list far the current 
document. You can 

paste one at the 
insertion point or just 
click Done. 

• To insert the current 
date or time, select an 
insertion point, 
choose Glossaries 
from the Text menu, 
select one of the 
preexisting glossaries 
for the date or time , 
click Paste, and then 
click Done . 

1. Select an insertion point. 

2. Choose Glossaries. 

Glossories 

Short time/t 
long time/T 
Short date/d 
long date/O 
Abbreuiated date/I) 

L-____________ ~ 

( ()'~'i'H~ ) 

(Rename ... ) 

( Poste ) 

(Import... ) 

Delete 

ti Done 9 

3. Select 
the glossary 
and click 
Paste. 

4. Click 
Done. 

WORKI NG WI TH TEXT 

Tiffle-Savers 
To use a 
glossary 

You can insert a 
glossary in any text 
block in your 
document. 

1 Select an insertion 
point where you want 
to insert the glossary. 

·2 Choose Glossaries 
from the Text menu. 

A window displays the 
names of glossaries in 
the current document. 

3 Select the glossary 
yo,u want and click 
Paste. 

4 Click Done. 

The text is inserted at 
the curre nt insertion 
point in the font , 
style, size, and format 
that you used ta create 
it. Yau can change the 
style and format with 
menu commands ar 
stylesheets . 

• To use a keyboard 
command to insert a 
glossary, select an 
insertion point, hold 

116/GO! 

down the Command 
key, type G , and then 
type the character 
assigned to the 
glossary. See "To 
Create a Glossary" in 
this chapter to assign a 
keyboard command to 
a glossary. 

• To import glossaries 
from another 
document, choose 

o 
Replace ... 
Replace Nellt 

.,IHyphenation On 
Hyphenation Off 
Hyphenation Specs. 

Tabs ... 
Type Specs .. . 
Styles ... 
Remoue Styles 

Check Spelling 
Suggest Spelling ... 
Rdd Word 

Glossaries from the 
Text menu and click 
Import . A dialog box 
lists the Ready,Set,Go! 
documents on your 
disk. Double-click a 
document to import 
its glossaries. The new 
glossaries a ppear in 
the list far the current 
document. You can 

paste one at the 
insertion point or just 
click Done. 

• To insert the current 
date or time, select an 
insertion point, 
choose Glossaries 
from the Text menu, 
select one of the 
preexisting glossaries 
for the date or time , 
click Paste, and then 
click Done . 

1. Select an insertion point. 

2. Choose Glossaries. 

Glossories 

Short time/t 
long time/T 
Short date/d 
long date/O 
Abbreuiated date/I) 

L-____________ ~ 

( ()'~'i'H~ ) 

(Rename ... ) 

( Poste ) 

(Import... ) 

Delete 

ti Done 9 

3. Select 
the glossary 
and click 
Paste. 

4. Click 
Done. 



To stop 
automatic 
hyphenation 

Ready ,Set ,Go! 
automatically 
hyphenates words as 
you type. If you 
change the size of a 
text block or edit the 
text, it automatically 
rehyphenates . 

You can turn off 
automatic 
hyphenation 
completely or remove 
hyphe nation from 
selected text. You can 
also keep together 
words that are 
separated by a space 
or hyphen . 

To make a word a 
permane nt exception 
to hyphenation, see 
"To Define an 
Exception to 

Hyphenation" in this 
chapter. 

• To turn off 
hyphenation, select an 
inse(~ion point and 
choose Hyphenation 
Off from the Text 
menu . 

The text you type from 
the insertion point on 
is not hyphenated. 

You can also turn off 
automat ic 
hyphenation with the 
Type Specs 
command. See "To 
Set Up Type 
Specifications" in this 
chapte r. 

• To remove 
hyphenation from 
existing text, select the 
text and choose 
Hyphenation Off from 
the Text menu. 

Text that you insert 
with the Paste 
command keeps its 
hyphenation format. 
To ensure that a text 
block or chain uses the 
same format 
throughout, choose 
Select All from the 
Edit menu and then 
choose the 
hyphenation 
command you want. 

• To keep two or more 
words together on the 
same line, put a 
nonbreaking space 
between them by 

holding down the 
Option key and typing 
the space . 

A nonbreaking space 
may be wider than a 

normal space, and 
you can see the 
difference in a printed 
document. To remove 
a nonbreaking space, 
select it and type a 
normal space. 

II • To turn off 
hyphenation before 
you enter text, 
select an insertion point 
and choose 
Hyphenation Off from 
the Text menu. 

Find NeHt 3€F 
Replace •.. 
Replace NeHt 3€R 

..-Hyphenation On 
Hyphenation Off 
Hyphenation Specs ... 

Tabs ... 3€T 
Type Specs ... 3€Y 
Styles ... 3€H 
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Glossaries ... 3€G 

Check Spelling 3€K 
Suggest Spelling... 3€J 
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.4tsig:D. byrtjecti..Di'thtidu 
'tbt .. piWitIg JIl ust . 

'rtpru tntthrtt-tilntnsiow ' 
'spact . The two...ti.m.n~s iou..l : 
:swf..ct of tht pm.ti.ni 
')eumt ou of \.is objects 
:oCiDltrut,u4thtwa.ytLl: ' 
)~t lll4 otbtr Cuut artists : 
.ori1.llj,ud. thl: swfa.ct 
'4tfilLtd. .. ut olcltsi.p 
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:arts . Tu cu.bists wo1J.Sta 
.type as .. slrona- tltmtlLt of 
not vU\LIltxptrltlLCt, 
:optlliJl.i the 'fty for MW 

' tl"UJlII.tAU 0( typt . 
. Max Irut was OM of the ' 
:Iu.4~ ,Wilers ill the . 

• To turn off 
hyphenation for existing 
text, select the text 
and choose 
Hyphenation Off from 
the Text menu. 
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WORKI NG WI TH TEXT 

Ti1ne-Savers 
To define an hyphenate it. If you 
exception to want to hyphenate it 
hyphenation differently, type the 

word with hyphens 
If you do not want where you want to 
Ready,Set,Go! to allow them. 
hyphenate a particular 
word or if you want to You can use any 
hyphenate it combination of 
differently, you can uppercase and 
make it an exception lowercase characters. 
by adding it to a list of Ready,Set,Go! ignores 
exceptions . uppercase and 

lowercase when 
1 Choose searching for 
Hyphenation Specs exceptions. 
from the Text menu. 

3 Click Insert Word. 
A window displays the 
current list of The word is added to 
exceptions, if any, the list alphabetically. 
and some general You can scroll through 
hyphenation the list of words or add 
specifications. It also another word. 
displays a blank below 
the list where you enter 4 Click Done. 
exceptions . 

The window closes and 
2 Type the word you the words you added 
want to add to the list. are stored in a file 

called Hyphenation 
You can type only one Exceptions that is 
word at a time. It can stored on your disk 
include letters and with the 
hyphens, but no other Ready,Set,Go! 
characters. Type the application. This list is 
word without hyphens used for all your 
if you never want to Ready,Set,Go! 

documents . 

118/ GO! 

• To change 
hyphenation on a 
case-by-case basis, 
select the word and 
turn on automatic 
hyphenation. You can 
also hold down the 
Command key and 
type hyphens where 
they are appropriate 
in a word. The word is 
hyphenated where you 

typed a Command­
hyphen if it does not 
fit on the line. 

• To remove a word 
from the list of 
exceptions, choose 
Hyphenation Specs 
from the Text menu, 
select the word you 
want to remove, click 
Delete Word(s), and 
then click Done. 

Find ••. 
Find NeHt 3€F 

1. Choose 
Hyphenation Specs. 

3€R 
Replace ... 
Replace NeHt 

2. Type the word. 
....-Hyphenation On 

Hyphenation orr 3. Click Insert Word. 
- I'" I I' 

- Hyphenation Specs 

Minimum 
r-----------r~Al Word Size: 

Minimum 
Before: 

[Hceptions: 

Minimum 
After: 

D Characters 

D Characters 

D Characters 

MaHimu~ f31 lines 
Consecutive Hyphens: '-=--J 

1===== ==== =='-1 181 Break last Word of Paragraph 

LI t_W_O_- d_im_e_n_s_io_na_I ____ -'1 18I Break Capitalized Words 

C Insert Word llnPll'tP IJiIHllh) 

Type hyphens where 
appropriate. Type the 
word without hyphens if 
you don 't want to 
hyphenate it. 

(~I 

4. Click 
Done. 
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To change 
hyphenation 
specifications 

You can change some 
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that Ready,Set,Go! 
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You can specify the 
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of consecutive lines 
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WORKI NG WI TH TEXT 

Tiffle-Savers 
To check 
spelling 

You can check spelling 
in a single text block or 
in a chain of blocks . 

Ready,Set,Go! uses 
the RSG Dictionary 
and a supplemental 
User Dictionary to 
search for legitimate 
spellings. See "To 
Change the User 
Dictionary" in this 
c ha pter. 

1 Select an insertion 
~ --point where you want 

to begin the spelling 
check. 

It begins after the 
insertion point or any 
selected text and ends 
at the end of the block 
or chain of linked 
blocks. 

2 Choose Check 
Spelling from the Text 
menu . 

If you 're checking a 
linked block and don't 
want to check the rest 
of the blocks in the 
chain, hold down the 
Option key while you 

120/ GO! 

choose Check 
Spe lling . 

When a misspelled or 
unknown word is 
found , it is selected. 

3 Correct the 
misspelling by typing 
the word again. 

Choose Suggest 
Spelling from the Text 
menu if you want help 
with the spelling. 

If the word is correctly 
spelled but unknown to 
the RSG Dictionary, 
you can add it to the 
User Dictionary by 
choosing Add Word 
from the Text menu. 

4 Choose Check 
Spelling again to 
continue checking. 

If ReadY,Set,Go! does 
not find a misspelled 
or unknown word, the 
insertion point does 
not move. 

II 1. Select an insertion point. 

'LOiOS, ih ILir simplHI 
:Corm., an jUSI IU: hAmt of 
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:th.t compuyor prol\I.Ct 
')tliliJ. tht loiO is .. cassi.c, : 
:Wtll-roott4 iD.lictory. A 
'mon molitl'1lsl.1$strufJ.et , : 
:s'Uth t.S Hdvtti.u, might .. .. 

Find ... 
Find NeHt 

2. Choose Check 
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Replace ... 
Replace NeHt :l€R 
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"To )t2'in, rtmtmlltr lUI: 

choose Add :lyptlltH th.tmstlvu eo1D. - : 

Word from the :~':':;~7tt:t~~ mu -

Text menu :~V;:~~:;,°:!r'::~al ' 
to add a new "strokU, hllsthtwor14tbt . 

:tht eompuyor prooiuct 

word to the ·',hiM tho 10 .. " "W,~ • . 
: Wtll~ottd ill. history. A 

User Dictionary. "m.O" mooitl'1l sns uri( latt , . 

:slId. lS Htlv'ttiu., lDight 

3. Type to correct a 
misspelled word. 

4. Choose Check 
Spelling again to 
continue. 
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To change the 
U~er Dictionary 

The User Dictionary is 
a text file that 
Ready,Set,Go! uses as 
a supplement to its 
basic spelling 
dictionary. 

You can add selected 
words to the User 
Dictionary with the 
Add Word command. 
You can also open the 
User Dictionary and 
add or delete words 
directly. 

1 Draw a text block 
and select an insertion 
point. 

2 Choose Get Text 
from the File menu. 

A dialog box lists the 
text files on the current 
disk. Click Drive and 
open folders , if 
necessary, to find the 
User Dictionary. It 
should be in the same 
folder as the 
Ready,Set,Go! 
application. 

3 Select User 
Dictionary and click 
Open. Or just double­
click the name . 

The list of words in the 
User Dictionary 
appears in the text 
block. 

4 Add, change, or 
delete words, keeping 
one word to a 
paragraph. 

When you insert a 
word, press Return 
after you type it. 

. 5 Choose Put Text 
from the File menu. 

A dialog box prompts 
you for the name of 
the document into 
which you want to put 
the text. 

6 Type User Dictionary 
as the name and click 
Save. 

Be sure to save the 
User Dictionary in the 
same folder as the 
Ready,Set,Go! 
application. 

7 When the next 
dialog box asks you to 
confirm the name, 
click Yes to replace the 
old version. 

You must quit and 
restart Ready. eLGo! 
to use the ne"- \-er ion 
of the User 
Dictionary. 

J . . . . ... . . . . 

1m II 
1. Create a text block 
and select an 
Insertion point. 

New :l!:N 
Open... il€O 
Close il€W 
SBue il€S 
Saue Rs ... 
Page Setup ... 
Printer Setup ... 
Print ... 

Put TNtt .. . 

2. Choose Get 
Text from the File 
menu. 

3. Double·click User 
Dictionary. 

llill Rppli(ation Disk I 
o User Dictionary 

doli 
:duchemp 
:ernst 
:goudy 
:letterforms 
:morcel 
:reodymodes 

lill Hpplicatlon ... 

c::::lli'i'- ] 
[ DriL'e : 

Open 

.' (ane pi 

4. Add, change, or 
delete words. 

5. Choose Put Text 
from the File menu. 

6. Type User Dictionary 
and click save. 

7. Click Yes. 
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W 0 R KIN G WITH G RAP Hie S 

Working With Graphics 

12 GO. 

G r~phics illustrate, emphasize, 
and organize. Sometimes they 
communicate the same 

information as text, but more quickly and 

more effectively. A bar chart of sales 
growth and a pie chart that shows how a 
population is divided by age groups are 
examples . 

ometimes graphics communicate things 

that can't be expressed in text-things 
like the pattern of circuits on a computer 
chip or the joy in a child's smile . 

Sometimes they help the text 

communicate better by dividing a page 
into columns or guiding the eye to 

important headings on the page. 
Sometimes they are the whole message. 
When you create graphics in a 

Ready,Set,Go! document, you have a choice 
of two kinds of graphics to do all of 

these tasks: graphic objects and pictures. 

Rectangles, Ovals, and Lines 

Graphic objects like rectangles, rounded 
rectangles, and ovals can form borders 
around text or pictures. They can also be 

the building blocks of simple charts and 

diagrams. 
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Lines-horizontal, vertical, and 

diagonal-can divide columns and rows 

with rules or give weight to the top or 

bottom of a page. They can also lead the 

reader's eye from a text label to the part 

of a picture it describes . 

Stacking graphic objects can give depth 

to a page-a solid rectangle behind a 

block of text, for example, suggests the 

I shadow created by a three-dimensional 

form. You can also experiment with 52 

patterns, including gray scales . Fill 

rectangles, rounded rectangles, and ovals 

with these patterns. Or choose from an 

equal number of border patterns, which 

may be the same as the fill pattern or 

different. You can also vary the width and 

style of many lines. 

The Picture Block 

You put pictures in picture blocks. You 

work with them the same way you work 

with other objects-moving and copying 

them, changing their size, locking them, 

or removing them from the document. So, 

in addition to the instructions in this 

section, you may want to refer to 

"Working With Objects" in this chapter. 

The pictures you put in a picture block 

can be charts from a spreadsheet program 

that you save in a graphics format. They 

can be illustrations you create in a 

graphics application. Or they can be 

photographic images you scan and save in 

a compatible graphics format . See "The 

Software" in Chapter 4 for details . 

When you move, copy, duplicate, or 

remove a picture block with a picture, 

you automatically move, copy, duplicate, 

or remove the picture, too. If you change 

the size of a picture block, though, you 

don't change the size of the picture. You 

just show more or less of it. 

You can change the size of the picture 

by scaling it. If the picture is too big to 

fit in the space allotted, you can scale it 

down. If you want it to fill more space, 

you can scale it up. Aside from improving 

fit , scaling can produce special effects, 

such as condensing or expanding an image. 

Because you can scale vertically, 

horizontally, or both, you can stretch a 

picture into new shapes. This feature is 

particularly useful for creating special 

typographic effects . 
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WORKI NG WITH GRAPHICS 

Rectangles) Ovals) and Lines 
To draw a 
graphic object 

You can draw several 
kinds of graphic 
objects: rectangles, 
quares, rectangles 

w ith rounded corners, 
ovals, and circles. 
You can also draw 
horizontal, vertical, 
and diagonal lines in 
various widths. 

1 Select one of the 
shape tools from the 
tool bar. 

2 Choose the line you 
want to use from the 
Lines menu. 

You can choose from 
a solid line in six 
widths, a dashed line 
in five widths , or one 
of three styles of 
double lines. A check 
marks the current 
selection. 

3 Position the pointer 
on the page. 

When you move the 
pointer into the 
window, it changes to 
a crossbar. 

124/ GO! 

4 Drag to draw the 
object. 

The object appears 
with the line width and 
style you chose. You 
can also choose a 
border pattern from 
the Pen menu. See "To 
Change the Border of 
an Object" in this 
chapter. 

Thin ----..c~Th~:-----. 

The object is not filled 
with a pattern unless 
you have chosen one 
from the Fill menu. 
See "To Change the 
Fill Pattern of an 
Object" in this 
chapter. 

You can change the 
size of a graphic 

object, move it or 
duplicate it on the 
page, copy or move it 
to another page or 
document, lock it, or 
remove it from the 
document entirely. 
You can also specify 
the size of a graphic 
object for greater 
precision. For details, 
see "Working With 
Objects" in this 
chapter. 

1. Select a shape tool. 

2. Choose a line. I _In_ 

1 point2---- 3. Position the pointer on the page. 

2 pOints~/ h = 4. Drag to draw the shape. 
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WORKI NG WITH GRAPHICS 

Rectangles) Ovals) and Lines 
To draw a 
graphic object 

You can draw several 
kinds of graphic 
objects: rectangles, 
quares, rectangles 

w ith rounded corners, 
ovals, and circles. 
You can also draw 
horizontal, vertical, 
and diagonal lines in 
various widths. 

1 Select one of the 
shape tools from the 
tool bar. 

2 Choose the line you 
want to use from the 
Lines menu. 

You can choose from 
a solid line in six 
widths, a dashed line 
in five widths , or one 
of three styles of 
double lines. A check 
marks the current 
selection. 

3 Position the pointer 
on the page. 

When you move the 
pointer into the 
window, it changes to 
a crossbar. 

124/ GO! 

4 Drag to draw the 
object. 

The object appears 
with the line width and 
style you chose. You 
can also choose a 
border pattern from 
the Pen menu. See "To 
Change the Border of 
an Object" in this 
chapter. 

Thin ----..c~Th~:-----. 

The object is not filled 
with a pattern unless 
you have chosen one 
from the Fill menu. 
See "To Change the 
Fill Pattern of an 
Object" in this 
chapter. 

You can change the 
size of a graphic 

object, move it or 
duplicate it on the 
page, copy or move it 
to another page or 
document, lock it, or 
remove it from the 
document entirely. 
You can also specify 
the size of a graphic 
object for greater 
precision. For details, 
see "Working With 
Objects" in this 
chapter. 
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To change the 
fill pattern of an 
object 

You can fill an object 
with one of 52 
patterns, including no 
pattern at all. 

1 Select the graphic 
object you want to fill. 

You can fill text blocks 
with a pattern. Choose 
a dark fill pattern and 
select the White Type 
option with the 
Specifications 
command to . reverse 
type. 

You can also select a 
group of objects. See 
"To Select a Group of 
Objects" in this 
chapter. 

2 Choose a pattern 
from the Fill menu. 

The pattern fills the 
object, but does not 
change its border. 

If you choose None, 
the object is 
transparent. You can 
see any text or object 
beneath it. 

If you choose the white 
pattern, the object is 
not transparent. You 
cannot see any text or 
object beneath it. 

The patterns labeled 
10 through 90 are 
percentages of black. 

You can also choose a 
fill pattern before you 
create an object. 

L1 1. Select the object. 

You cannot see 
through 

2. Choose a pattern. 

objects filled with -----Ed~~lIlI 
the white pattern. 

You can see 
through objects filled 
with None. 
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To change the 
fill pattern of an 
object 

You can fill an object 
with one of 52 
patterns, including no 
pattern at all. 

1 Select the graphic 
object you want to fill. 

You can fill text blocks 
with a pattern. Choose 
a dark fill pattern and 
select the White Type 
option with the 
Specifications 
command to . reverse 
type. 

You can also select a 
group of objects. See 
"To Select a Group of 
Objects" in this 
chapter. 

2 Choose a pattern 
from the Fill menu. 

The pattern fills the 
object, but does not 
change its border. 

If you choose None, 
the object is 
transparent. You can 
see any text or object 
beneath it. 

If you choose the white 
pattern, the object is 
not transparent. You 
cannot see any text or 
object beneath it. 

The patterns labeled 
10 through 90 are 
percentages of black. 

You can also choose a 
fill pattern before you 
create an object. 

L1 1. Select the object. 

You cannot see 
through 

2. Choose a pattern. 

objects filled with -----Ed~~lIlI 
the white pattern. 

You can see 
through objects filled 
with None. 
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WORKI NG WI TH GRAPHI C S 

Rectangles) Ovals) and Lines 
To change the 
border of an 
object 

You can choose one of 
52 border patterns for 
your objects or lines. 
These combine with 
the line you choose 
from the Lines menu 
to produce a variety of 
effects. 

1 Select the graphic 
object whose border 
you want to change. 

You can also select a 
group of objects. See 
"To Select a Group of 
Objects" in this 
chapter. 

2 Choose a pattern 
from the Pen menu. 

The border appears in 
the pattern you 
choose. 

126/ GO! 

If you choose the white 
pattern or None, the 
border disappears but 
any fill pattern 
remains. If the object 
is filled with white or 
no pattern, the entire 
object may seem to 
disappear. 

You can find a missing 
object by choosing 

Select All from the 
Edit menu . When the 
object is selected, its 
handles appear on the 
screen and you can 
change its border or 
fill pattern to make it 
visible again. 

Some other patterns 
may cause the object 
to disappear, too. For 
example, if you draw a 
horizontal line with 
one of the horizontal 
stripe patterns, the 
line may disappear. 
You can find it with the 
Select All command. 

The patterns labeled 
10 through 90 are 
percentages of black. 

L1 1. Select the object. 

I I 
2. Choose a pattern. 

I I 

WORKI NG WI TH GRAPHI C S 

Rectangles) Ovals) and Lines 
To change the 
border of an 
object 

You can choose one of 
52 border patterns for 
your objects or lines. 
These combine with 
the line you choose 
from the Lines menu 
to produce a variety of 
effects. 

1 Select the graphic 
object whose border 
you want to change. 

You can also select a 
group of objects. See 
"To Select a Group of 
Objects" in this 
chapter. 

2 Choose a pattern 
from the Pen menu. 

The border appears in 
the pattern you 
choose. 

126/ GO! 

If you choose the white 
pattern or None, the 
border disappears but 
any fill pattern 
remains. If the object 
is filled with white or 
no pattern, the entire 
object may seem to 
disappear. 

You can find a missing 
object by choosing 

Select All from the 
Edit menu . When the 
object is selected, its 
handles appear on the 
screen and you can 
change its border or 
fill pattern to make it 
visible again. 

Some other patterns 
may cause the object 
to disappear, too. For 
example, if you draw a 
horizontal line with 
one of the horizontal 
stripe patterns, the 
line may disappear. 
You can find it with the 
Select All command. 

The patterns labeled 
10 through 90 are 
percentages of black. 

L1 1. Select the object. 

I I 
2. Choose a pattern. 

I I 



The Picture Block 
To create a 
picture block 

Before you can insert 
pictures on a page, 
you must create a 
picture block. 

1 Select the picture 
tool from the tool bar 
by clicking it. 

As you drag , a dotted 
rectangle shows the 
size and position of 
the picture block. 
When you release the 
mouse button, the 
picture block is 
selected. If you create 
more picture blocks, 
they all stay selected 
until you choose 
another tool. 

If the grid is active, the 
picture block snaps to 
fit one or more 
rectangles in the grid. 

You can change the 
size of the picture 
block, move it, copy 
or duplicate it, 
remove it, or lock it. 
See "Working With 
Objects" in this 
chapter. 

2 Position the 
pointer on the page in 
the window. I~I 

The pointer changes 
to a crossbar when you 
move it inside the 
window. 

3 Drag the pointer to 
draw the picture 
block. 
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1. Select the 
picture tool. 

2. Position the 
pointer 
on the page. 

3. Drag to draw 
the picture 
block. 

The pointer 
changes to a 
crossbar. 

AnXin the 
picture block 
distinguishes 
itfrom a 
rectangle. 
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The Picture Block 
To create a 
picture block 

Before you can insert 
pictures on a page, 
you must create a 
picture block. 

1 Select the picture 
tool from the tool bar 
by clicking it. 

As you drag , a dotted 
rectangle shows the 
size and position of 
the picture block. 
When you release the 
mouse button, the 
picture block is 
selected. If you create 
more picture blocks, 
they all stay selected 
until you choose 
another tool. 

If the grid is active, the 
picture block snaps to 
fit one or more 
rectangles in the grid. 

You can change the 
size of the picture 
block, move it, copy 
or duplicate it, 
remove it, or lock it. 
See "Working With 
Objects" in this 
chapter. 

2 Position the 
pointer on the page in 
the window. I~I 

The pointer changes 
to a crossbar when you 
move it inside the 
window. 

3 Drag the pointer to 
draw the picture 
block. 
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1. Select the 
picture tool. 

2. Position the 
pointer 
on the page. 

3. Drag to draw 
the picture 
block. 

The pointer 
changes to a 
crossbar. 

AnXin the 
picture block 
distinguishes 
itfrom a 
rectangle. 
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The Picture Block 
To insert a 
picture 

You can insert a 
picture in a picture 
block if you created or 
scanned the picture 
with Letraset's Image­
Studio or an 
application that can 
save its graphics in 
MacPaint, PICT, TIFF, 
or EPSF format. See 
"The Software" in 
Chapter 4 for more 
information about 
compatible 
applications. 

1 Select the cropping 
tool from the tool bar. 

128/ GO! 

2 Click in the picture 
block into which you 
want to insert a 
picture. 

If no picture is in the 
block, a wavy pattern 
shows it's selected and 
ready for a picture. If 
the picture block 
contains a picture, a 
rectangle appears 
around it to show it's 
selected. 

3 Choose Get Picture 
from the File menu. 

A dialog box lists the 
documents you can 
use. If you are using 
the hierarchical file 
system, it also lists 
folders that may 
contain documents 
you can use. You can 
open the folders to 
view additional folders 
and their documents. 

You can click the Eject 
or Drive button to go 
to another disk. 

4 Select the 
document you want 
and click Open. Or 
just double-click the 
name. 

The picture is inserted 
in the picture block, 
and any existing 
picture is replaced. 

If you don't see your 
picture , it's likely that 
your block is smaller 
than the picture and 
that you 're seeing the 
white space in the 
picture. 

You can make the 
picture block larger or 
you can use the 
cropping tool to move 
the picture in the 
block. See "To Crop a 
Picture" in this 
chapter. 

• To copy a picture 
from another 
document with the 
Scrapbook or 
Clipboard, see "To 
Copy Part of a 
Document" in this 
chapter. The steps are 
the same, except you 
work with pictures and 
picture blocks instead 
of text and text blocks. 

• To insert text as a 
picture, create a text 
block, type and format 
the text you want to 
insert in the picture 
block, select the text 
block with the object 
pointer, and choose 
Cut or Copy from the 
Edit menu. Then 
select the picture block 
with the cropping tool 
and choose Paste from 
the Edit menu. You 
can't edit text in a 
picture block, but you 
can crop and scale it 
for special 
typographic effects. 

The Picture Block 
To insert a 
picture 

You can insert a 
picture in a picture 
block if you created or 
scanned the picture 
with Letraset's Image­
Studio or an 
application that can 
save its graphics in 
MacPaint, PICT, TIFF, 
or EPSF format. See 
"The Software" in 
Chapter 4 for more 
information about 
compatible 
applications. 

1 Select the cropping 
tool from the tool bar. 

128/ GO! 

2 Click in the picture 
block into which you 
want to insert a 
picture. 

If no picture is in the 
block, a wavy pattern 
shows it's selected and 
ready for a picture. If 
the picture block 
contains a picture, a 
rectangle appears 
around it to show it's 
selected. 

3 Choose Get Picture 
from the File menu. 

A dialog box lists the 
documents you can 
use. If you are using 
the hierarchical file 
system, it also lists 
folders that may 
contain documents 
you can use. You can 
open the folders to 
view additional folders 
and their documents. 

You can click the Eject 
or Drive button to go 
to another disk. 

4 Select the 
document you want 
and click Open. Or 
just double-click the 
name. 

The picture is inserted 
in the picture block, 
and any existing 
picture is replaced. 

If you don't see your 
picture , it's likely that 
your block is smaller 
than the picture and 
that you 're seeing the 
white space in the 
picture. 

You can make the 
picture block larger or 
you can use the 
cropping tool to move 
the picture in the 
block. See "To Crop a 
Picture" in this 
chapter. 

• To copy a picture 
from another 
document with the 
Scrapbook or 
Clipboard, see "To 
Copy Part of a 
Document" in this 
chapter. The steps are 
the same, except you 
work with pictures and 
picture blocks instead 
of text and text blocks. 

• To insert text as a 
picture, create a text 
block, type and format 
the text you want to 
insert in the picture 
block, select the text 
block with the object 
pointer, and choose 
Cut or Copy from the 
Edit menu. Then 
select the picture block 
with the cropping tool 
and choose Paste from 
the Edit menu. You 
can't edit text in a 
picture block, but you 
can crop and scale it 
for special 
typographic effects. 



1. Select the cropping tool. 

2. Click in the picture block. 

3. Choose Get Picture. 

The picture 
appears 
in the picture 
block. 

Saue 
Saue As ... 
Page Setup ... 
Printer Setup ... 
Print... 
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D Letterform 
D Logotype 
D Mostheod 
D Pi(a~~o 
D Pictogroph 
D Symbol 

(gJ Applicotion ... 

Eject 

Driue 

Open 
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the document 
with the 
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WORKING WITH GRAPHICS 

The Picture Block 
To crop a 
picture 

A picture block acts 
like a hole cut out of a 
sheet of paper. If you 
put the paper on top of 
a picture, you can see 
only part of the picture 
through the hole 
because the paper 
"crops" the rest of it. 

130/ GO! 

You can move the 
picture in a picture 
block to change the 
way it is cropped. 

1 Select the cropping 
tool from the tool bar. 

2 Position the 
pointer in the picture 
block and drag the 
picture in the picture 
block. 

1. Select the cropping tool. 

2. Position the 
pointer in the block 
and drag. 

You can keep dragging 
beyond the edge of the 
picture block. The 
picture keeps moving 
as long as you hold 
down the mouse 
button. 
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To move, copy, 
replace, 
or remove a 
picture , 

You can move or copy 
a picture from one 
block to another, 
replace it with another 
picture , or remove it 
from the document 
entirely. 

• To move or copy a 
picture from one 
block to another, 
select the picture with 
the cropping tool and 
choose Cut or Copy 
from the Edit menu. 

The picture is stored 
on the Clipboard, 
replacing the last thing 
you cut or copied. You 
can select another 
picture block and 
paste the picture in it 
with the Paste 
command . 

You can preserve any 
cropping or scaling by 
selecting the entire 
picture block with the 
object pointer when 
you cut or copy. 

• To replace a picture 
with another picture, 
select the one you want 
to replace with the 
cropping tool and 
choose Get Picture 
from the File menu. 

A dialog box displays 
the available picture 
documents. When you 
open the one you 
want, it replaces the 
existing picture in the 
block. 

You can also paste a 
picture from the 
Clipboard or 
Scrapbook to replace 
an existing one. 

• To remove a picture, 
select it with the 
cropping tool and 
choose Clear from the 
Edit menu. Or select it 
and press the 
Backspace key. 

_ • Select the picture. 

• Choose Copy 
to copy it to 
the Clipboard. 

• Choose Clear 
or press Backspace 
to remove it 
entirely. 

When you choose 
Clear or use the 
Backspace key, the 
picture is not saved on 
the Clipboard. 

• To restore a picture 
that you have 
removed, choose 
Undo from the Edit 
menu before you do 
anything else. 
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• Choose 
Cut to 
move it to 
the Clip. 
board. 
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WORKI NG WITH GRAPHICS 

The Picture Block 
To scale a 
picture 

When you insert a 
picture in a picture 
block, it may not fit 
the block. You can 
scale it larger or 
smaller to fit. 

The normal scale is 
100 percent. To 
reduce the scale, type 
a percentage less than 
100. To increase the 
scale, type a 
percentage greater 
than 100. 

4 Click OK. 

The size of the picture 
block remains the 
same, but the 
proportions of the 
picture within the 
block change. 

If necessary, you can 
change the way the 
picture is cropped with 
the cropping tool. 

You can change the 
scale across or down 
the picture to expand 
or condense it, either 
horizontally or 
vertically. 

1. Select the picture block or the picture. 

1 Select the picture 
block with the object 
pointer. Or select the 
picture with the 
cropping tool. 

2 Choose 
Specifications from 
the Edit menu. 

A dialog box displays 
the specifications for 
the picture block and 
several options. 

3 Type a percentage 
of the normal scale for 
Scale Across and Scale 
Down. 

132/ GO! 

1),,,11) :-:1 

Cut 3€ H 
CoPy 3€C 
Paste 3€U 
Clear 

Select All 3€R 
Duplicate ... 3€D 

lock 
./Unlock 

Bring To Front 
Send Behind 

Specifications... 3€M 

Picture Block Specificotions 

File: Pic ossa Type: PICT 

Stort Rcross: 16.06 1 picos.pts 181 locked 

Shirt Down: 19.00 1 picos.pts 181 Runoround 

119.09 1 picos.pts 
@Frame 

Width: o Graphic 

Depth: 124.06 I picos.pts D Don·t Print 

TeHt Repel 1°·06 I picas.pts 
Distance: 

Scole Across: 1123 I percent 

Scale Down: 1123 I percent ([ OK )) ~ 

2. Choose 
Specifications. 

3. Type a new 
percentage for Scale 
Across and Scale 
Down. 

4. Click OK. 
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Printing 

134/ GO! 

P rinting is the moment of glory. 
After you've done all the work of 

designing a document, entering 
and formatting text, and illustrating the 

text with pictures and graphics, you get 
to see the results of your efforts on the 
printed page. 

Before you print, however, you have 

some choices to make. You select the 
printer you want to use and several setup 

and printing options. These options differ 
for different printers . 

The Setup 

In order to print, you need a resource for 
your printer. This is a program that 

translates the file you 're printing into a 
language your printer understands. The 
System Folder on your Ready,Set,Go! 
System Disk comes with three printer 
resources: an ImageWriter resource , an 
AppleTalk ImageWriter resource, and a 

LaserWriter resource. If you are using a 
LaserWriter, you also need the LaserPrep 
file that comes in your System Folder. 
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You select the printer with the 
Chooser desk accessory. If you are using 

a network with more than one printer, 

you can also identify the printer you want 

to use by a name that you or someone 
else gives it. 

Once you have selected a printer, you 

can select your Printer Setup options. 

These are the paper size and orientation 

you plan to use for printing. If you are 

using a standard page size, the Printer 

Setup options should be the same as the 

ones you select with the Page Setup 

command. (See "To Change the Page Size 

and Orientation" in this chapter.) If you 

are using a tabloid or other page size , 

you can decide which paper size and 

orientation are best for printing. 

The Printout 

When you are ready to print, select your 

printing options. How many copies do you 

want to print? Do you want to print all of 

the pages or just some of them? What 

print quality do you need? Do you need 

to give special instructions to the 
LaserWriter? 

You also make choices about the way 

you feed paper. You can feed it 

automatically or by hand. With many 

preprinted forms, folded paper, or paper 

sizes that can't be fed automatically, you 

must feed them one at a time, by hand. 

When you're finished printing, you may 

not be finished with your task. If you 

plan to print many copies, your printout 

may simply be a "camera-ready" original 

that you take to a professional printer for 

printing. If you need a very high quality 

original for printing, your printout may 

be a proof copy of your document that you 

check before you take it to a 

phototypesetter. And of course, if you are 
printing tiles-sections of a very large 

page-you have some pasting to do. 
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PRI NTI NG 

The Setup 
To select a 
printer 

You can select the 
printer you want 
before you print. If 
only one printer is 
available, you must 
make sure that it is 
selected. 

1 Choose the 
Chooser from the 
Apple menu. 

A window shows icons 
for the printers and 
other resources 
available to you . 

2 Click the icon for 
the printer you are 
using. 

A dialog box reminds 
you to confirm the 
Page Setup options 
before you print. See 
"To Set Up an 
ImageWriter" or ''To 
Set Up a LaserWriter" 
in this chapter. 

3 Click Continue. 

4 If you are using an 
ImageWriter printer, 
select the port to 
which it 's connected. 

136/ GO! 

5 Type your name for 
the user name if it's 
not already entered. 

This name is optional. 

6 Click the close box 
to close the Chooser 
window. 

D 
About Ready,Set,Go! 

Alarm Clock 

Control Panel 
Key Caps 
Note Pad 
Scrapbook 

2. Click a 
printer 

con. 

3. Click 
continue. 

You must now confirm 
the Printer Setup 
options to let 
Ready,Set,Go! know 
which printer you are 
using . 

1. Choose Chooser. 

Image Writer icon 

/ u;erWriter icon 

Chooser 

User Name: 

1-·' 

CAUTION! You must 
choose the printer you 
will be printing with in 
the Chooser and 
confirm the choice 
with the Printer Setup 
command before you 
start to work on a 
document. 

AppleTalk 
@ Active 

o Inactive 3.1 

4. Click a printer 
port Icon If 

5. Type your 
name for 

the user name. you are using an 
ImageWrlter. 

6. Click the 
close box. 
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To set up 
an ImageWriter 

Before you begin 
printing with an 
ImageWriter, you can 
select the paper size 
and orientation, the 
method of feeding 
paper, and the 
method of 
pagination. 

1 Choose Printer 
Setup from the File 
menu. 

A dialog box displays 
the setup options for 
the ImageWriter. 

2 Click the options 
you want. 

If the Printer Setup 
options match the 
document's Page 
Setup options, 
Ready,Set ,Go! prints 
the document exactly 
as it appears on the 
screen. If the Printer 

Setup options are 
different , 
Ready,Set,Go! shows 
how the page will be 
printed on the paper 
size and in the 

New il€N 1. Choose Printer Setup. 
Open. .. il€O 
Close il€W 
Saue il€S 
Saue As ... 
Page Setup ... 

Print ... 
l,pt 1.~HL" 
Put 'h~ HL" 
bpt Pie1unL" 
Quit 

Prints 
Upright 

2. Click the options. 

8.5 X 11 
inches 

8.5 x 14 
inches 

6.93 x 9.84 
inches 

orientation you 
specify. See "To 
Change the Page Size 
and Orientation" in 
this chapter. 

3 Click OK. 

Prints 
sideways 

No Gaps Between Pages 

Must be 
selected for 
Ready, Set, Go! 
documents 

Halves 
page 
size 

Prints 
over page 
perforations 

3. Click OK. 
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PRI NTI NG 

The Setup 
To set up 
a LaserWriter 

Before you begin 
printing with a 
LaserWriter, you can 
select the paper size 
and orientation, 
reductions and 
enlargements, and 
some special options 
for producing high­
quality images. 

1 Choose Printer 
Setup from the File 
menu. 

A dialog box displays 
the setup options for 
the LaserWriter. 

2 Click the options 
you want. 

1 GO. 

If the Printer Setup 
options match the 
document's Page 
Setup options, 
Ready,Set,Go! prints 
the document exactly 
as it appears on the 
screen. If the Printer 

Setup options are 
different , 
Ready,Set,Go! shows 
how the page will be 
printed on the paper 
size and in the 

New 8I:N 
Open... 81:0 

1. Choose Printer Setup. 

[lose 8I:W 
Soue 8I:S 
Soue Rs ... 
Poge Setup ... 

Print... 
r,.~t rf'Ht 

Put f.'Ht,,, 

I'.~ t Pid ure ... 
Quit 

Prints 
upright 

Prints 
sideways 

2. Click the options. 

8.5 x 11 8.5 x 14 8.27 x 11.69 
inches inches inches 

orientation you 
specify. See "To 
Change the Page Size 
and Orientation" in 
this chapter. 

3 Click OK. 

6.93 x 9.84 
inches 

Substitutes 
installed 
LaserWriter 
fonts for 
anyfont not 
installed 

Smoothes 
bitmapped 
images 

You type a 3. Click OK. 

to reduce 
jagged 
edges 

percentage 
from 25 
percent to 
400 percent. 
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The Printout 
To print with an 
ImageWriter 

When you print with 
an ImageWriter, you 
can print the entire 
document or the range 
of pages you want. You 
can specify the 
number of copies you 
want, the paper 
source, and the print 
quality. 

1 Choose Print from 
the File menu. 

A dialog box displays 
the print options for 
the ImageWriter. 

2 Click the options 
you want. 

3 Click OK. 

The document is 
printed according to 
your specifications. 

New XN 1. Choose Print. 
Open ••• XO 
Close XW 
Saue XS 
Saue Rs ... 
Page Setup ••• 
Printer Setup •.• 

I;.~t ·h~Ht... 

Put 'h~Ht" 

Best 
quality 

Faster to 
print 
than the 
best quality 

Fast 2. Click 
printing the options. 
without 
graphics 3. Click OK. 

.,,>, l>i"l\1relF-='===~:====~=====\=====;;;;;;;;;~~ 
Quit (001 

Prin~ JL~~~~~ 

all pages 

For printing 
fanfold or 
a continuous 
roll of paper 

For printing 
single 
sheets 

You can 
specify the first 
and last pages 
you want 
to print. 
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Chapter 4 is your reJerence gUide to Ready, Set, Go! It describes 
the details oj Ready, Set, Go!- what's on the disks and the 
desktop, which commands are in which menus, what each 
command does, and what the preset options are. It tells you 
about some oj the applications you can use with Ready, Set, Go! 
and the shortcuts you can use to speed your work. 

If you 've already completed the tutorial in Chapter 2 and you've 
spent some time performing the tasks in Chapter 3, you can use 
this chapter as a quick reJerence Jor details you've Jorgotten or 
to learn more about how a command works. If you are an 
experienced Macintosh user, you may want to use this reJerence 
to help you explore the Jeatures oj Ready, Set, Go! instead oj 
going through the tutorial in Chapter 2. If you need help with 
individual tasks-such as starting Ready, Set, Go!, entering text 
Jrom another document, or creating a picture block-you can 
Jind . what you need in Chapter 3. 
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You can use Ready,Set,Go! with any Macintosh except a Macintosh 128K. 

The Ready,Set,Go! software comes on three disks: the System Disk, the 
Application Disk, and the Dictionary Disk. In addition to this software, you 
may want to use other applications, such as word processing programs, 
graphics software , or desk accessories and other utilities that help you work 
more efficiently. You may also want to install additional fonts. 

CAUTION! Do not use your original Ready,Set,Go! disks when you work. 
Make working copies of the disks and store the originals in a safe place. See 
"To Make Working Copies of Your Disks" in Chapter 3. 

The Ready,Set,Go! Application Disk is a 400K disk that contains the 
Ready,Set,Go! application, version 4.0, which you use to create 
documents, and a folder named Example. This folder contains four files 
that you use with the tutorial in Chapter 2. 

The Application Disk also includes two files that you should keep in the same 
folder as the Ready,Set,Go! application. These are the Hyphenation 
Exceptions file and the User Dictionary. 

The Hyphenation Exceptions file is a list of the exceptions to the built-in 
hyphenation rules in Ready,Set,Go! You can add to this list with the 
Hyphenation Specs command. See "The Text Menu" in this chapter for 
de tails . 
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The User Dictionary is a list of words that supplements the RSG Dictionary 
that Ready,Set,Go! uses to check spelling. You can add words to the User 
Dictionary with the Add Word command. The User Dictionary is a text­
only (ASCII) file. You can open it, edit it, and save changes to it with a word 
processor, but be sure to save it as a text-only file named User Dictionary 
when you're done. Each line must contain only one word, followed by a 
return character. You can edit the User Dictionary in Ready,Set,Go! by 
using the Get Text command to enter the dictionary in a text block and then 
using the Put Text command to save it again. See "The Text Menu" in this 
chapter for details about the commands you use to check spelling. See "The 
File Menu" in this chapter for details about using the Get Text and Put Text 
commands. 

CAUTION! If you edit the User Dictionary in Ready,Set,Go! you must quit 
Ready,Set,Go! and restart it before you can use your revised User 
Dictionary. 

You use the 
Ready, Set, Gol 
application 
to create 
documents. 

The User 
Dictionary 
contains 
words you add to 
supplement 
theRSG 
Dictionary for 
checking 
spelling. The Hyphenation Exceptions 

file lists words that are 
exceptions to the built-in 

hyphenation rules. 

This folder contains 
example files you need 

for the tutorial. 

THE SOF1WARE/ 143 

The User Dictionary is a list of words that supplements the RSG Dictionary 
that Ready,Set,Go! uses to check spelling. You can add words to the User 
Dictionary with the Add Word command. The User Dictionary is a text­
only (ASCII) file. You can open it, edit it, and save changes to it with a word 
processor, but be sure to save it as a text-only file named User Dictionary 
when you're done. Each line must contain only one word, followed by a 
return character. You can edit the User Dictionary in Ready,Set,Go! by 
using the Get Text command to enter the dictionary in a text block and then 
using the Put Text command to save it again. See "The Text Menu" in this 
chapter for details about the commands you use to check spelling. See "The 
File Menu" in this chapter for details about using the Get Text and Put Text 
commands. 

CAUTION! If you edit the User Dictionary in Ready,Set,Go! you must quit 
Ready,Set,Go! and restart it before you can use your revised User 
Dictionary. 

You use the 
Ready, Set, Gol 
application 
to create 
documents. 

The User 
Dictionary 
contains 
words you add to 
supplement 
theRSG 
Dictionary for 
checking 
spelling. The Hyphenation Exceptions 

file lists words that are 
exceptions to the built-in 

hyphenation rules. 

This folder contains 
example files you need 

for the tutorial. 

THE SOF1WARE/ 143 



I 

REF ERE NeE 

The Software 
The Dictionary 

Disk 

The System 
Disk 

144/ REFERENCE 

The Dictionary Disk is a 400K disk that contains the RSG Dictionary. This 
file is the built-in dictionary that Ready,Set,Go! uses to check spelling. 
Ready,Set,Go! also checks the User Dictionary on the Application Disk for 
words that you add with the Add Word command. 

The RSG Dictionary must be in the same folder as the Ready,Set,Go! 
application. If you are working with a hard disk or SOOK disks, create a 
working copy of your Application Disk and copy the RSG DictionalY into the 
same folder as the Ready,Set,Go! application. If you are working with one 
SOOK disk or 400K disks only, you cannot use the RSG Dictionary or any of 
the spelling features of Ready,Set,Go! See "To Make Working Copies of 
Your Disks" in Chapter 3 for details. 

Ready,Set, GO!_+-_ ______ ~~III 
uses the RSG 
Dictionary 
to check 

RSG DIctionary 

spelling. 

The Ready,Set,Go! System Disk is an SOOK disk that contains all the system 
software you need to start up your Macintosh and run Ready,Set,Go! unless 
you have 400K drives. It also contains the resources for the ImageWriter and 
LaserWriter printers. If you are using a different printer, you must use the 
appropriate resource. See the manual that came with your printer for 
details. See "To Make Working Copies of Your Disks" in Chapter 3 for 
details . 
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Other 
Applications 
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The System 
Folder has the 
software 
necessary to 
start up your 
Macintosh 
and run 
Ready, Set, Go! 
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Image Writer 
resource if you 
are using 
an ImageWriter 
printer. 

You need the 
LaserWriter 
resource and the 
Laser Prep 
file if you are 
using a LaserWriter 
printer. 

When you work with Ready,Set,Go! you can use text and graphiCS from other 
Macintosh applications. You can cut or copy text or graphics from almost 
every application to the Clipboard or Scrapbook and then paste it into your 
Ready,Set,Go! document. 

You can also use the Get Text command to get text from any text-only 
(ASCII) files or documents created with MacWrite 4.5, Microsoft Word 1.05 
or 3.0, or WriteNow! and put them directly into Ready,Set,Go! 

You can use the Get Picture command to get pictures directly from 
bitmapped graphics applications, like MacPaint and FullPaint; object­
oriented graphicS applications that use the PICT format , like MacDraw or 
MacDraft; high-resolution graphics applications that use EPSF 
(Encapsulated PostScript File Format), like Adobe Illustrator, Cricket Draw 
or Graph, or Letraset's Image Studio; and scanner software that uses TIFF 
(Tag Image File Format), like Image Studio or ThunderWare's Thunderscan. 
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Ready,Set,Go! comes w ith three ImageWriter fonts (Geneva, Chicago, and 
Monaco) and two LaserWriter fonts (Helvetica and Times), each in a 
number of point sizes, installed in the System file on the System Disk. 

You can install additional fonts if you like. If you are using an ImageWriter, 
you simply use the Font/ DA Mover on your Macintosh System Tools disk. 
The Font/ DA Mover installs screen fonts in your System file. Because the 
ImageWriter can reproduce any image on the screen, it can reproduce any 
screen font. 

The LaserWriter and other PostScript printers do not reproduce the fonts as 
they appear on the screen. Instead, they use a printer font, which is a set of 
instructions for creating the characters in any size in a particular font. The 
printer fonts for Helvetica, Times, Courier, and a symbol font are built into 
all PostScript printers, such as the LaserWriter. More fonts are built into the 
LaserWriter Plus. In addition, there are hundreds of other fonts you can buy 
for use with PostScript printers, but you must download them to your printer 
to use them. Downloadable fonts are transferred from your Macintosh to 
the internal memory in your PostScript printer. To use downloadable fonts, 
you install the screen fonts in your System file with the Font/ DA Mover and 
place copies of the printer fonts in your System Folder. See your Macintosh 
owner's guide and the manuals that come with your PostScript printer and 
downloadable fonts for more information. 

With Ready,Set,Go! version 4.0, you can open, work with , and save 
documents created with Ready,Set,Go! versions 2, 2.1, and 3. If you open a 
document created with an earlier version, Ready,Set,Go! converts it to the 
version 4.0 file format and opens it in a new, untitled document window. It 
is saved on your disk when you choose Save As the first time. The original 
file is left unchanged on your disk. 
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Available 
Memory 

When you are working with documents in Ready,Set,Gol each document i 
stored in the internal memory (RAM) of your Macintosh. Changes you 
make are stored on your disk only when you choose Save or Save As, so it i 
important to save your changes often. 

The size and number of documents you can work with at one time are limited 
only by the available internal memory in your Macintosh. A dialog box will 
alert you if you try to open too many-or too large---documents. 
Ready,Set,Go! works perfectly with application managers like the Switcher, 
but you can ensure that the greatest amount of internal memory is available 
for your Ready,Set,Go! documents by not using such applications, which 
use more memory than is necessary to run Ready,Set,Go! alone. It is also a 
good idea to turn off the RAM Cache in the Control Panel, especially on a 
Macintosh 512K enhanced. See "Desk Accessories" in this chapter for more 
information. 

You can also manage the amount of available internal memory by adj'jsting 
these items: 

• the number of windows open on the desktop 

• the number of pages in a document 

• the amount of text and graphics on a page 

• the number of stylesheets in a document 

• the number and length of glossaries in a document 

• the number of entries in the User Dictionary 

• the number of entries in the Hyphenation Exceptions file 

If you do not have enough memory for a document, you can divide the 
document into smaller files , remove unnecessary fonts from the System 
file, and remove all desk accessories except the Chooser and Control Panel 
from the System file. If you need to work with very large documents, you 
may increase your internal memory with a memory expansion card. 
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If you are working on a network, you can store Ready,Set,Go! documents on 
a shared disk or folder, but each person must work with his or her own 
purchased copy of Ready,Set,Go! You can contact Letraset for information 
on obtaining a site-licensing agreement for your company. 

Multiple persons can open and work with copies of an individual 
Ready,Set,Go! document at a time. If you try to open a document that is 
already open on the network, Ready,Set,Go! informs you that a copy of that 
document will be opened instead. 
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The Desktop 
The Document 

Window 

The Menu Bar 

The Ready,Set,Go! desktop appears on your screen when you open the 
Ready,Set,Go! application. It is the area where you work. 

Menu bar 

Page 
scroll bar 

Tool bar 

Windows 

At the top of the desktop is the menu bar. The menu bar contains the titles of 
the menus from which you choose commands. 

A window with an untitled document appears when you open Ready,Set,Go! 
Each document window has its own tool bar and page scroll bar just below 
its title bar. You can open as many document windows as the available 
memory in your Macintosh allows. You can even open copies of the same 
document and view different parts of it. See the Open and Save commands 
in "The File Menu" in this chapter for important information about working 
with multiple copies of the same document. 

One window is always the active window. You make a window active by 
clicking in it. You move a window by dragging the title bar, and you change 
its size by dragging the size box or clicking the zoom box. You close a 
window by clicking the close box or choosing Close from the File menu . 
You scroll the contents of the window to see any part of a page that's not 
visible. When you name a document with the Save As command, its name 
appears in the title bar of the window. For more on working with windows, 
see "The Windows" in Chapter 3. 
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Below the title bar of every window is a tool bar. The tool bar contains the 
tools you use to create and work with objects on pages in that window. There 
are two types of tools: selection pointers and tools for creating objects. 

When you work outside the page area in a window, the pointer is an arrow. 
You can use this pointer to select a tool from the tool bar. When you select a 
tool and move the pointer inside the page area, the pointer changes shape 
to indicate the tool you are using. Selection pointers take the shape they 
have in the tool bar. Tools for creating objects turn into crossbars. Each 
tool has a "hot spot" where things happen. For example, the tip of the 
object pointer must be touching an object to select it. The center point of 
the crossbar is where an object appears when you start to drag. The selected 
tool is always highlighted in the tool bar. 
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The Page Scroll 
Bar 

The Document 
Page 

Every document window has a page scroll bar to the right of the tool bar. 
The page scroll bar has page icons, which display the number and order of 
pages in the document. The numbers correspond to numbers on the pages 
only if you number the pages consecutively beginning with page 1. 
Otherwise, they refer only to the order of the pages in the document. Two 
icons at the left side of the page scroll bar represent the left and right master 
pages. 

The icon of the current page is highlighted. If you are working with facing 
pages, the icons of both current pages are highlighted. You can click a page 
icon to display that page. If the document has more pages than fit in the 
bar, you can use the arrows to scroll the page icons to find the page you 
want. 

A document may have as many pages as the internal memory available in 
your Macintosh allows. Normally, one page appears in a document window 
at a time. However, you can also display and work with two facing pages. 
You choose the size of the page and its orientation- whether it's upright or 
sideways-with the Page Setup command. You can insert, delete, and 
duplicate the pages of the document. 

On each page of a document, you create objects. There are three kinds of 
objects; text blocks are areas where you enter text; picture blocks are areas 
where you insert pictures; and graphic objects are shapes such as 
rectangles, ovals, and lines. You can change the size of objects and copy, 
move, stack, align, and lock them. See "Working With Objects" in 
Chapter 3 for more information. 
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Each window has one ruler at the top and one along the left side. You can 
use these to position objects you create on a page. The rulers measure 
across and down the page, starting at the upper left comer of the window. 
Dotted lines move along the rulers as you move the pointer and show the 
position of the pointer's "hot spot. " The preset unit of measure for the 
rulers is inches. You can change it to centimeters or picas and points with 
the Preferences command. You can also hide the rulers or change their 
starting point. See "The Grid" in Chapter 3 for more information on 
working with rulers. 

The print area defined by your printer creates an unchanging margin for 
every page of the document. The printer cannot print in this margin, even 
though you can place objects there on the screen, or cross it with a line or 
another object. This margin is marked by a dotted line around the edge of 
each page. The dotted line does not appear if you select Tiling with the Page 
Setup command or deselect Show Print Area with the Preferences 
command. 

You create a visual margin on the page by aligning objects. You can use a 
grid to help you with this task. 
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The Grid 

Master Pages 

You can select one of eight preset grids or design your own custom grid 
when you work with a document. The grid appears as dotted lines on the 
page, forming one or more rectangles in columns and rows. You use these 
as guidelines for creating and aligning objects on each page. 

When you select or define your grid with the Design Grids command, it is 
automatically activated. Objects that you draw "snap" to fit the rectangles in 
the grid. If you want to draw objects that don't fit the grid, you can turn the 
grid off with the Snap To command. You can also hide the grid with the 
Preferences command. The grid is never active when it's hidden. 

See "Designing a Document" in Chapter 3 for information on working with 
grids . 

Each document has a left and right master page. The left master page 
corresponds to all the left, or even-numbered, pages in the document. The 
right master page corresponds to all the right, or odd-numbered, pages. 
Any object that appears on a master page-such as a running head, a page 
number, or column divider rules-appears on the corresponding left or 
right pages of the document. You cannot remove an individual master page 
element from a document page. You can turn off the master pages for 
individual document pages with the Use Master command. See "To Set Up 
Master Pages" in Chapter 3. 
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Ready,Set,Go! has eleven menus in its menu bar. These contain the 
Ready,Set,Go! commands. When a menu title is dimmed, you can't use any 
of the commands in that menu. You can't choose an individual command 
when it is dimmed. 

When you choose a command followed by ellipses (.. .), a dialog box or a 
window prompts you for more information. Sometimes a dialog box asks 
you to confirm the operation you are about to perform. You click OK or Yes 
to confirm the command and any information you've entered in the dialog 
box or window. If you click Cancel---or the close box in a window-to cancel 
the command, Ready,Set,Go! returns to where you were when you chose the 
command and does not change either your document or the information 
that was originally in the dialog box. 

You can perform some commands from the keyboard with Command-key 
equivalents. You hold down the Command key while you press the 
appropriate key, and Ready,Set,Go! performs the command as if you had 
chosen it from the menu. For a list of Command-key equivalents, see 
"Shortcuts" at the end of this chapter. 

The Apple menu has information about Ready,Set,Go! and contains the 
desk accessories that are installed in the System file on your working copy of 
the Ready,Set,Go! System Disk. 

About Ready,Set,Go! 
Shows the Ready,Set,Gol version number and copyright information. It 
also shows the amount of internal memory (RAM) that's available as you 
work. 

Desk Accessories 
Desk accessories are applications that you can run without quitting 
Ready,Set,Go! When you choose a desk accessory, it may appear in a 
window that becomes the active window. It may also add a new menu to the 
menu bar, from which you can choose commands. 
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You can use any of the commands in the menu bar while a desk accessory is 
open. They affect the document in the window that was active before you 
chose the desk accessory. The exceptions are some of the commands in the 
File and Edit menus. You can use these commands to close a desk accessory 
and to cut, copy, or paste a selection from a desk accessory to a document. 

The System file that comes with Ready,Set,Go! includes six desk 
accessories: Alarm Clock, Chooser, Control Panel , Key Caps, Note Pad, 
and Scrapbook. Of these, four are particularly important as you work with 
Ready,Set,Go! 

• Chooser is used to select the printer you want to use to print documents. 
You can choose the Print command from the File menu to see which printer 
is currently selected. When you choose the Chooser from the Apple menu, 
a window displays icons for the types of printers that are available. When 
you select an icon, it lists the names of the printers that are available. 

If you change the type of printer, you must choose Page Setup before you 
print so Ready,Set,Go! can adjust the print area. It is also a good idea to 
verify the size of paper with Printer Setup at this time. 

If you select a LaserWriter, the AppleTalk option must be selected. 

If you've installed other software in your System file, such as print spooling 
or file serving software, check the user's guide that came with the software to 
see how it affects the Chooser. 

• Control Panel controls a number of system options. For example, you 
can use it to adjust the time and date , the desktop pattern, or the speed at 
which the pointer moves on the screen when you move the mouse. See your 
Macintosh owner's guide for more information about each option. 

The most important option for users of Ready,Set,Go! is the RAM Cache. 
Ready,Set,Go! stores each document you are working with in internal 
memory (RAM), so the size and number of documents you can work with at 
one time are limited by the amount of internal memory available . Because 
the RAM Cache also uses internal memory, it 's a good idea to turn it off 
when using Ready,Set,Go!-especially on a Macintosh 512K enhanced. 
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• Key Caps displays your keyboard and labels the keys with the characters 
in the current font. It also adds a Key Caps menu, which lists the same 
screen fonts that appear in the Ready,Set,Go! Font menu. You can preview 
a font by choosing it from the Key Caps menu. Press the Shift and Option 
keys, alone or in combination, to see the special characters in the current 
font. 

Characters you type or click while Key Caps is open appear in a box at the 
top of the Key Caps window. You can cut and paste the contents of the box 
into your document. This is a quiCk way to find a special character and use it 
in your document. 

• Scrapbook is used for copying text or graphics. It's particularly useful if 
you want to copy and paste several items from a document created in 
another application to a document in Ready,Set,Go! or if you want to paste 
the same text or objects into different Ready,Set,Go! documents. You use 
the Scrapbook's scroll bar to display the item you want to use and choose 
Cut or Copy. Close the Scrapbook and use the insertion pointer to select an 
insertion point for text or the cropping tool to select a picture block. Then 
choose the Paste command. 

The File menu contains commands that you use to work with the documents 
stored on your disks. You use some of these commands to open, save, 
print, and close Ready,Set,Go! documents. You use others to get text or 
pictures from other kinds of documents or to set up the printed page. You 
also quit Ready,Set,Go! from the File menu. 

New 
Opens a new, untitled document. You can open as many new documents as 
the internal memory available in your Macintosh allows. A dialog box alerts 
you if you try to open too many. Each document appears in a new window. 

Op.en ... 
Opens an existing Ready,Set,Go! document. You select the document in a 
dialog box that lists the Ready,Set,Go! documents. Another dialog box 
alerts you if you try to open more documents than the internal memory in 
your Macintosh allows. 

REF ERE NeE 

The Menus 

The File Menu 

ImI 
New ilCN 
Open ... ilCO 
Close ilCW 
Soue ilCS 
Soue As .. . 
Page Setup .. . 
Printer Setup ... 
Print.. . 
Get leHt .. . 
Put leHt .. . 
Get Picture ... 
Quit ilCQ 

156/ REFERENCE 

• Key Caps displays your keyboard and labels the keys with the characters 
in the current font. It also adds a Key Caps menu, which lists the same 
screen fonts that appear in the Ready,Set,Go! Font menu. You can preview 
a font by choosing it from the Key Caps menu. Press the Shift and Option 
keys, alone or in combination, to see the special characters in the current 
font. 

Characters you type or click while Key Caps is open appear in a box at the 
top of the Key Caps window. You can cut and paste the contents of the box 
into your document. This is a quiCk way to find a special character and use it 
in your document. 

• Scrapbook is used for copying text or graphics. It's particularly useful if 
you want to copy and paste several items from a document created in 
another application to a document in Ready,Set,Go! or if you want to paste 
the same text or objects into different Ready,Set,Go! documents. You use 
the Scrapbook's scroll bar to display the item you want to use and choose 
Cut or Copy. Close the Scrapbook and use the insertion pointer to select an 
insertion point for text or the cropping tool to select a picture block. Then 
choose the Paste command. 

The File menu contains commands that you use to work with the documents 
stored on your disks. You use some of these commands to open, save, 
print, and close Ready,Set,Go! documents. You use others to get text or 
pictures from other kinds of documents or to set up the printed page. You 
also quit Ready,Set,Go! from the File menu. 

New 
Opens a new, untitled document. You can open as many new documents as 
the internal memory available in your Macintosh allows. A dialog box alerts 
you if you try to open too many. Each document appears in a new window. 

Op.en ... 
Opens an existing Ready,Set,Go! document. You select the document in a 
dialog box that lists the Ready,Set,Go! documents. Another dialog box 
alerts you if you try to open more documents than the internal memory in 
your Macintosh allows. 



If your disk uses the hierarchical file system, the dialog box lists a directory 
of documents and folders on the current disk. You can open a folder to view 
a directory of the documents and folders stored in it. When you do, the 
name of the current folder appears above the directory. Press the current 
folder name to see a list of the folders and disk that contain the current 
folder. You can drag down the list to select anyone of these folders or the 
disk to view the directory of documents and folders it contains. 

If your disk does not use the hierarchical file system, the dialog box lists all 
the Ready,Set,Go! documents on the current disk. 

Clicking Eject ejects the current disk so you can insert another disk and view 
or open its folders and documents. Clicking Drive displays the documents 
and folders on another available disk. (Pressing Tab is the same as clicking 
Drive.) 

Clicking the Open button in the dialog box opens the selected folder or 
document. You can also double-click a folder or document to open it. 
When a document opens, it opens to the page you were working on when 
you last saved it. 

You can open more than one copy of the same document. Each copy you 
opeh becomes a different version of the document. The first copy you open 
is the "original." You cannot save other copies with the same name in the 
same folder while the original is open. If you close the original and then 
save a copy with the same name, the copy replaces the original. See the 
Save command in this chapter for additional details. 

You can also open documents created with earlier versions of 
Ready,Set,Go! See "Earlier Versions of Ready,Set,Go!" in this chapter for 
more information. 
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Close 
Closes the active window on the desktop. The active window may be either a 
desk accessory or a Ready,Set,Go! document window. The command is 
dimmed if no document is open. 

If you have made changes in the document in the active window without 
saving them, a dialog box asks you if you want to save them before you close 
the window. If you click Yes, the changes are saved before the document 
closes. If you have not already saved the document, you can give it a name 
before you save it. See the Save and Save As commands in this chapter for 
more information. If you click No, the document closes and the changes are 
not saved. 

Save 
Saves the current version of the document in the active window and replaces 
the version on the disk with the same name. The command is dimmed if you 
haven't named the document with the Save As command, if you haven't 
made any changes to the document since you last saved it, or if no 
document is open. 

If you have opened more than one copy of the document, the first copy you 
opened is the "original. " You cannot save other copies with the same name 
in the same folder as the original while the original is open. Ready,Set,Go! 
displays the Save As dialog box and automatically enters the name of the 
original document preceded by "Copy of. " You can save the copy with this 
name or type a new name. 

.- ' 
CAUTION! If you close the original and then save a copy of it with the 
same name, Ready,Set,Go! does not prompt you for a different name. It 
simply warns you that you are replacing the original with the copy. 

.... 

.- ... 

---
-- ~-

- ~ 

....,. 
~ 
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Save As ... 
Saves an untitled document with a name you specify. You can also use the 
Save As command to create a new version of the document with a new name 
or in a new place. The command is dimmed if no document is open. 

A dialog box prompts you for the name of the document. The name may be 
up to 31 characters long. You may use any character except a colon O. To 
save both the current and the old versions of a document, type a new name 
or open a folder or disk that doesn't contain a document with the same 
name. If you try to save the current version in a folder or on a disk that has a 
document or folder with the same name, a dialog box asks if you want to 
replace the document on the disk. Clicking Yes replaces it. Clicking No 
returns you to the Save As dialog box. 

If your disk uses the hierarchical file system, the dialog box lists a directory 
of both documents and folders on the current disk. You can double-click a 
folder to open it and view the documents and folders it contains. When you 
do, the name of the current folder appears above the directory of its 
contents. You can click the folder name and drag to show the hierarchy of 
open folders on the disk. Press the current folder name to see a list of the 
folders and disk that contain the current folder. You can drag down the list 
to select anyone of these folders or the disk to view the directory of 
documents and folders it contains. When you click Save, the document is 
saved with the name you typed in the current folder. 

If your disk does not use the hierarchical file system, the Save As dialog box 
lists a directory of all the Ready,Set,Go! documents on the current disk and 
displays the name of the disk above the directory. When you click Save, the 
document is saved with the name you typed on the disk. 

Clicking Drive displays the documents and folders on another available 
disk. (Pressing Tab is the same as clicking Drive.) Clicking Eject ejects the 
current disk so you can insert another disk and save the document on it. 
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Page Setup .•. 
Specifies the size and orientation of pages. You can also use the Page Setup 
command to create a very large page from several smaller sections called 
"tiles." The Page Setup command is dimmed if no document is open. 

A dialog box lists five standard page sizes: US Letter (8.5 by 11 inches), US 
Legal (8.5 by 14 inches) , Tabloid (11 by 17 inches) , A4 Letter (8.27 by 11.69 
inches), and B5 Letter (6.93 by 9.84 inches). You can also click the Other 
option to specify any width and depth of page you want, up to 99 by 99 
inches. If you select any of the standard page sizes except Tabloid, your 
selection is automatically selected in the Printer Setup dialog box. The 
preset size is US Letter. 

Each page size has a standard print area , which is the maximum area that 
can be printed on the page size you have selected. A dotted line marks the 
outline of the print area of each page in the document window unless you 
specify Tiling or deselect Show Print Area with the Preferences command. 

You can choose two page orientations: the regular upright orientation or a 
sideways orientation. 

If the page size is larger than the paper size, you can divide the page into 
tiles, print them, and then paste them together by hand. When you click 
Tiling, you can specify the tile overlap-that is, the portion of the image 
that overlaps from tile to tile. The preset overlap is 1 inch. You can also 
print registration marks when tiling. These are useful for aligning the tiles. 

When you change any of these options, Ready,Set,Go! changes them on the 
screen. If you are using a custom grid, the margins remain the same, but the 
print area may change and you may have to adjust the grid. Objects on a 
page keep their same size and relative position. 

CAUTION! If you specify a smaller page size, objects that appeared on a 
larger page may no longer be visible. Before you select new options with 
Page Setup, remember to shift objects so you will be able to see them. 

See "The Page" in Chapter 3 for more about changing page size and 
orientation. 
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Printer Setup ••• 
Specifies paper size and orientation and special printing effects, such as 
reducing or enlarging, font substitution, and treatment of bit maps. The 
command is dimmed if no document is open. 

The dialog box that appears corresponds to the printer selected with the 
Chooser. The paper sizes for the LaserWriter are US Letter (8.5 by 11 
inches), US Legal (8.5 by 14 inches), A4 Letter (8.27 by 11.69 inches), and 
B5 Letter (6.93 by 9.84 inches). The sizes for the ImageWriter are US Letter, 
US Legal, Computer Paper, A4 Letter, and International Fanfold. For either 
printer, you can choose to print with a regular upright orientation or a 
sideways orientation on the page. 

If you have a LaserWriter, you can enlarge the page up to 400 percent or 
reduce it to as small as 25 percent. Ready,Set,Go! automatically substitutes 
printer fonts for screen fonts when you print. If you don't want 
Ready,Set,Go! to substitute LaserWriter fonts for ImageWriter font or for 
screen fonts for which you don't have LaserWriter fonts, turn off Font 
Substitution. You can also select a number of other options, including some 
that affect the treatment of bitmapped text and graphics. See the owner's 
guide that came with your printer for details. 

If you have an ImageWriter, you should specify Tall Adjusted to correct 
distortion of graphics. You can also specify 50% Reduction to print your 
pages at half size, and No Gaps Between Pages to eliminate the top and 
bottom margins on the printed pages. 

Clicking OK saves the setup options as part of the document. See "Printing" 
in Chapter 3 for more information. 
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Print ... 
Prints the current document according to the selected options. The 
command is dimmed if no document is open. 

The dialog box that appears corresponds to the printer selected with the 
Chooser. If you are using a LaserWriter, you can specify the number of 
copies and the range of pages you want to print. The preset options are one 
copy and all the pages. You can also include a cover page that lists 
information about your print job as a first or last page. The LaserWriter 
normally feeds paper automatically from the paper cassette. With the 
Manual Feed option, you can feed paper one sheet at a time. 

If you are using an ImageWriter, you can specify the number of copies and 
the range of pages you want to print. You can also choose one of the three 
print qualities: Best, Faster, and Draft. Best and Faster print exactly what is 
on your page. Draft prints only the text, and the ImageWriter substitutes its 
own font for any fonts you have specified on the page. The preset options 
are one copy of all the pages of the document, using automatic paper feed. 
If you have specified a 50 percent reduction with the Printer Setup 
command, the ImageWriter prints only at Best quality. 

Clicking OK starts printing. You can hold down the Command key and type 
a period (.) to stop printing. With the ImageWriter, you can stop printing 
only after it actually starts. 

See the owner's guide that came with your printer and "Printing" in 
Chapter 3 for more information. 
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Get Text ... 
Inserts the text from another document at the insertion point in a text block. 
The command is dimmed if no insertion point or text is selected in a text 
block. 

A dialog box appears with a directory of documents you can insert into 
Ready,Set,Go! You may need to click Drive or Eject, scroll the directory, or 
open and close folders to find the document you want. Select the name of 
the document and click Open or just double-click the name. See the Open 
command in this chapter for more information on this dialog box. 

The documents you can open are text-only (ASCII) files or documents 
created with MacWrite 4.5, Microsoft Word 1.05 or 3.0 (do not use Fast 
Save), or WriteNow! 

When you open a document, Ready,Set,Go! inserts it at the insertion point 
in the text block. If text is selected in the text block, the new text replaces the 
selected text. Text you get from a text-only file is inserted with any formats 
you specified at the insertion point. Text you get from a document created 
with a compatible application retains most of its formats, including style 
and size of fonts, tab stops, indents, alignment, and line spacing. If a font 
you specified when you created the document is not installed in the System 
file you are using with Ready,Set,Go! an available font will be substituted. 
See "To Get Text From Another Document" in Chapter 3 for more 
information . 

If you hold down the Option key when you choose Get Text, Ready,Set,Go! 
converts punctuation commonly used in word processing to the style used 
in typesetting. Two spaces are converted to one space, inch symbols (") are 
converted to double open or close quotation marks. (" and "), foot symbols 
(') are converted to single open or close quotation marks or apostrophes 
(' and '), and two hyphens in a row (--) are converted to an em dash (-). 
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Put Text ... 
Saves text from a text block or a chain of blocks in a Ready,Set,Go! 
document as a text-only (ASCII) file . This command saves all the text in the 
block or chain with an insertion point or text selected. The command is 
dimmed if no insertion point or text is selected. 

For a complete description of the dialog box you use to save text, see the 
Save As command in this section. 

After it's saved, you can open the file with any application that can open 
text-only files. 

Get Picture ... 
Inserts a graphics document created in another application in a picture 
block. You select the picture block by clicking in it with the cropping tool. 
The command is dimmed if no picture block is selected. 

A dialog box appears with a directory of documents you can insert into a 
picture block. You may need to click Drive or Eject, scroll the directory, or 
open and close folders to find the document you want. Select the name of 
the document and click Open or just double-click the name. See the Open 
command in this chapter for more information on this dialog box. You can 
open documents saved in the MacPaint, PICT, EPSF, or TIFF file formats. 
See "The Software" in this chapter for a list of compatible applications. 

When you open a graphics document, it's inserted in the picture block you 
selected with the cropping tool. The picture is usually centered in the 
picture block. If you don't see the picture, use the cropping tool to drag the 
picture until you do or temporarily enlarge the picture block. 

When you insert a MacPaint or PICT file in a picture block, it becomes part 
of your Ready,Set,Go! document and you no longer need the original 
graphics files to print it in Ready,Set,Go! However, when you insert a high­
resolution EPSF or TIFF file in a picture block, only the screen image 
becomes part of your Ready,Set,Go! document when you save it, and the 
original graphics document should be stored in the same folder as the 
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The Edit Menu 

Undo 3&2 

Cut 3&H 
Copy 3&C 
Paste 3&U 
Clear 

Select HII 3&H 
Duplicllte.. . 3&D 

LocI< 
~nlocl< 

Bring To Front 
Send Behind 

Speciflclltions... 3&1'1 

Ready,Set,Go! document you placed it in. When you print, Ready,Set,Go! 
remembers the name and location of any high-resolution graphic you 
placed in the document and uses the original file, with any cropping and 
scaling information, to print the picture on the page. If you rename the 
original graphics file, you must use the Get Picture command again. If 
Ready,Set,Go! can't find the original file , it prints the screen image 
instead. 

Quit 
Quits Ready,Set,Go! and returns you to the Finder. If you've made changes 
to any document on the desktop since you last saved it, a dialog box asks you 
if you want to save the changes. If you click Yes, the changes are saved 
before the document closes. (See the Save and Save As commands in this 
chapter for more information.) If you click No, the document closes and 
the changes are not saved. After the last document is closed, you return to 
the Finder. 

You use some of the commands in the Edit menu to cut, copy, and paste 
selected objects, text, and pictures. You use other commands to undo some 
operations; to select all the text in a text block or chain of blocks; to select 
all the objects on a page; or to duplicate, lock, unlock, or move objects in 
front or in back of one another. You can also specify the size, position, and 
other specifications of text blocks, picture blocks, and other objects on a 
page. 

Undo 
Restores text, pictures, or graphic objects that have been deleted with the 
Backspace key or with the Cut or Clear command. You must choose Undo 
immediately after you delete. Otherwise, the command is dimmed. 

Cut 
Removes the selected object, group of objects, text, or picture and places it 
on the Clipboard, replacing anything that is already on the Clipboard. 
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Copy 
Copies the selected object, group of objects, text, or picture and places it 
on the Clipboard, replacing anything that is already on the Clipboard. 

Paste 
Places a copy of the contents of the Clipboard on the page in the active 
window. The contents of the Clipboard may be text, a picture, or one or 
more objects. You can paste items you cut or copy in the same document or 
in another document. 

If the Clipboard contains text, you must select an insertion point or text in 
the text block where you want to paste it. 

If the Clipboard contains a picture, you must select the picture block (with 
or without a picture) with the cropping tool where you want to paste it. 

If the Clipboard contains one or more objects, you must select the object 
pointer before you paste. You can paste objects on any page in any 
document window. The objects are pasted on the current page in the same 
position (relative to the upper left corner) as on the page from which they 
were copied. If you copy and paste an object on the same page, the new 
copy appears on top of original and is selected. You can drag to move it. 

Clear 
Removes the selected object, group of objects, text, or picture without 
placing it on the Clipboard. You must choose Undo immediately to restore 
anything you clear aCCidentally. 

Select All 
Selects all the objects on a page (except master page objects) if the object 
pointer is selected. If an insertion point or text is selected, this command 
selects all the text in the text block or chain of linked blocks. 

If you want to select only the text in one block that is part of a chain, select 
an insertion point or text in that block and hold down the Option key while 
you choose Select All. 
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Duplicate ... 
Places the specified number of copies of a selected object or group of 
objects on the same page as the selection. You can specify the horizontal 
and vertical distance between the original and each copy. If no objects are 
selected, the Duplicate command is dimmed. . 

A dialog box prompts you for the number of copies and the horizontal and 
vertical offset for each copy. The preset offset is .25 inch to the right and 
below the original object or group. A negative offset moves the copy to the 
left of or above the original. You can also duplicate an object onto a facing 
page if you are working with facing pages. 

When you click OK, the specified copies are placed on the page or facing 
page and the copy farthest from the original is selected. 

Lock 
Locks the object or group of objects you select with the object pointer so you 
can't remove, move, or resize them. Objects you create are unlocked until 
you lock them. If no objects are selected, Lock is dimmed. 

Lock affects only objects. Text, pictures, line weights, and pen and fill 
patterns are not affected. You can copy and paste or duplicate locked 
objects, and the copies are also locked. You can also move locked objects 
in front or in back of other objects. 

If you select one or more locked objects, a check appears next to Lock in the 
Edit menu. If you select both locked and unlocked objects, no check 
appears in the menu. 

If you select a locked object and choose Specifications, an X appears in the 
Locked check box. See the Specifications command in this chapter for more 
information. 

Unlock 
Unlocks the object or group of objects you select with the object pointer. 
Objects you create are unlocked until you lock them. If no objects are 
selected, Unlock is dimmed. If you select one or more unlocked objects, a 
check appears next to Unlock in the Edit menu. 

THE MENUS/ 167 

Duplicate ... 
Places the specified number of copies of a selected object or group of 
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selected, the Duplicate command is dimmed. . 
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vertical offset for each copy. The preset offset is .25 inch to the right and 
below the original object or group. A negative offset moves the copy to the 
left of or above the original. You can also duplicate an object onto a facing 
page if you are working with facing pages. 

When you click OK, the specified copies are placed on the page or facing 
page and the copy farthest from the original is selected. 

Lock 
Locks the object or group of objects you select with the object pointer so you 
can't remove, move, or resize them. Objects you create are unlocked until 
you lock them. If no objects are selected, Lock is dimmed. 

Lock affects only objects. Text, pictures, line weights, and pen and fill 
patterns are not affected. You can copy and paste or duplicate locked 
objects, and the copies are also locked. You can also move locked objects 
in front or in back of other objects. 

If you select one or more locked objects, a check appears next to Lock in the 
Edit menu. If you select both locked and unlocked objects, no check 
appears in the menu. 

If you select a locked object and choose Specifications, an X appears in the 
Locked check box. See the Specifications command in this chapter for more 
information. 

Unlock 
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Objects you create are unlocked until you lock them. If no objects are 
selected, Unlock is dimmed. If you select one or more unlocked objects, a 
check appears next to Unlock in the Edit menu. 
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Bring To Front 
Places one or more locked or unlocked objects you select in front of any 
unselected objects they overlap. This command is dimmed if no objects are 
selected. 

Send Behind 
Places one or more locked or unlocked objects you select behind any 
unselected objects they overlap. This command is dimmed if no objects are 
selected. 

Specifications ... 
Specifies the position and size of a selected text block, picture block, or 
graphic object in the units of measure you choose with the Preferences 
command. It also specifies other options for the selected object. 

A different dialog box appears for each type of object. All of them define 
the size and position of the object by specifying the starting location, 
measured from the upper left corner of the page (regardless of ruler 
positions). For most objects, you specify the width and depth. For 
horizontal lines, you specify only the width. For vertical lines, you specify 
only the depth. For diagonal lines, you specify ending location, measured 
from the upper left corner of the page . 

All the specifications dialog boxes also include options for locking the 
object (see the Lock command in this chapter) and for specifying a text 
runaround. When you specify a text runaround, any text that overlaps the 
object runs around the object and you can specify the text repel distance­
the distance between the text and the ohject. You can also select the Don't 
Print option, which you can use to drop out objects to be printed in a 
different color. 

• Text Block Specifications include three special options: Ignore 
Runarounds, White Type, and PostScript. If you select Ignore Runarounds, 
text in the selected text block does not run around objects, even if you 
specify runarounds for those objects. You can use the White Type option to 
display white type on top of objects filled with black or a pattern. This 
option is effective only if you fill the text block with a dark pattern as well. If 
you select PostScript, any text in the selected text block is interpreted as a 
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PostScript program by a PostScript printer-such as the LaserWriter. This 
option is useful for creating special logo characters, for example. 
Ready,Set,Go! does not check for errors , so make sure your program is 
perfect before you print. 

• Picture Block Specifications include special options for scaling a 
picture and running text around either the frame of the picture block or the 
graphic image inside the picture block. You can change the scale across and 
the scale down the picture independently . 

• Rounded Rectangle Specifications include a width and depth you 
can specify for the curves at their corners. 

The Font menu contains the fonts you use for displaying and printing text. 
The Ready,Set,Go! System file contains three ImageWriter fonts (Chicago, 
Geneva, and Monaco) and two LaserWriter fonts (Helvetica and Times), 
each in several sizes. The menu is dimmed if no insertion point or text is 
selected . 

The preset font is Geneva. The current font at the insertion point or for 
selected text is checked in the menu. If the selected text uses more than one 
font, no font is checked. 

When you insert text in existing text by selecting an insertion point or text 
and then typing, by getting text from a text-only (ASCII) document with the 
Get Text command, or by pasting text from the Clipboard, the text uses the 
current font selected for the insertion point or selection. When you insert 
formatted text with the Get Text command, it uses the same fonts as in the 
original if they are installed in the System file you are using with 
Ready,Set,Go! Otherwise, an available font is substituted. 

You can use the Font/ DA Mover to add screen fonts to your System file or to 
remove them. See "The Software" in this chapter for information about 
screen and printer fonts . 
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The Style menu contains type styles and sizes you use for displaying or 
printing text. The menu is dimmed if no insertion point or text is selected. 

Font Styles 
The Style menu contains nine styles: Plain, Bold, Italic , Underline, 
Outline, Shadow, Condense, Extend, and Overstrike. You can combine 
most of these styles for a variety of effects. 

The preset style is Plain. You can choose one or more other styles. When 
you do, any text you type at the insertion point or in place of selected text 
appears in those styles. The current styles are checked in the menu. If the 
selected text uses more than one combination of styles, no style is checked 
in the menu . 

Extend and Condense are opposite styles. If you choose one, it cancels the 
other. If you choose Plain, all styles except Plain are canceled. 

When you insert new text, it uses styles according to the same rules as it uses 
fonts. See "The Font Menu" in this chapter for more information. 

Type Sizes 
The Style menu contains seven point sizes. It also includes the Other 
command, which you can use to specify any size from 1 to 255 points. 

The preset size is 12 Point. The current size for the insertion point or 
selected text is checked in the menu. If you choose the Other command, a 
dialog box prompts you for the point size you want. Other is checked if an 
unlisted size is specified. If the selected text uses more than one size, no size 
is checked. 

Each type size in each font has an automatic line spacing, which sets the 
distance in points from the baseline of the current line to the baseline of the 
line above. However, if two or more sizes appear in the same line, the line 
uses the spacing for the largest type size, increasing the space to the line 
above. See the Line Spacing command in this chapter for more 
information. 
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The Style menu contains type styles and sizes you use for displaying or 
printing text. The menu is dimmed if no insertion point or text is selected. 

Font Styles 
The Style menu contains nine styles: Plain, Bold, Italic , Underline, 
Outline, Shadow, Condense, Extend, and Overstrike. You can combine 
most of these styles for a variety of effects. 

The preset style is Plain. You can choose one or more other styles. When 
you do, any text you type at the insertion point or in place of selected text 
appears in those styles. The current styles are checked in the menu. If the 
selected text uses more than one combination of styles, no style is checked 
in the menu . 

Extend and Condense are opposite styles. If you choose one, it cancels the 
other. If you choose Plain, all styles except Plain are canceled. 

When you insert new text, it uses styles according to the same rules as it uses 
fonts. See "The Font Menu" in this chapter for more information. 

Type Sizes 
The Style menu contains seven point sizes. It also includes the Other 
command, which you can use to specify any size from 1 to 255 points. 

The preset size is 12 Point. The current size for the insertion point or 
selected text is checked in the menu. If you choose the Other command, a 
dialog box prompts you for the point size you want. Other is checked if an 
unlisted size is specified. If the selected text uses more than one size, no size 
is checked. 

Each type size in each font has an automatic line spacing, which sets the 
distance in points from the baseline of the current line to the baseline of the 
line above. However, if two or more sizes appear in the same line, the line 
uses the spacing for the largest type size, increasing the space to the line 
above. See the Line Spacing command in this chapter for more 
information. 



Sizes that appear in outline in the menu are installed in the System file and 
have the best screen appearance. The other sizes, including those you 
specify with the Other command, are created from the closest installed size 
by scaling it to a larger or smaller size. Scaled fonts may appear rough or 
illegible on screen. You can turn off font scaling with the Preferences 
command to make it easier to edit odd sizes, but be sure to turn it back on if 
you print with an ImageWriter. 

If you 're printing with the ImageWriter, the installed sizes produce the best 
result because the ImageWriter prints the fonts as they appear on your 
screen. With the LaserWriter, each size of a printer font is created inside the 
printer, with the same quality for each size. Therefore, a LaserWriter font in 
any size produces an excellent printing result, even if the screen appearance 
is ragged or if you have turned off font scaling. 

When you insert new text, it uses sizes according to the same rules as it uses 
fonts . See "The Font Menu" in this chapter for more information. 

You can use the Font/ DA Mover to add screen fonts of different sizes to your 
System file or to remove them. See "The Software" in this chapter for 
information about screen and printer fonts. 
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The Format menu contains commands for formatting any amount of 
selected text. These include commands for aligning lines of text, for 
altering word, line, and paragraph spacing, for indenting lines, and for 
changing the horizontal and vertical character spacing. The Format menu is 
dimmed if no insertion point or text is selected. 

The format of a line depends on the format commands that apply to the first 
character in the line. You can change the line's format by selecting the first 
character and choosing one of the commands that apply to lines from the 
Format menu. However, if you change the format of the first character only, 
the other individual characters in the line keep their original formats. If you 
then insert or delete text or if you resize the text block, the first character of 
the line may change and the line format changes accordingly. So it is a 
good idea to format whole paragraphs or at least whole lines, rather than 
just single characters. 

The first four commands in the Format menu are alignment commands. 
The one that applies to the selected insertion point or text is checked in the 
menu. If more than one alignment command applies to the selection, none 
is checked. When you choose one of the other Format commands, a dialog 
box lists the specifications for the selected insertion point or text. If there is 
more than one specification for the selection, no specification appears in 
the dialog box. 

If you are printing with a LaserWriter, you can improve the fit of lines and 
characters by selecting Use Fractional Widths with the Preferences 
command, even though the fit on the screen may actually appear to be 
worse. Because the ImageWriter prints lines as they appear on the screen, 
you get the best results if Use Fractional Widths is not selected. See the 
Preferences command in this chapter for more information. 

When you insert new text, it uses formats according to the same rules as 
fonts. See "The Font Menu" in this chapter for more information. 

Left 
Aligns selected lines to the left side of the -text block and leaves text ragged 
on the right. This is the preset alignment for every character. 
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The Format menu contains commands for formatting any amount of 
selected text. These include commands for aligning lines of text, for 
altering word, line, and paragraph spacing, for indenting lines, and for 
changing the horizontal and vertical character spacing. The Format menu is 
dimmed if no insertion point or text is selected. 

The format of a line depends on the format commands that apply to the first 
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the other individual characters in the line keep their original formats. If you 
then insert or delete text or if you resize the text block, the first character of 
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good idea to format whole paragraphs or at least whole lines, rather than 
just single characters. 

The first four commands in the Format menu are alignment commands. 
The one that applies to the selected insertion point or text is checked in the 
menu. If more than one alignment command applies to the selection, none 
is checked. When you choose one of the other Format commands, a dialog 
box lists the specifications for the selected insertion point or text. If there is 
more than one specification for the selection, no specification appears in 
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If you are printing with a LaserWriter, you can improve the fit of lines and 
characters by selecting Use Fractional Widths with the Preferences 
command, even though the fit on the screen may actually appear to be 
worse. Because the ImageWriter prints lines as they appear on the screen, 
you get the best results if Use Fractional Widths is not selected. See the 
Preferences command in this chapter for more information. 

When you insert new text, it uses formats according to the same rules as 
fonts. See "The Font Menu" in this chapter for more information. 

Left 
Aligns selected lines to the left side of the -text block and leaves text ragged 
on the right. This is the preset alignment for every character. 



Right 
Aligns selected lines to the right side of the text block and leaves text ragged 
on the left. 

Center 
Centers selected lines between the right and left sides of the text block, 
leaving the text ragged on the left and right. 

Justify 
Spaces words evenly so selected lines align to the left and right sides of the 
text block (except for the last line of each paragraph, which aligns only on 
the left). 

Word Spacing ... 
Specifies the percentage of normal space between selected words. The 
preset word spacing is normal, that is, 100 percent. ::: ch:~ o-\A \+ 

A dialog box prompts you for the percentage of normal word spacing you 
want. It may be any amount from a to 255 percent. This command is 
particularly useful to force justified text to fit in a fixed-size text block. 

Line Spacing ... 
SpeCifies the space between the baseline of the selected line and the 
baseline of the line above it. 

A dialog box prompts you for the spacing you want. It may be any amount 
_+--'~~~~~~=,~. The preset spacing is Auto. When you use automatic 

line spacing, Ready,Set,Go! determines the line spacing based on the 
largest font size in the line. Specify a number of points for line spacing if you 
want the line spacing to be consistent in a selected paragraph, even if more 
than one size of type occurs in it. You can type Auto in the dialog b ox to 
return any selection to automatic line spacing. 

-lyp.: A lA.1.0 
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Specifies the space, in addition to the specified line spacing, between the 
baseline of the first line in a paragraph and the baseline of the line above. 
Each paragraph may use different paragraph spacing, depending on the 
specification for the first character in the paragraph. 

A dialog box prompts you for the number of additional points between 
paragraphs you want. It may be any amount from 0 to 255 points. The preset 
spacing is 0 (zero) , which means there's no extra space and the paragraph 
spacing is identical to the line spacing. You can type a in the dialog box to 
return the paragraph spacing for any selection to its line spacing format . 

Paragraph Indent ... 
!b i~ de~o.v....\-\ r; 

Indents the first line of selected paragraphs from the left side of the text 
block. 

A dialog box prompts you for the amount you want to indent in the unit of 
measure that you select with the Preferences command. The preset indent is 
o (zero). Type a to cancel the indent for a selection. 

,\ • 4 
Left Indent... f-I~a v!£:""~\ Vl3 
Indents every selected line, except the first line in a paragraph, from the left 
side of a text block. See "Paragraph Indent" in this chapter to indent the first 
line in a paragraph. 

A dialog box prompts you for the amount you want to indent in the unit of 
measure that you select with the Preferences command. You can use this 
command to create a hanging indent. The preset indent is 0 (zero) . .h~O 

to cancel the indent for a selection. 

Right Indent ... 
Indents every selected line from the right side of a text block. 

A dialog box prompts you for the amount you want to indent in the unit of 
measure that you select with the Preferences command. The preset indent is 
o (zero). Tvoe a to cancel the indent for a §election. 
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Specifies the space, in addition to the specified line spacing, between the 
baseline of the first line in a paragraph and the baseline of the line above. 
Each paragraph may use different paragraph spacing, depending on the 
specification for the first character in the paragraph. 

A dialog box prompts you for the number of additional points between 
paragraphs you want. It may be any amount from 0 to 255 points. The preset 
spacing is 0 (zero) , which means there's no extra space and the paragraph 
spacing is identical to the line spacing. You can type a in the dialog box to 
return the paragraph spacing for any selection to its line spacing format . 

Paragraph Indent ... 
!b i~ de~o.v....\-\ r; 

Indents the first line of selected paragraphs from the left side of the text 
block. 

A dialog box prompts you for the amount you want to indent in the unit of 
measure that you select with the Preferences command. The preset indent is 
o (zero). Type a to cancel the indent for a selection. 

,\ • 4 
Left Indent... f-I~a v!£:""~\ Vl3 
Indents every selected line, except the first line in a paragraph, from the left 
side of a text block. See "Paragraph Indent" in this chapter to indent the first 
line in a paragraph. 

A dialog box prompts you for the amount you want to indent in the unit of 
measure that you select with the Preferences command. You can use this 
command to create a hanging indent. The preset indent is 0 (zero) . .h~O 

to cancel the indent for a selection. 

Right Indent ... 
Indents every selected line from the right side of a text block. 

A dialog box prompts you for the amount you want to indent in the unit of 
measure that you select with the Preferences command. The preset indent is 
o (zero). Tvoe a to cancel the indent for a §election. 



Kern ~ niG""C:- I ~S1-~' 
Automatically reduces the space between pairs of characters in text you 
select. The right character of each pair shifts to the left. If no text or 
insertion point is selected, the command is dimmed. 

This command affects only LaserWriter fonts and only those pairs of 
characters that are included in a special table of pairs that can be kerned. 
(This table is stored with the fonts .) Because the Macintosh screen allows 
kerning only in I-point increments, kerning is effective only for headlines 
and other places where large type sizes are used. 

You can kern any characters or specify the amount of kerning by holding 
down the Option key when you choose the Kern command. A dialog box 
prompts you for the number of points you want to remove between each 
pair of characters in text you select. 

If you select only one character when you choose Kern, the dialog box 
appears whether you hold down the Option key or not. The selected 
character shifts to the left the number of po ints you specify. 

If you select an insertion point and choose Kern , each character you type 
after the insertion point is shifted to the left the number of points you 
specify in the dialog box. 

The preset number of points in the dialog box is 0 (zero) , which means the 
spacing between the characters is the same as when you type them without 
kerning. If you select text that has been letterspaced or with characters 
kerned different amounts , no amount will appear in the dialog box. You can 
type 0 in the dialog box to return any selection to its normal character 
spacing. 

You can also hold down the Command key and press the Left Arrow key to 
shift each selected character to the lefr- Each time you press the Left Arrow 
key, each character shifts one point. The amount of kerning is displayed in 
the dialog box if you hold down the Qp-tion key'" while you select the text and 
choose the Kern command. 
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L tt \)IO'V-e.. \'i \.o~v-v1- ~ e erspace... ..J' (\ / 
Adds space between selected characters. When letterspaced, each selected 
character shifts to the right. If no text or insertion point is selected, the 
command is dimmed. 

A dialog box prompts you for the number of points you want to add between 
each pair of characters in the text you select. You use this dialog box the 
same way you use the Kern dialog box. See "Kern" in this chapter for more 
information. 

You can also hold down the Command key and press the Right Arrow key 
once for each point you want to shift each selected character to the right. 
The number of points you shift each character appears in the dialog box if 
you select the text and choose Letterspace. 

Shift Up... mO\Je tAp l' 
Shifts selected characters up from their normal baseline. 

A dialog box prompts you for the number of points you want to shift the 
selected characters. 

The preset shift is 0 (zero). If you select text that has been shifted down or 
with characters shifted up different amounts, no amount will appear in the 
dialog box. You can type a in the dialog box to return selected characters to 
their normal baseline, or you can choose the Baseline command. 

The Shift Up command changes the spacing between lines unless you 
specify a specific number of points with the Line Spacing command. 

You can also hold down the Command key and press the Up Arrow key once 
for each point you want to shift the selected text up. The number of points 
you shifted the selected text appears in the dialog box if you choose Shift 
Up. 
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The Text Menu 

Find NeHt :!!:F 
Replace ..• 
Replace NeHt :!!:R 

",Hyphenation On 
Hyphenation Off 
Hyphenation Spec • .. . 

Tabs ... :!!:T 
Type Specs.. . :!!:Y 
Styles... :!!:H 
Remooe Style. 
Glossaries... :!!:G 

Check Spelling :!!:K 
Suggest Spelling... :!!:J 
Rdd Word :!!:l 

Shift Down ... 
Shifts selecfed characters down from their normal baseline. 

A dialog box prompts you for the number of points you want to shift the 
selected characters. You use this dialog box the same way you use the Shift 
Up dialog box. 

You can also hold down the Command key and press the Down Arrow key 
once for each point you want to shift the selected text down. The number of 
points you shifted the selected text appears in the dialog box if you choose 
Shift Down. 

¢ 
Returns all selected characters to their normal baseline, canceling the effect 
of the Shift-Up or Shift Down command. 

The Text menu offers special features for working with text. You can use the 
commands in this menu to find and replace text and styles of type, choose 
hyphenation options, set tabs , set up type specifications, define and use 
style sheets and glossaries, and check your spelling. 

Find ... 
Searches for specified text in a text block or chain of linked blocks, starting 
after the insertion point or selected text, for text specifications such as a 
font, style, or size of type you specify, or for a combination of text and text 
specifications. If no text or insertion point is selected, the command is 
dimmed. 

When you choose Find, a window prompts you for the text you want to find 
and some search options. You can type any text, up to 255 characters . 
except a return or tab character. Type the text, including punctuation . 
exactly as you want to search for it. If you select text before you choose the 
Find command, the selected text appears in the Find What box in the 
window. 
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You can use special symbols to find tabs, returns, and other characters that 
you can't type or that are invisible. Each symbol is a combination of two 
characters: a lowercase Greek delta Ca) and another letter. You type the 
delta by holding down the Option key and typing d. Type at in the dialog 
box to find a tab character, ar or an to find a return, aa to find the Apple 
character, ae to find a check mark, am to find the command Cor propeller) 
character, or ad to find the diamond character. 

Before you stalt the search, select the search options you want. You can 
search for text that matches the uppercase and lowercase characters you 
type, or you can ignore case. You can also search only the current text block 
or the entire chain. The preset options are to ignore uppercase and 
lowercase characters and to search an entire chain. 

Tf VOll hold down the OPtion key while you choose eu2, an expanded 
window appears. Here you can. specify the font, style, and sjze of type you 
wish to find , as well as text and the search options. You can specify all or 
only one of these options. Options you don't specify-for example, by 
making sure all the style options are not checked-will be ignored. If you 
don't enter any text, you can find evelY occurrence of the font, style, or size 
you specify, regardless of the text itself. 

Clicking OK begins the search. When the specified text is found , it is 
selected. The Find window closes, and you can edit the text. A message tells 
you if Ready,Set,Go! does not find the text or if it finds the text in a text 
overflow that's not visible in the block or chain. 

Find Next 
Searches for the next occurrence of text, font, style, size of type, and other 
options you last specified in the Find window, starting after the current 
insertion point or text selection . 

If you choose this command after Ready,Set,Go! has found the last 
occurrence in the block or chain, a message tells you that there are no more 
occurrences or that the text was found in a text overflow that's not visible. 
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Replace ... 
Searches fo r specified text in a text block, a chain of linked blocks, or the 
entire document, and replaces it with text that you type. It begins searching 
after the insertion point or text you select. You can also find and replace a 
font, style , or size of type you specify. 

A window prompts you for the text you want to replace and the text you want 
to change it to. The rules for typing this text and for special characters are 
the same as those in the Find window. See "Find" in this chapter for more 
information. 

Before you start the search, select the search options you want. You can 
select whether you want to find and replace text that matches the uppercase 
and lowercase characters you type, or to ignore case. You can select 
whether you want to find and replace the text only in the current text block, 
in all the blocks it is linked to in a chain, or throughout the whole document. 
You can also select whether you want to replace the single next occurrence 
of the text or every occurrence. The preset options are to ignore uppercase 
and lowercase characters, to search an entire chain, and to replace only the 
next occurrence. If no insertion point or text is selected, the only option is 
to find and replace every occurrence of the text throughout the entire 
document. 

_+-.J.J-p..Lu..J.J.>Ll.\.L.l.£L.u..LL.ll.!'"'--'4LU>..!ll.~Y'-while you choose Replace, an expanded 
window appears where you can specify a font, style, or size of type, as well as 
what text you wish to replace and what to change it to, and the search 
options. The rules for selecting type styles and text are the same as for the 
Find window. See "Find" in this chapter for more information. 

Clicking OK begins the search. When the specified text is found, it is 
replaced with the replacement text, which is then selected. The Replace 
window closes, and you can edit the text. A message tells you if 
Ready,Set,Go! does not find the text or if it finds the text in a text overflow 
that's not visible in the block, chain, or document. 
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Replace Next 
Searches for and replaces the single next occurrence of the text, font, style, 
size of type, and any options you last specified in the Replace window, 
starting after the current insertion point or text selection. 

If you choose this command after Ready,Set,Go! has found the last 
occurrence in the block or chain, a message tells you that there are no more 
occurrences or that the text was found in a text overflow that's not visible. 

Hyphenation On 
Automatically hyphenates words at the end of lines in text you select or text 
you type or insert from another document after the inse rtion po int. 
Ready,Set,Go! uses a set of rules to perform hyphenation. You can modify 
some of these hyphenation specifications and create a list of words that are 
exceptions with the Hyphenation Specs command. See "Hyphenation 
Specs" in this chapter for more information. 

Hyphenation is always on when you first create a text block and select an 
insertion po int. You can turn it off or on for any amount of selected text in a 
text block. This command is checked in the Text menu if hyphenation is on 
for the selected text. If hyphenation is on for some characters but off for 
others in a selection, no check appears in the menu. 

When you insert new text in existing text, hyphenation follows the same 
rules as fonts. See "The Font Menu" in this chapter for more information. 

Hyphenation Off 
Turns automatic hyphenation off for text you select or text you type or insert 
after the insertion point. You can turn hyphenation off for any character or 
group of characters. For example, you can select a single word that you 
don't want to hyphenate and choose Hyphenation Off. This command is 
checked in the Text menu if hyphenation is off for the selected text. If 
hyphenation is on for some characters but off for others in a selection , no 
check appears in the menu. 

When you insert new text in existing text, hyphenation follows the same 
rules as fonts . See "The Font Menu" in this chapter for more information. 
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Hyphenation Off 
Turns automatic hyphenation off for text you select or text you type or insert 
after the insertion point. You can turn hyphenation off for any character or 
group of characters. For example, you can select a single word that you 
don't want to hyphenate and choose Hyphenation Off. This command is 
checked in the Text menu if hyphenation is off for the selected text. If 
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Hyphenation Specs ... 
Allows you to view, alter, and add to the list of words you want 
Ready,Set,Go! to hyphenate differently than it does on its own. You can 
also change some of the hyphenation specifications in the current 
document. If no document is open, Hyphenation Specs is dimmed in the 
menu. 

When you choose Hyphenation Specs, a window appears with a list of 
hyphenation exceptions you create on the left side and the current 
hyphenation specifications on the right. 

• Hyphenation Exceptions is a list of words you can create that you want 
Ready,Set,Go! automatically to hyphenate differently than it does 
normally. The list is saved in a file called Hyphenation Exceptions that is 
stored in the same place on the Application Disk as the Ready,Set,Go' 
application. Ready,Set,Go! uses this list for every document you work in. 

Type the words you want to add to the list of exceptions one at a time in the 
box below the scrolling list of words in the Hyphenation Specs window. 
Type hyphens in the word where you want Ready,Set,Go! to hyphenate it. 
Type the word with no hyphens if you want it never to be hyphenated. 
Ready,Set,Go! ignores uppercase and lowercase characters when it uses 
your list. After you type each word, click Insert Word. The word is added to 
the scrolling list of exceptions in alphabetical order. You can also remove 
words from the list by selecting them in the list and clicking Delete Word. 
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• Hyphenation Specifications by which Ready,Set,Go! hyphenates 
automatically are displayed on the right side of the Hyphenation Specs 
window. The specifications apply only to the current document. You can 
type new specifications for the minimum size of a word for which 
hyphenation is allowed (preset at 5 characters), the minimum number of 
characters allowed before and after a hyphen (both preset at 2 characters), 
and the maximum number of lines in a row that are allowed to end in a 
hyphen (preset at 3 lines). You can deselect Break Last Word Of Paragraph 
to prevent a part of an automatically hyphenated word from being the only 
thing on the last line of a paragraph. You can also deselect Break 
Capitalized Words to prevent words that start with a capital letter from being 
hyphenated. Ready,Set,Go! will not automatically hyphenate a word if the 
rules you select will be broken. 

Click Done to confirm your hyphenation specifications. 

Tabs ... 
Allows you to specify the number and kind of tab stops for text you select or 
text you type or insert after the insertion point. You can specify up to ten tab 
stops for a selection. You can also specify a character to be repeated as a 

-r--t-"--c.,,"-'o_\_e::_d_._E!A ______ f--!le~a~d,,£e~r~t~o~a~t~ab~s~top. If no text or insertion point is selected, Tabs is dimmed 
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in the menu . 

A window appears with a ruler where you position tab stops for text you 
selected. The ruler measures the distance from the left edge of the text block 
in the units of measure you speCified with the Preferences command. You 
can click the arrows on either side of the ruler to scroll into view the portions 
of the ruler that don't fit in the window. 

Any tab stops already set for the selected text appear in gray above the ruler. 
If you click on an existing tab stop, it becomes black to show it is selected. 
Only one tab stop can be selected at a time. The selected tab stop's indent, 
measure, leader character (if any), and the position of the decimal point if 
it is a decimal tab are displayed in the current units of measure at the top of 
the window. 
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_______ -+-_Wh-"-=-=-e::.;:n---'-'~..:.c=:clic.;:ck~on the ruler where you want to set a tab stop, two 
overlapping arrows and a small icon to their left appear above the ruler in 
black. The larger arrow indicates the tab stop's indent from the left edge of 
the text block, the smaller arrow indicates its measure (or width) , and the 
small icon indicates whether it is a left, right, centered, justified, or decimal 
tab stop. When you first create a tab stop, it is left-aligning with no measure. 
Decimal tab stops also have an up-pointing arrowhead which indicates the 
alignment of the decimal point. You can also click the Specs button to 
display a dialog box where you can specify precisely the indent, measure, 
and decimal alignment by typing in the current units of measure. You can 
also specify any character to be repeated as a leader from where you type a 
tab character to the tab stop's position. 

You can drag any active tab stop out of the box around the ruler to remove 
it. If you click Clear All, all tab stops are removed for the selected text. 

Click OK to set the tab stops you have created or changed for the selected 
text. Click Cancel to restore any tab stops that were set before you chose 
Tabs. 

When you type a tab character, the insertion point moves to the indent you 
set for the first or next tab stop with the Tabs command. If no tab stops are 
set for the insertion point or selected text, the insertion point moves 8 
points to the right. 

Type Specs ••• 
Allows you to set up type and formatting specifications for text you select or 
text you type or insert after the insertion pont. If no text or insertion point is 
selected, Type Specs is dimmed in the menu. 

A window appears in which you can choose most of the type and formatting 
specifications that also appear in the Format and Text menus. You can 
select one or all of the options for each specification in the window. 
Options you specify are applied to your selection in the text block. Options 
you don't specify will be ignored, and selected text will retain its existing 
specifications for those options. See. the equivalent individual menu 
commands in this chapter for more information about each option. 
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You can click Apply, and drag the window out of the way if you need to, to 
see the effects of the type and formatting options you have specified on the 
selected text without closing the window. You can also click OK to apply 
your specifications and close the window. Click Cancel to close the window 
and leave the current specifications for selected text or the insertion point 
unchanged. 

Styles .•• 
Allows you to set up, add, modify, use, and delete stylesheets for your 
current document. Stylesheets are preset type and formatting specifications 
you can apply to text you select or text you type or insert after an insertion 
point. It also allows you to import stylesheets you created in another 
document so you can use them in your current document. 

A window appears with a scrolling list of the stylesheets in the current 
document. 

Click New to create a new stylesheet. The Style Specifications window 
appears where YOll can name the new stylesheet and specify the type and 
formatting specifications you want from many options. Type the name for 
the new stylesheet in the Style Name box. Then select the options you want 
for the stylesheet. The current specifications for any text or insertion point 
you selected are preset in the window. You select the options you want in the 
same way you do with the Type Specs command. See Type Specs in this 
chapter for more information. If you do not specify one of the type or 
formatting options, text you apply the style sheet to will keep its original 
specifications for that option. Click OK to save the stylesheet with the name 
and options you specified. Its name is added to the list in the Styles window. 

You can modify an existing stylesheet by selecting its name from the list in 
the Styles window and clicking Modify. The Style Specifications window 
appears displaying the current name and type and formatting options for 
the style sheet. Make any changes to the name or specifications you wish and 
click OK. Any text you formatted with the stylesheet will be automatically 
updated with the new options you specify. Click Cancel to restore the 
original name and specifications for the style sheet. 
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You can format text you select or text you type or insert after the insertion 
point with the type and format specifications you selected in a stylesheet. 
Select the stylesheet you want to use and click Apply in the Styles window. 
The options for type and formats you specified in the stylesheet are applied 
to the selection. The selected text retains its current formats for any type 
and formatting options you did not specify for the stylesheet. 

You can add copies of stylesheets you created in another document to the 
list in the current document. Click ImpOlt in the Styles window, and a dialog 
box appears listing Ready,Set,Go! documents on the current disk. See the 
Open command in this chapter for information on this dialog box. The 
names of any stylesheets in the document you select are added to the list in 
the Styles window. If an imported stylesheet has the same name as an 
existing stylesheet in the list, a period and the number 1 (.1) are appended 
to the added name. You can modify, apply, duplicate, or delete the 
stylesheets you import just as you can the ones you create in the current 
document. 

Often it is easier to modify an existing stylesheet than to create a stylesheet 
from scratch. Select the name of the style sheet you want to modify without 
losing the original from the list in the Styles window and click Duplicate. 
The stylesheet you select is duplicated, a period and the number 1 (.1) are 
appended to the original name, and the new name is added to the list. Then 
you can modify or delete the duplicate as you would any other stylesheet in 
the list. 

You can delete any style sheet from the current document by selecting its 
name in the list in the Styles window and clicking Delete. Click OK in the 
dialog box that appears to warn you about what you are dOing, or click 
Cancel if you clicked Delete accidentally. When you click OK, the stylesheet 
is deleted and its name is removed from the list. 
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You can create a character shortcut for any style sheet by adding a slash ( / ) 
and any character you can type to the end of its name. Then you can apply 
the stylesheet to any selected text or insertion point by holding down the 
Command key and typing H and then qUickly typing the character you 
assigned to the stylesheet. The style sheet is applied to your selection without 
opening the Styles window. 

If you format text with a stylesheet, you cannot use commands from the 
menus to change any of the type or formatting options you specified in the 
stylesheet you used, though type or formatting options you didn't specify in 
the stylesheet can be altered in this way. See "Remove Styles" in this chapter 
for more information. 

Remove Styles 
Allows you to use menu commands to modify the type and formatting of any 
selected text that was formatted with a stylesheet. Remove Styles does not 
alter the current formats of type you select. If you select text and choose 
Remove Styles, its formats are not altered if you modify the stylesheet you 
originally used to format it. If no text or insertion point is selected, this 
command is dimmed in the menu. 

Glossaries ••• 
Allows you to name, rename, and store frequently used text as a glossary 
and paste it at the insertion point in any text block. It also allows you to 
import glossaries you created in another document so you can use them in 
your current document. 

When you choose Glossaries, a window appears displaying a scrolling list of 
the glossaries for the current document. 

You define the text and type styles you want to save as a glossary by typing it 
in a text block, selecting it, and chOOSing the Glossaries command. Click 
Define in the Glossaries window, and a dialog box appears prompting you 
to type a name for the new glossary. Type the name and click OK, and the 
new glossary name is added to the list of glossaries for the current 
document. The new name is selected in the list, and the beginning of its 
contents is displayed at the bottom of the Glossaries window. 
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You can rename an existing glossary by selecting its name from the list in 
the Glossaries window and clicking Rename. A dialog box prompts you for 
the new name for the glossary. Type the new name and click OK, and the 
new name replaces the old one in the scrolling list. 

You can paste the contents of an existing glossary at the insertion point by 
selecting its name from the scrolling list in the Glossaries window and 
clicking Paste. 

You can add copies of glossaries you created in another document to the 
current document. You click Import in the Glossaries window, and a dialog 
box appears listing Ready,Set,Go! documents on the current disk. See the 
Open command in this chapter for information on this dialog box. The 
names of any glossaries in the document you select are added to the list in 
the Glossaries window. If an imported glossary has the same name as an 
existing glossary in the list, a period and the number 1 (.1) are appended to 
the added name. You can rename, paste, or delete the glossaries you 
import just as you can the ones you create in the current document. 

You can delete any glossary from the current document by selecting its 
name from the list in the Glossaries window and clicking Delete. Click OK in 
the dialog box that appears to warn you about what you are doing, or click 
Cancel if you clicked Delete accidentally. When you click OK, the glossary 
is deleted and its name is removed from the list. 

You can create a character shortcut for any glossary by adding a slash ( / ) 
and any character you can type to the end of its name. Then you can paste 
the glossary at the insertion point by holding down the Command key and 
typing G and then quickly typing the character you assigned to the glossary. 
The glossary is pasted at the insertion point without opening the Glossaries 
window. 
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Check Spelling 
Checks the spelling of each word from after the currently selected text or 
insertion point to the end of a text block or chain of linked blocks. This 
command is dimmed if no text or insertion point is selected or if the RSG 
Dictionary is not in the same folder as the Ready,Set,Go! application. 

Check Spelling compares each word to the spelling rules in the RSG 
Dictionary and the list of words in the User Dictionary-if you have created 
one and it is also in the same folder as the Ready,Set,Go! application. 
When Ready,Set,Go! finds a word that is misspelled or unknown, it stops the 
search and selects the word. You can then edit the word, ask for a suggested 
spelling, or add the word to the User Dictionary. See the Suggest Spelling 
and Add Word commands and "The Application Disk" in this chapter for 
more information. 

Choose Check Spelling again to continue the search. If no misspelled or 
unknown words are found, the current selection or insertion point stays 
selected. 

Suggest Spelling ... 
Allows you to view a list of spelling suggestions from the RSG Dictionary and 
User Dictionary for any word you select. This command is dimmed if no 
text or insertion point is selected or if the RSG Dictionary is not in the same 
folder as the Ready,Set,Go! application. 

If you have selected one entire word-and not any spaces or punctuation 
before or after it-a window appears with a scrolling list of suggested 
spellings for that word. The list is in alphabetical order, and the first word is 
selected in the list and in the box below it. You can select the correctly 
spelled word you want from the list and edit it in the box below the list to 
correct capitalization or make any other changes you want. 

If you click Replace, the word selected in the box below the list replaces the 
word you selected in the text block. If you click Cancel, no changes are 
made . 
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Add Word 
Allows you to add a word you select to a permanent file named User 
Dictionary. Ready,Set,Go! uses this dictionary as a supplement to the RSG 
Dictionary when you choose the Check Spelling and Suggest Spelling 
commands. This command is particularly useful for recording proper 
names and special terms that the RSG Dictionary doesn't recognize when 
you check spelling. The User Dictionary must be named User Dictionary 
and be in the same folder as the Ready,Set,Go! application. See "User 
Dictionary" in this chapter for more information. This command is 
dimmed if no text or insertion point is selected or if the RSG Dictionary is 
not in the same folder as the Ready,Set,Go! application. 

The Special menu has commands for working with single pages or facing 
pages (spreads) and selected objects in the active document window. With 
these commands, you can display a page or facing pages in different sizes. 
You can add or delete pages or spreads or go to a page you want. You can 
select your preferences for the current document for units of measure; 
screen displays of grids, rulers , the print area, and blocks; the display and 
treatment of screen fonts; and page numbering. You can set up grids and 
activate them. You can activate and deactivate the master pages. You can 
also align objects. 

Facing Pages 
Displays both the current page and its facing page in the active windows. 
You can work with facing pages exactly as you do with single pages and 
display them at any size you choose in the SpeCial menu . 

Working with facing pages is particularly useful if you are creating pages by 
the spread, as is done with many books and magazines. You can position 
any object so that it crosses from one page to the other and even run text 
around it on both pages. However, if you create spreads with objects that 
cross pages, you must stay in Facing Pages view as you work and print. If you 
return to a single-page view, those objects will only appear as part of the left 
page of each spread and you will lose both those objects and any 
runarounds on the right pages. Also, be aware that no object will print 
where it crosses the nonprinting area between the two pages' print areas 
unless you select Tiling with the Page Setup command. 
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If you have chosen Facing Pages just to view a spread in a document without 
objects that cross pages, you can choose this command again to view only 
one page in the active window at a time. This command is checked in the 
menu when facing pages are displayed. 

Size To Fit 
Reduces or enlarges a page or facing pages so that all of the page or pages fit 
in the active window, no matter what size the window is. The scroll bars are 
inactive because the entire page is always visible. This command is checked 
in the menu when it's chosen. 

Half Size 
Displays a page or facing pages at 50 percent of actual size. You can use the 
scroll bars to go to any part of the page or facing pages that isn't visible. 
This command is checked in the menu when it's chosen. 

75% Size 
Displays a page or facing pages at 75 percent of actual size. You can use the 
scroll bars to go to any part of the page or facing pages that isn't visible. 
This command is checked in the menu when it's chosen. 

Actual Size 
Displays a page or facing pages at the same size as they will print, as 
determined by the Page Setup and Printer Setup options. You can use the 
scroll bars to go to any part of the page or facing pages that isn't visible. 
This command is checked in the menu when it 's chosen. 

The first time you open a document, it displays a US Letter page (8.5 by 11 
inches) at its actual size. However, if you save a document with a different 
page· size or display size, it opens with the sizes you last saved. 

Double Size 
Displays a page or facing pages at 200 percent of actual size. You can use the 
scroll bars to go to any part of the page or facing pages that isn't visible. 
This command is checked in the menu when it's chosen. 
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This command is checked in the menu when it's chosen. 

Actual Size 
Displays a page or facing pages at the same size as they will print, as 
determined by the Page Setup and Printer Setup options. You can use the 
scroll bars to go to any part of the page or facing pages that isn't visible. 
This command is checked in the menu when it 's chosen. 

The first time you open a document, it displays a US Letter page (8.5 by 11 
inches) at its actual size. However, if you save a document with a different 
page· size or display size, it opens with the sizes you last saved. 

Double Size 
Displays a page or facing pages at 200 percent of actual size. You can use the 
scroll bars to go to any part of the page or facing pages that isn't visible. 
This command is checked in the menu when it's chosen. 



Insert Page(s) ••• 
Adds one or more pages before or after the current document page. You 
can't use this command if the current page is a master page. 

A dialog box prompts you for the number of pages you want to add. The 
number is limited only by the available memory in your Macintosh. (See 
"Available Memory" in this chapter for more information.) You can insert 
the page or pages before or after the current page, and they can be blank or 
duplicates of the current page. The preset options are 1 page, Insert After 
Current Page, and Insert Blank Page. 

If you click Duplicate Current Page, you can indicate how text blocks on the 
duplicate page should be linked. Only the text blocks themselves are 
duplicated, not any text in them. You click None if you don't want to link the 
text blocks. You click Local if you want to link the text blocks on the duplicate 
page to one another but not to blocks on other pages. You click Global if 
you want to link the text blocks to one another and to any linked blocks on 
the previous and following pages. 

Clicking OK inserts the speCified number of pages. The inserted page, or 
the first page in a group of inserted pages, becomes the current page in the 
window. Page numbers are reassigned, if necessary, in the page scroll bar. 
The master page objects that appear on an existing page may change if the 
page changes from an even-numbered page to an odd-numbered page (or 
vice versa) because you inserted pages. 

If you have facing pages displayed in the active window, this command 
changes to Insert Spreads in the menu. The dialog box then prompts you for 
the same options, but they apply to pairs of facing pages instead of single 
pages . 
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Delete Page(s) .•. 
Deletes a page or range of pages that you specify. You can't use this 
command if the current page is a master page. 

A dialog box displays the number of the current page (which is also the page 
selected in the page scroll bar) as the starting and ending page of the range 
to be deleted. You can change the range by typing the numbers of the first 
and last pages you want to delete. You delete one page by typing its number 
in both blanks. 

Clicking OK deletes the specified pages, and th~ page before the deleted 
page becomes the current page in the window. (If the first page is deleted, 
the following page becomes the current page.) Page numbers are 
reassigned, if necessary, in the page scroll bar. The master page objects 
that appear on an existing page may change if the page changes from an 
even-numbered page to an odd-numbered page (or vice versa) because you 
deleted pages. 

CAUTION! The page range you specify wjth Delete Page(s) refers to the 
order of the pages in your document, as displayed in the page scroll bar. If 
you have specified a starting page number other than 1 with the Preferences 
command, page numbers that appear on the pages will not be the same as 
their order m the document. 

Go To Page ••• 
Displays the page whose number you specify in the dialog box. This 
command is particularly useful if you are working with a long document and 
don't want to scroll the page scroll bar to find the icon with the page number 
you want. If you enter a number that's higher than any existing page, 
Ready,Set,Go! displays the last page in the document. You can't use this 
command to go to a master page. 
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Preferences ..• 
Allows you to preset your options for several of the features in 
Ready,Set,Go! These include the measurement scale; page numbering; 
screen displays of the grid, rulers, print area, and blocks; and the display 
and treatment of screen fonts. 

• Units of measure may be in inches, centimeters, or picas and points. 
This scale is used for the units of measure of the ruler on the page and in the 
Tabs window, and for measurements that you specify with commands in the 
File, Edit, Format, Text, and Special menus. The preset option is inches. 

• Starting Page Number is the number you assign to the first page of the 
document, which appears in the page scroll bar as page 1. You can insert 
the page number directly in a text block on any page of the document by 
holding down the Command, Option, and Shift keys while pressing the 3 
key. If you type the same thing on a master page, two number signs (##) 
appear and the page number is entered automatically on corresponding 
pages of the document. If the position of a page with automatic numbering 
is changed, the page number also changes to reflect the page's new 
position. 

• Show Grid, Show Rulers, Show Print Area, and Show Block 
Outlines display or hide these items in the window. When you first open a 
document, no grid is displayed. If you set up a grid with the Design Grids 
command, it is automatically displayed and active. You can hide it and 
make it inactive by deselecting the Show Grid option. If you select the Show 
Grid option, the last grid specified in the Design Grids dialog box appears. 

Every document window opens with rulers in the scale that you choose. You 
can deselect the Show ~uler option to hide the rulers in the active window. 
Select the Show Ruler option to show the rulers again. 

The portion of the page size you select with the Page Setup command on 
which your printer can print-the print area-is indicated on each page in a 
window by a dotted line. See the Page Setup command for more 
information. You can hide the dotted line that indicates the print area by 
deselecting Show Print Area. Select Show Print Area to show the dotted line 
again . 
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When you create a text or picture block, Ready,Set,Go! displays its outline 
on the page. Deselect the Show Block Outlines option to hide these 
outlines. Select Show Block Outlines to show them again . 

• Use Fractional Widths determines the number of characters that can 
fit on a line more precisely than it can by just using the bit map of each 
character in a screen font, but the screen display may not be as clear. Using 
this option also results in more perfect alignment of the right edges of 
justified lines when you print. Select Use Fractional Widths if you are 
printing with a LaserWriter to take advantage of this feature. If you are 
printing with an ImageWriter, do not select this option because the 
ImageWriter prints exactly what is displayed on the screen. This option has 
no effect on a Macintosh 512K . 

• Disable Font Scaling makes screen font sizes that are not installed in 
your System file easier to work with. Normally, the Macintosh creates a bit 
map for those sizes of fonts from a size that is installed, but these can be 
difficult or impossible to read, especially in small sizes. You can select the 
Disable Font Scaling option if you are printing with a LaserWriter. Odd sizes 
of fonts are displayed in a size that is installed in the System file, and 
character spacing and line fit are not altered. Do not select Disable Font 
Scaling if you are printing with an ImageWriter because it prints exactly what 
appears on the screen. This option has no effect on a Macintosh 512K. 

Snap To 
Activates or deactivates the grid if it is displayed. When the grid is active, 
new objects and objects you resize automatically "snap" to the nearest grid 
lines. Existing objects are not affected. The grid is active when the 
command is checked. 

The command is dimmed and the grid is inactive if no grid has been 
selected or defined in the Design Grids dialog box or if the Show Grids 
option in the Preferences dialog box is not selected. 
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Use Master 
Activates and deactivates the master page elements on the current page. 
Master page elements appear, and cannot be altered, on the corresponding 
pages of the document if Use Master is chosen. Choosing this command 
affects only the current page. The command is checked in the menu when 
the master pages are active for the current page. 

Design Grids ... 
Sets up a grid for the entire document. You can select one of eight preset 
grids or define one of your own. 

A dialog box displays the eight preset grid options. These use preset 
margins, rows, columns, and spacing between rows and columns. You can 
click a grid option and click OK to activate a grid and display it in the 
document window. If you choose Design Grids, click Grid Setup, and then 
click OK, the Grid Setup dialog box displays the preset specifications for the 
active grid. 

You can also create your own custom grid by clicking Grid Setup, clicking 
OK, and typing your own specifications in the Grid Setup dialog box. The 
specifications use the units of measure you select with the Preferences 
command. 

Most publications are printed on both sides of each sheet of paper, so 
Double Sided is preset in the Grid Setup dialog box. This allows you to set 
margins for the inside-nearest the binding-and outside of each page, 
which switches depending on whether you are viewing a right or a left page. 
Deselect Double Sided if your publication will be printed on only one side 
of each sheet of paper. The Inside and Outside margin specifications 
change to Left and Right, because the inside is on the left on every page. 
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Clicking OK activates the grid and displays it in the document window. The 
Show Grid option in the Preferences dialog box is selected, and the Snap To 
command is automatically checked. 

If the page size on the screen changes because you change the Page Size or 
Printer Setup options, the grid specifications do not change, but the grid 
rectangles change size to accommodate the change. If the grid extends 
beyond the print area and is active, objects that you create may snap into a 
position beyond the print area and will not print. It's best to specify the grid 
again. 
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Alignment ... 
Aligns selected objects vertically, horizontally, or both, along their sides or 
center axis, depending on the options you select in the dialog box. This 
command is dimmed unless two or more objects are selected. Locked 
objects are not affected by this command. 
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If you click Left Sides or Right Sides, objects move to align with the side of 
the object that's farthest to the left or right. If you click Tops or Bottoms, 
objects move to align with the edge of the object that's nearest the top or 
bottom of the page. If you click VR Centers or T/ B Centers, Ready,Set,Go! 
calculates a vertical or horizontal center "line" along which it aligns the 
objects. 
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The Fill menu contains 52 patterns that you can choose to fill the area inside 
text blocks, rectangles, rounded rectangles, or ovals. The chosen pattern 
immediately fills one of these objects when you create it. You can also 
change an object's fill pattern at any time by selecting it and choosing a new 
pattern from the menu. See "The Lines Menu" and "The Pen Menu" in this 
chapter if you want to change the borders of objects. 

When you start Ready,Set,Go! the preset pattern is None, which is 
transparent. If an object filled with None overlaps a text block, you can see 
the text through it. 

The Fill menu includes black, white, and no (transparent) patterns; 
horizontal , vertical, and diagonal stripe patterns in varying widths; some 
standard Macintosh patterns; and nine shades of gray. 

The Lines menu contains styles and thicknesses for the lines and borders of 
the graphic objects you draw. The current line for a selected object is 
checked in the menu. The preset line style and thickness is an unbroken 
line, 1 point thick. 

The Thin line is a hairline, only 1/ 4 point thick. Only a high-resolution 
printer-such as a PostScript phototypesetter-can print that fine a line. On 
the LaserWriter, the Thin line will print a bit thicker than 1/ 4 point. On an 
ImageWriter, the Thin line will print at the same thickness as the I-point 
line. The Thin line and the I-point line appear to be the same thickness on 
the screen because the dots .on the screen are only 1 point square. 
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The Pen Menu The Pen menu contains 52 patterns that you can choose as patterns for lines 
and the borders of rectangles, rounded rectangles, and ovals. The patterns 
are the same as in the Fill menu. The chosen pattern appears immediately 
as the line or border pattern when you draw these objects. You can change 
the pattern of an object's border at any time by selecting the object and 
choosing a new pattern from the Pen menu. Changing the border of a 
rectangle, rounded rectangle, or oval does not change its fill pattern, which 
you change with the Fill menu. 

Some patterns-such as None, white, or those with widely spaced dots or 
lines-may produce an invisible line or border. If so, you can use the object 
pointer to drag in the area where the object has disappeared. The selection 
handles then appear, and you can choose another pattern from the Pen 
menu if you want. 
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Command·N opens a new Ready,Set,Go! document. 

Command·O opens the Open dialog box. You can then select an existing 
Ready,Set,Go! document to open. 

Command·Q quits Ready,Set,Go! 

Command·S saves the version of the document in the active window, 
replacing the version on the disk. 

Command·W closes the active window. 

Command·. opens the Design Grids dialog box. You can then select a 
standard grid. Or you can click Grid Setup and then click OK to design your 
own grid. 

Command·E displays facing pages in the currently selected view. For a 
complete view of facing pages, press Command-E followed by 
Command-I. 

Command·1 displays the current page to fit in the window. 

Command·2 displays the current page at half its actual size. 

Command·3 displays the current page at 75 percent of its actual size. 

Command-4 displays the current page at its actual size. 

Command·S displays the current page at double its actual size. 

Command.Optlon·Shlft·3 inserts the page number of the current page at 
the insertion point. On a master page, the placeholder is ##. 

Command.Optlon·Shlft.4 inserts the page number of the page 
preceding the current page at the insertion point. On a master page, the 
placeholder is $$ . 

.. 



Command-Option-ShiH-5 inserts the page number of the page after the 
current page at the insertion point. On a master page, the placeholder is 
%%. 

Command-Option-Shift-6 inserts at the insertion point the page number 
of the page on which the text block before the current text block in a chain 
occurs. On a master page, the placeholder is "". 

Command-Optlon-Shlft-7 inserts at the insertion point the page number 
of the page on which the text block after the current text block in a chain 
occurs. On a master page, the placeholder is &&. 

Command-Option-ShiH-a inserts the total number of pages in the 
current document at the insertion point. 

Option + Drag turns the selected tool into the hand tool for moving the 
page around in the window (unless the insertion pointer is selected). The 
tool returns to normal when you release the mouse button. 
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Command-A selects all the objects (except master-page objects) on the 
current page if the object pointer is selected. 

Command-C places a copy of the selected object or group of objects on 
the Clipboard. 

Command-D opens the Duplicate dialog box. You can then specify the 
number of duplicates you want to make and the horizontal and vertical 
offset. 

Command-M opens a Specifications dialog box for each selected object. 

Command-V pastes objects from the Clipboard onto the current page in 
the same position as on the page from which they were cut or copied. 

Command-X removes a selected object or group of objects from the page 
and places it on the Clipboard. 

Command-Z restores objects that you 've just deleted with the Backspace 
key or the Cut or Clear command. Also restores the size or position of an 
object you just resized or moved with the object pointer. 

Shape Tool + Shift constrains rectangles to squares, ovals to circles, and 
diagonal lines to 45-degree angles. 

Linking Tool + Shift + Click adds a text block you Shift-click in before 
the text block you just clicked in in a chain of blocks. 

Linking Tool + Command-Shift + Click splits a chain of text blocks 
into two chains and makes the text block you Command-Shift-click in the 
first block in the new chain. 

Linking Tool + Option-Shift + Click adds a chain of blocks whose first 
text block you Option-Shift-click in to another chain of blocks whose first 
block you just clicked in. 



Selecting Text Command-A selects all the text in a text block (or chain of linked blocks) 
with an insertion point or selected text. 

Command-Opt ion-A selects all the text in a text block with an insertion 
point or selected text, but not the text in any linked text blocks. 

Insertion Pointer + Double-click selects an entire word and the space 
that follows it. Drag to select additional words, one at a time. 

Insertion Pointer + Command + Double-click selects an entire word 
without the space that follows it. Drag to select additional words, one at a 
time . 

Insertion Pointer + Click Three Times selects an entire line. Drag to 
select additional lines, one at a time. 

Insertion Pointer + Click Four Times selects an entire paragraph. 
Drag to select additional paragraphs, one at a time. 

Insertion Pointer + Drag Across Linked Blocks selects all the text 
from the insertion point in the first block to the place where you stop 
dragging in another text block on the same or facing page. 

Insertion Pointer + Shift + Click selects all the text in the same or 
linked text block from the current insertion point to the place where you 
Shift-click. 
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Command·B displays selected text or text that you type after the insertion 
point in bold style. If it's already bold, this key combination cancels the 
bold style. 

Command·C places a copy of the selected text on the Clipboard. 

Command·F finds the next occurrence of the text you last specified in the 
Find dialog box. 

Command·. displays selected text or text that you type after the insertion 
point in italic style. If it's already italic, this key combination cancels the 
italic style. 

Command· .. opens the Suggest Spelling window. You can then select one 
of the suggested spellings for the selected word or type the correct spelling. 

Command·K checks the spelling from the insertion point to the end of the 
text block or chain of linked blocks. 

Command·L adds the selected word to the User Dictionary that 
Ready,Set,Go! checks when you choose the Check Spelling command. 

Command·P displays the selected text or text you type after the insertion 
point in plain style. 

Command·R finds the next occurrence of the search text you last specified 
in the Replace window and replaces it with the replacement text. 

Command· T opens the Tabs window if text or an insertion point is 
selected. You can then set tabs for the current selection. 

Command·U displays the selected text or text you type after the insertion 
point in underline style. If it's already underlined, this key combination 
cancels the underline style. 

Command·V pastes text in the Clipboard at the insertion point in a text 
block or replaces selected text with the text on the Clipboard. 



Using 
Glossaries and 

Stylesheets 

Entering Date 
and Time 

Command·X removes selected text from the text block and places it on the 
Clipboard. 

COl'f'lmand.Y opens the Type SpecifiCations window. You can then set up 
type specifications for selected text or text you type after the insertion point. 

Command·Z restores text that you've just deleted with the Backspace key or 
the Cut or Clear command. . 

Command·G displays the Glossaries Window. You can then create a new 
glossary, or apply, modify, or import an existing glossary. 

Command·G + Glossary Character inserts the glossary aSSigned to the 
character you type at the insertion point. 

Command·H displays the Styles window. You can then create a new 
stylesheet, or apply, modify, or import an existing stylesheet. 

Command·H + Stylesheet Character displays the selected text or text 
you type after the insertion point according to the type specifications 
defined for the stylesheet assigned to the character you type. 

Command·G + t enters the current time in the hours and minutes (such as 
12:15 PM) at the insertion point in a text block. 

Command·G + T enters the current time in hours, minutes, and seconds 
(such as 12:15:45 PM) at the insertion point in a text block. 

Command·G + d enters the current date in the format month/day/ year at 
the insertion point in a text block. 

Command·G + D enters the current date as a complete date (such as 
Saturday, September 26, 1987) at the insertion point in a text block. 

Command·G + Option-d enters the complete date in abbreviated form 
(such as Sat, Sep 26, 1987) at the insertion point in a text block. 
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Glossary 
Application Disk: The Ready,Set,Go! disk that contains the application, 
an Example folder , and the Hyphenation Exceptions and User Dictionary 
fil e s. 

Baseline: An imaginary line on which the bottom of most uppercase 
letters rests. 

Camera-ready: Art or text copy that is ready to be photographed for 
re productio n . 

Clipboard: The place where copied or cut text o r graphics is stored. You 
can use the Clipboard to paste text or graphics into a Ready,Set,Go! 
document. 

Desk accessory: An application that you can open from the Apple menu 
when you 're in Ready,Set,Go! The Chooser and the Scrapbook are 
examples of desk accessories. 

Desktop: The work area on a Macintosh screen on which you arrange the 
windows you work in. 

Dialog box: A request for more information in oraer to complete a 
command . 

Document: Anything you create with a Macintosh application. You can 
create documents in Ready,Set,Go! or import them from other 
applica tion s. 

Font: A set of letters, numbers, and other characters w ith a consistent look 
and size. Ready,Set,Go! comes with three ImageWriter fonts (Geneva, 
Chicago, and Monaco) and two LaserWriter fonts (Helvetica and Times). 

Glossary: Text you use repeatedly in Ready,Set,Go! that you name and 
store in a list. You can insert a glossary anywhere in a document. 

Graphic object: An object that you d raw directly on a Ready,Set,Go! 
page with one of the shape tools. It can be a line , a rectangle , a rounded 
rectangle , or an oval, and you can give its interio r or border a pattern . A 
graphic object is a type of Read y,Set,Go' object. 
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Grid: A non printing pattern of rectangles on your page that helps you lay 
out your objects. You can activate the grid so that objects you draw "snap" 
to fit the rectangles, or you can turn the grid off and just use its rectangles as 
guidelines for placing the objects yourself. 

Hanging indent: An indent of the second and any following lines of text 
in a paragraph to the right of the beginning of the first line. Also the 
alignment of subsequent lines with the first word of an item in a list. 

Hierarchical file system: A system for storing files on disks that uses 
folders to organize your material. A folder can hold documents, 
applications, and other folders. You open a folder just as you open a 
document-by double-clicking its name in a dialog box. 

Insertion point: The place in a text block where text will be added. You 
select it with the insertion pointer. An insertion point looks like a blinking 
vertical line. 

Kern: To reduce the space between two characters . 

Letterspace: To add space between two characters. 

Link: To join text blocks in a "chain" so that the text flows from one block 
to another. If you alter the text in one linked block, the other blocks w ill be 
adjusted automatically. 

Margin: The white space surrounding the art and text on your page. 

Master page: A page that contains all the repeating elements-such as 
running heads- for the pages in your document. You have a master page 
for both your left pages and your right pages. 

Object: What you draw on your Ready,Set,Go! page. There are three types 
of objects: text blocks, picture blocks , and graphic objects. 

Pica: Twelve points, or about 1/ 6 of an inch. The pica is a publishing unit 
of measure for size and distances of text and art within a page . 
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Picture block: A place on your page where you put a picture. A picture 
block is a type of Ready,Set,Go! object. 

Point: There are 12 points in a pica and about 72 points in an inch. The 
point is a publishing unit of measure. 

Reverse: Light-colored type or graphics on a dark-colored background. 

Stylesheet: In Ready,Set,Go! a combination of font, type style, type size, 
and formats that you define, give a name to, and store in a list. You can 
apply a preset style to any selected text in a document. 

System Disk: The Ready,Set,Go! disk that contains the system software 
necessary to start up your Macintosh and the resources to print with the 
ImageWriter and LaserWriter printers. 

Text block: A place on your page where you put text. A text block is a type 
of Ready,Set,Go! object. 

Text runaround: The flow of text around a picture, a graphic object, or 
other text on a page. 

Tile: A section of a printed page. You use tiles when the page you're 
printing is larger than the paper your printer can handle. You print the 
sections separately and paste them together. 

Window: An area on the desktop that contains a document page. You can 
have as many windows open as the internal memory in your Macintosh 
allows, but only one window at a time-the front one-is active. 
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Index 
A 
About Ready,Set,Go! command (Apple menu) , 154 
activating windows, 48 
Actual Size command (Special menu), 22- 23, 51 , 190 
adding 

page numbers, 63 
pages, 22-23,60 
text blocks, 89 
to User Dictionary, 121 

Add Word command (Text menu), 120, 121 , 189 
Adobe Illustrator, 145 
aligning 

objects , 77 
text, 93 

alignment, 9, 102 
Alignment command (Special menu), 77, 197 
apostrophe, ]63 
Apple menu, 154-156 

About Ready,Set,Go! command, 154 
Calculator, 155 
Chooser, 36-37, 136, 147, 155 
Control Panel, 147, 155 
Key Caps, 155, 156 
Note Pad, 155 
Scrapbook, 83, 128-129, 131 , 145, 155, 156 

Application Disk, 16-17, 44, 142-143, 144 
applications, 145. See also specific application 
arrow keys , 94 , 95 , 96 
Article file , 28-29 
ASCII docume nts. See text-only (ASCII) documents 

B 
Backspace key, 73, 86, 91 , 131 
Baseline command (Format menu) , 96, 177 
baseline , defined, 96 
blank pages, 60 
Boilerplates file, 32-33 
boilerplate . See glossaries 
Bold command (Style menu) , 170 
border pattern, changing, 126 
Bring To Front command (Edit menu), 76, 168 
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C 
Calculator (Apple menu), 155 
case , 104-105, 106-107, 118 
center alignment (tab stops), 102-103 
Center command (Format menu), 93, 173 
centimeters, 21, 57. See also Preferences command 
chain of blocks. See text blocks 
characters. See text 
character spacing, 9 
checking spelling, 120-121 
Check Spelling command (Text menu), 120, 188 
Chicago font , 146 
Chooser (Apple menu), 36-37, 136, 147, 155 
circles. See graphic objects; shape tools 
Clear command (Edit menu), 73, 86, 91 , 131, 166 
Clipboard, 70, 73, 83, 86, 90 , 128-129, 131 , 145 
close box, 48 
Close command (File menu), 158 
closing windows, 48 

shortcuts , 200 
columns (text) , 26-27 
Command key 

selecting text with, 85 
unlinking linked text blocks with, 91 
windows and, 48 
See also shortcuts 

commands, 2-3, 154. See also specific command 
Condense command (Style menu), 170 
Control Panel CApple menu), 147, 155 
Copy command (Edit menu) , 70, 83, 90, 128-129, 

131 , 166 
copying 

documents , 83-84 
linked text blocks, 90 
objects, 70 
pictures, 128-129, 131 

Courier font , 146 
Cricket Draw, 145 
Cricket Graph, 145 
cropping pictures , 130 
cropping tool , 24-25, 128- 129, 130, 150 
custom grids, 56 
Cut command (Edit menu), 70, 73, 86, 90 , 91 , 128-

129, 131 , 165 

Index 
A 
About Ready,Set,Go! command (Apple menu) , 154 
activating windows, 48 
Actual Size command (Special menu), 22- 23, 51 , 190 
adding 

page numbers, 63 
pages, 22-23,60 
text blocks, 89 
to User Dictionary, 121 

Add Word command (Text menu), 120, 121 , 189 
Adobe Illustrator, 145 
aligning 

objects , 77 
text, 93 

alignment, 9, 102 
Alignment command (Special menu), 77, 197 
apostrophe, ]63 
Apple menu, 154-156 

About Ready,Set,Go! command, 154 
Calculator, 155 
Chooser, 36-37, 136, 147, 155 
Control Panel, 147, 155 
Key Caps, 155, 156 
Note Pad, 155 
Scrapbook, 83, 128-129, 131 , 145, 155, 156 

Application Disk, 16-17, 44, 142-143, 144 
applications, 145. See also specific application 
arrow keys , 94 , 95 , 96 
Article file , 28-29 
ASCII docume nts. See text-only (ASCII) documents 

B 
Backspace key, 73, 86, 91 , 131 
Baseline command (Format menu) , 96, 177 
baseline , defined, 96 
blank pages, 60 
Boilerplates file, 32-33 
boilerplate . See glossaries 
Bold command (Style menu) , 170 
border pattern, changing, 126 
Bring To Front command (Edit menu), 76, 168 

210 

C 
Calculator (Apple menu), 155 
case , 104-105, 106-107, 118 
center alignment (tab stops), 102-103 
Center command (Format menu), 93, 173 
centimeters, 21, 57. See also Preferences command 
chain of blocks. See text blocks 
characters. See text 
character spacing, 9 
checking spelling, 120-121 
Check Spelling command (Text menu), 120, 188 
Chicago font , 146 
Chooser (Apple menu), 36-37, 136, 147, 155 
circles. See graphic objects; shape tools 
Clear command (Edit menu), 73, 86, 91 , 131, 166 
Clipboard, 70, 73, 83, 86, 90 , 128-129, 131 , 145 
close box, 48 
Close command (File menu), 158 
closing windows, 48 

shortcuts , 200 
columns (text) , 26-27 
Command key 

selecting text with, 85 
unlinking linked text blocks with, 91 
windows and, 48 
See also shortcuts 

commands, 2-3, 154. See also specific command 
Condense command (Style menu), 170 
Control Panel CApple menu), 147, 155 
Copy command (Edit menu) , 70, 83, 90, 128-129, 

131 , 166 
copying 

documents , 83-84 
linked text blocks, 90 
objects, 70 
pictures, 128-129, 131 

Courier font , 146 
Cricket Draw, 145 
Cricket Graph, 145 
cropping pictures , 130 
cropping tool , 24-25, 128- 129, 130, 150 
custom grids, 56 
Cut command (Edit menu), 70, 73, 86, 90 , 91 , 128-

129, 131 , 165 



D 
date, inserting, 116 

shortcuts, 205 
decimal alignment (tab stops), 102-103 
Delete Page(s) command (Special menu), 61 , 192 
deleting 

glossaries , 114- 115 
pages , 61 
stylesheets, 112-113 
from User Dictionary, 121 

delta character (Option key-D), 178 
deselecting. See selecting 
Design Grids command (Special menu), 20-21 , 54, 

56, 195-196 
desk accessories. See Apple menu 
desktop, 40-51 , 149-153 
diagonal lines. See graphic objects; Lines menu; shape 

tools 
dictionaries. See Dictionary Disk; RSG Dictionary; 

spelling; User Dictionary 
Dictionary Disk, 17, 144 
dimmed menus/ menu commands, 154 
disk drives. See 800K disk drives; 400K disk drives; 

hard disk drive 
disks , working copies of, 42-43. See also specific disk 
documents, 46-47, 52-63 

copying, 83- 84 
designing , 4-5 
naming, 18-19 
opening, 2-3, 46 , 200 
printing, 12-13 
saving, 47, 200 
shortcuts , 200 
text-only, 47, 82 , 145 
See also text 

document window, 149-153 
double-clicking, 85 
double quotation marks, 163 
Double Size command (Special menu), 22-23, 51 , 

190 
Down Arrow key, 96 
downloadable fonts , 146 
drawing graphic objects, 124 
Duplicate command (Edit menu) , 71, 167 
duplicate pages, 60 
duplicating objects, 71 

E 
Edit menu, 165-169 

Bring To Front command, 76, 168 
Clear command, 73, 86, 91 , 131 , 166 
Copy command, 70, 83, 90, 128-129, 131 , 166 
Cut command, 70, 73, 86, 90, 91 , 128-129, 131 , 

165 
Duplicate command, 71 , 167 
Lock command, 74, 167 
Paste command, 70, 84, 86, 90, 117, 128-129, 

131, 166 
Select All command, 69, 85, 88, 117, 126, 166 
Send Behind command, 76, 168 
Specifications command, 11 , 34-35, 57, 68, 69, 74, 

87, 132-133, 168-169 
Undo command, 73, 86, 91 , 131 , 165 
Unlock command, 74, 167 

800K disk drives, working copies and, 42-43 
ellipses , 154 
em dash, 163 
enlarging windows, 48 
EPSF format , 145 
Example folder, 142, 143 
exporting. See Put Text command 
Extend command (Style menu), 170 

F 
facing pages , displaying, 50 
Facing Pages command (Special menu), 22-23, 50, 

189- 190 
File menu, 156-165 

Close command, 158 
Get Picture command, 24-25 , 34-35, 128-129, 

131, 164-165 
Get Text command, 28-29, 82, 121 , 163 
New command, 3, 46, 156 
Open command, 3, 44, 46, 156- 157 
Page Setup command, 4, 13, 50, 58, 59, 160 
Print command, 36-37, 139, 140, 162 
Printer Setup command, 137, 138, 161 
Put Text command, 47, 121 , 164 
Quit command, 45 , 165 
Save As command, 18-19, 47, 159 
Save command, 24-25 , 36- 37, 47, 158 

files. See documents; text or specific file 
Fill menu , 124, 125, 198 
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facing pages , displaying, 50 
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fill pattern, changing, 125 
Find command (Text menu), 104-105, 177-178 
finding text, 104-105 
Find Next command (Text menu) , 104-105 , 178 
Font/ DA Mover, 146 
Font menu, 9, 92 , 169 
fonts , 9, 146 

downloadable, 146 
finding , 104-105 
printer, 92, 146 
replacing , 106-107 
scaled, 92 
screen, 92, 146 
See also Font menu; Style menu 

foot symbol, 163 
Format menu, 9, 93,100,172- 177 

Baseline command, 96, 177 
Center command, 93 , 173 
Justify command, 93 , 173 
Kern command, 94, 175 
Left command, 93, 172 
Left Indent command, 100, 174 
Letterspace command, 95 , 176 
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Illustration file , 34-35 
Illustrator (Adobe), 145 
ImageStudio, 145 
ImageWriter, 92, 145 , 146 

printing with, 139 
setting up , 137 

importing 
glossaries, 116 
stylesheets, 110-111 
text, 82 
See also Get Picture command; Get Text command 

inches, 21, 57. See also Preferences command 
inch symbol, 163 
indents, 100. See also tab stops 
inserting 

date, 116, 205 
pictures, 128-129 
text (as picture), 128-129 
time, 116, 205 

insertion pointer, 9, 28-29, 81, 82 , 150 
Insert Page(s) command (Special menu) , 22-23, 60 , 

89, 191 
internal memory, 147 
Italic command (Style menu), 170 

J 
justified alignment (tab stops) , 102 
Justify command (Format menu), 93, 173 

K 
Kern command (Format menu) , 94 , 175 
kerning, 94, 95 
keyboard commands, 154 

for glossaries, 114, 116 
for stylesheets, 108, 110 
See also Command key; shortcuts 

Key Caps (Apple menu), 155, 156 

L 
LaserPrep file, 145 
LaserWriter, 92, 145, 146 

printing with, 140 
setting up , 138 

leader character (tab stops) , 102-103 
left alignment (tab stops) , 102-103 
Left Arrow key, 94 
Left command (Format menu), 93, 172 
Left Indent command (Format menu) , 100, 174 
left master page. See master pages 
Letterspace command (Format menu), 95, 176 
lette rs pacing , 95 
lines. See graphic objects; Lines menu; shape tools 
Lines menu , 124, 126, 198 
line spacing, 9, 98 
Line ··Spacing command (Format menu), 98, 173 
linked text blocks, 88, 90, 91, 202 
linking tool , 8, 28-29, 88, 89, 91, 150, 202 
Lock command (Ed it menu), 74, 167 
locking objects, 74 
lowercase , 104-105, 106-107, 118 

M 
MacDraft, 145 
MacDraw, 145 
Macintosh 128K, 142 
Macintosh 512K enhanced, 147, 155 
MacPaint, 145 
MacWrite, 82, 145 
margins, 152 
master pages, 4- 5, 62, 63 , 153 

elements, removing, 62 
page numbers and, 63 

Masthead file, 24-25 
measure. See tab stops 
measu re ment scale. See Preferences command 
memory, 147 
menu bar, 2- 3, 149 
menus/ menu commands , 2-3 , 154. See also specific 

menu/ menu command 
Microsoft Word, 82, 145 
Monaco font , 146 
moving · 

linked text blocks, 90 
objects , 69, 70 
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pictures , 131 
text, 86 
windows, 48 

N 
naming 

documents, 18-19 
glossaries , 11 4-115 

networks, 148 
New command (File menu), 3, 46, 156 
newsletter, 16-37 
nonbreaking spaces, 117 
Note Pad (Apple menu), 155 
number signs, 63 

o 
object pointer, 67, 69, 75, 150 
objects , 64-77 

aligning, 77 
border pattern, 126 
copying, 70 
creating, 6- 7, 66 
duplicating, 71 
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locking, 74 
moving , 69, 70 
position of, 68 
removing, 73 
restoring , 73 
selecting , 67, 75 
shortcuts , 202 
size of, 68, 72 
stacking, 76 
unlocking , 74 
See also graphic objects; picture blocks; text blocks 

Open command (File menu) , 3, 44 , 46 , 156-157 
opening documents, 2-3, 46 

shortcu ts, 200 
Option key 

21 

checking spelling with , 120 
converting punctuation with, 163 
finding with , 104-105 
kerning with, 94 
nonbreaking space with, 117 
replacing with , 106-107 

EX 

selecting text with, 85 
Option key-D (delta character), 178 
orientation (of pages) , changing, 58 
Other command (Style menu) , 92, 170-171 
Outline command (Style menu) , 170 
ovals. See graphic objects; shape tools 
Overstrike command (Style menu) , 170 

p 
page numbers, 63 

shortcuts, 200-201 
pages , 58- 63 , 151 

addi ng, 22-23, 60 
blank , 60 
deleting , 61 
duplicate, 60 
facing , 50 
master, 4-5 , 62, 63 , 153 
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removing, 131 
replacing, 131 
restoring, 131 
scaling, 132- 133 
See also picture blocks 

picture tool, 7, 24-25 , 66, 127, 150 
Plain command (Style menu) , 92, 170 
points, 21 , 57. See also Preferences command 
position (of objects), 68 
PostScript printers, 146 
Preferences command (Special menu), 20-21 , 54, 

57, 58, 63 , 66, 92, 193- 194 
print area , hiding/showing, 58 
Print command (File menu) , 36-37, 139, 140, 162 
printer fo nts , 92, 146 
printers, selecting, 136. See also ImageWriter; 

LaserWriter; PostScript printers 
Printer Setup command (File menu) , 137, 138, 161 
printing , 36- 37, 134-140 

documents, 12-13 
with ImageWriter, 139 
with LaserWriter, 140 

punctuation , converting with Option key, 163 
Put Text command (File menu), 47, 121 , 164 

Q 
Quit command (File menu), 45 , 165 
quitting , 45 
quota tion marks, 163 

R 
RAM , 147 
RAM Cache, 14-7, 155 
rectangles. See graphic objects; shape tools 
recto , defined, 23 
registration marks , 59 
Remove Styles command (Text menu) , 110- 111 , 

112-113, 186 
removing 

hyphenation , 117, 118 
inde nts, 100 
linked text blocks , 91 
master page ele ments, 62 
nonbreaking spaces , 117 
objects, 73 
pictures , 131 

spaces (nonbreaking) , 117 
tab stops, 102-103 
text , 86 

renaming. See naming 
Replace command (Text menu), 106- 107, 179 
Replace Next command (Text menu), 106-107, 180 
replacing 

pictures, 131 
text, 86, 106-107 

restoring 
linked text blocks , 91 
objects, 73 
pictures, 131 
text , 86 

Return key, 81 
right alignment (tab stops), 102 
Right Arrow key, 95 
Right command (Format menu), 93 , 173 
Right Indent command (Format menu), 100, 174 
right master page. See master pages 
rounded rectangles. See graphiC objects; shape tools 
RSG Dictionary , 120, 143, 144 
rulers, 57, 102-103, 152 
runarounds . See text runarounds 

S 
sample newsletter, 16- 37 
Save As command (File menu) , 18- 19, 47 , 159 
Save command (File menu), 24-25, 36- 37, 47 , 158 
saving documents, 47 

shortcuts, 200 
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scaling pictures , 132-1 33 
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screen fonts, 92 , 146 
scroll arrows, 49 
scroll bar, 49 
scroll box, 49 
scrolling windows, 49 
searching and replacing. See finding text; replacing 
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Select All command (Edit menu), 69, 85, 88, 117, 

126, 166 
selecting 

objects, 67, 75 
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printers , 136 
shortcuts, 203-205 
text , 85 , 203-205 

Send Behind command (Edit menu), 76, 168 
setting up 

ImageWriter, 137 
LaserWriter, 138 
tab stops , 102-103 
type specifications, 103 

75% Size command (Special menu) , 22-23, 51, 190 
Shadow command (Style menu) , 170 
shape tools, 7, 11, 66, 124, 150 
Shift Down command (Format menu), 96, 177 
shifting characters up/down, 96 
Shift key 

adding text blocks with, 89 
selecting objects with, 69, 75 
selecting text with, 85 

Shift Up command (Format menu), 96 , 176 
shortcuts , 200- 205 
showing 

grids, 54 
picture blocks , 66 
print area , 58 
rulers , 57 

shrinking windows, 48 
Shut Down command (Special menu), 16-17, 44 
sideways orientation, 58 
single quotation marks , 163 
site-licensing agreement, 148 
size , 9 

finding , 104-105 
of objects , 68 , 72 
of pages, 4- 5, 58 
replacing, 106-107 
of windows, 48 

size box, 48 
sizes (type) . See Style menu 
Size To Fit command (Special menu) , 22-23, 24-25, 

51 , 190 
slash , fo r keyboard commands, 108, 11 4 
Snap To command (Special menu), 54, 72, 194 
software . See applications or specific application 
spaces , 163 

nonbreaking, 117 
Special menu , 189-197 

216/ INDEX 

Actual Size command, 22-23, 51 , 190 
Alignment command, 77, 197 
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shortcuts, 205 
using , 110- 111 
See also text 

subscripts, 96 
Suggest Spelling command (Text menu), 120, 188 
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Switcher, 147 
Symboi font, 146 
System Disk, 16- 17, 44 , 144- 145, 146 
System file, 92 , 146 , 147 
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Tab key, 102- 103 
Tabs command (Text menu) , 102- 103, 182-183 
tabs ruler, 102-103 
tab stops 

alignment at, 102 
leader character for, 102 
removing , 102-103 
setting up , 102-103 
specifications , defining, 102 

text, 6-7, 8-9, 78-121 
aligning, 93 
columns, 26-27 
finding, 104- 105 
importing, 82 
inserting (as picture) , 128-129 
kerning, 94, 95 
le tte rspacing , 95 
moving , 86 
removing, 86 
replacing, 86, 106-107 
restoring, 86 
selecting , 85 , 203-205 
shifting up/ down, 96 
shortcuts, 203-205 
typing , 81 
See also documents; stylesheets; text blocks 

text blocks, 6- 7, 8-9, 78-121 
adding, 89 
creating, 66, 80 
linked, 88, 90, 91 , 202 
See also objects; text 

text measure. See tab stops 

Text menu , 177-189 
Add Word command, 120, 121 , 189 
Check Spelling command, 120, 188 
Find command, 104-105, 177-178 
Find Next command, 104-105, 178 
Glossaries command, 32-33 , 114-115, 116, 186-

187 
Hyphenation Off command, 117, 180 
Hyphenation On command, 180 
Hyphenation Specs command, 118, 119, 181- 182 
Remove Styles command, 110- 111 , 112-113, 186 
Replace command, 106-107, 179 
Replace Next command, 106-107, 180 
Styles command,30-31, 108- 109, 110- 111, 112-

11 3, 184-186 
Suggest Spelling command, 120, 188 
Tabs command, 102-103, 182-183 
Type Specs command, 9, 101 , 183- 184 
Word Spacing command, 97 

text-only (ASCII) documents, 47, 82, 145 
text runarounds, 37, 87 
text tool, 7, 26-27, 66, 80, 150 
Thunde rscan , 145 
TIFF format, 145 
tiles , 12- 13, 59 
time, inserting, 116 

shortcuts , 204 
time-savers, 104-121 

checking spelling, 120-121 
finding text, 104-105 
glossaries , 114-116 
hyphenation , 117- 119 
replacing text, 106-107 
s tylesheets, 108-113 

Times font , 146 
title bar, 48 
tool bar, 3, 66, 149, 150. See also specific tool 
turning on/off 

grids , 54 
hyphenation, 117 

type sizes. See Style menu 
type specifications, setting up, 101. See also style 

sheets ; Type Specs command 
Type Specs command (Text menu) , 9, 101, 183-184 
typing text, 81 
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U 
Underline command (Style menu), 170 
Undo command (Edit menu), 73, 86, 91 , 131, 165 
units of measure, 57, 193. See also Preferences com 

mand 
unlinking linked text blocks, 91 
Unlock command (Edit menu), 74, 167 
unlocking objects, 74 
Up Arrow key, 96 
uppercase , 104-105 , 106-107, 118 
upright orientation , 58 
Use Master command (Special menu), 62, 195 
User Dictionary, 120, 142, 143, 144 

changing, 121 

V 
versio ns, 146 
verso, defined, 23 

. vertical lines. See graphic objects; Lines menu; shape 
tools 

view (of windows), changing, 50-51 

w, X, Y 
windows, 3, 48-51, 149 

activating, 48 
closing, 48, 200 
e nlarging, 48 
moving , -48 
scrolling , 49 
sho rtcu ts, 200, 205 
shrinking, 48 
size of, changing, 48 
view, changing , 50-51 

Word (Microsoft), 82, 145 
word spacing, 97. See also text 
Word Spacing command (Format menu), 173 
Word Spacing command (Text menu) , 97 
working copies, 42-43 
WriteNow, 82, 145 

Z 
zoom box, 48 
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